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DAQ Quick Start Guide
This guide describes how to install and configure the NI-DAQ 7.x driver 
software and a data acquisition (DAQ) device, and confirm the device is 
operating properly.

This guide does not describe NI switch module installation and 
configuration; refer to the NI Switches Getting Started Guide.
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Conventions
The following conventions are used in this guide.

<> Angle brackets indicate function keys.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on 
the device, refer to the Read Me First: Safety and Radio-Frequency 
Interference document, shipped with the device, for precautions to take.

When this symbol is marked on a product, it denotes a warning advising 
you to take precautions to avoid electrical shock.

When this symbol is marked on a product, it denotes a component that may 
be hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. 

italic Italic text denotes a cross reference, an introduction to a key concept, or a 
placeholder for a word or value that you must supply.

monospace Text in this font denotes text or characters you should enter from the 
keyboard, error codes, the proper names of disk drives, paths, directories, 
programs, functions, filenames, and extensions.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.
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NI-DAQ 7.x Software
National Instruments measurement devices are packaged with NI-DAQ 
driver software, an extensive library of functions and VIs you can call from 
your application software, such as LabVIEW or LabWindows™/CVI™, to 
program your NI measurement devices. Measurement devices include 
DAQ devices such as the M Series multifunction I/O (MIO) devices, signal 
conditioning modules, and switch modules. Driver software has an 
application programming interface (API), which is a library of VIs, 
functions, classes, attributes, and properties for creating applications for 
your device.

NI-DAQ 7.x includes two NI-DAQ drivers, each with its own API, 
hardware configuration, and software configuration. 

• NI-DAQmx is the latest NI-DAQ driver with the following advantages 
over Traditional NI-DAQ (Legacy):

– DAQ Assistant—a graphical way to configure virtual channels 
and measurement tasks for your device, and to generate 
NI-DAQmx code based on your virtual channels and tasks, for use 
in LabVIEW, LabWindows/CVI, and Measurement Studio.

– Increased performance, including faster single-point analog I/O 
and multithreading.

– NI-DAQmx simulated devices for testing and modifying 
applications without plugging in hardware. 

– Simpler, more intuitive APIs for creating DAQ applications using 
fewer functions and VIs than earlier versions of NI-DAQ.

– Expanded functionality for LabVIEW, including property nodes 
and waveform data type support.

– Similar APIs and functionality for ANSI C, LabWindows/CVI, 
and Measurement Studio, including native .NET and C++ 
interfaces.

– Improved support and performance for the LabVIEW Real-Time 
Module.

• Traditional NI-DAQ (Legacy) is an upgrade of the earlier version of 
NI-DAQ. Traditional NI-DAQ (Legacy) has the same VIs and 
functions and works the same way as NI-DAQ 6.9.3, except you can 
use Traditional NI-DAQ (Legacy) and NI-DAQmx on the same 
computer, and some hardware is no longer supported. 
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Who Can Use NI-DAQmx
You should install and use NI-DAQmx if the following situations apply:

• You are a new NI-DAQ user.

• You are using devices supported by NI-DAQmx; refer to the Support 
in NI-DAQ 7.4 section at the end of this guide.

• You are using Windows 2000/NT/XP.

If you are using NI application software with NI-DAQmx, you must use 
LabVIEW, LabWindows/CVI, or Measurement Studio version 7.x, 
VI Logger 2.x, or the LabVIEW Real-Time Module 7.1 or later.

If you use one of the Microsoft .NET languages, Visual C# and/or Visual 
Basic .NET, or a device supported only by NI-DAQmx, such as an M Series 
device, you must use NI-DAQmx.

You also can use NI-DAQmx with a supported compiler, such as an 
ANSI C compiler.

Who Must Use Traditional NI-DAQ (Legacy)
You should use NI-DAQmx if you are a new NI-DAQ user or your 
application meets the previous conditions. Install and use Traditional 
NI-DAQ (Legacy) if one of the following situations apply:

• You have a device that is not supported by NI-DAQmx, such as the 
AT E Series multifunction DAQ devices.

• You are using a version of LabVIEW, LabWindows/CVI, or 
Measurement Studio earlier than version 7.0.

• You are using the LabVIEW Real-Time Module for the Macintosh.

• You are upgrading from NI-DAQ 6.9.x and have existing applications 
that you do not want to port to NI-DAQmx now. 

Note The earliest version of NI application software supported by Traditional NI-DAQ 
(Legacy) is version 6.0. LabVIEW, LabWindows/CVI, or Measurement Studio versions 
6.x can use Traditional NI-DAQ (Legacy) from the NI-DAQ 7.x distribution.

How NI-DAQ Fits into Your System
Figure 1 depicts the measurement system overview, showing the path of 
real-world physical phenomena to your measurement application.

Sensors and transducers detect physical phenomena. Signal conditioning 
components condition physical phenomena so that the measurement device 
can receive the data. The computer receives the data through the 
measurement device. Software controls the measurement system, telling 
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the measurement device when and from which physical channels to acquire 
or generate data. Software also takes the raw data, analyzes it, and presents 
it in a form you can understand, such as a graph, chart, or file for a report. 

Figure 1.  Measurement System Overview

NI measurement devices and application software are packaged with 
NI-DAQ driver software to program all the features of your 
NI measurement device such as configuring, acquiring, and generating data 
from and sending data to NI measurement devices. Using NI-DAQ saves 
you from having to write these programs. Application software, such as 
LabVIEW, LabWindows/CVI, Measurement Studio, and VI Logger, sends 
the commands to the driver, such as acquire and return a thermocouple 
reading, and then displays and analyzes the data acquired.
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You can use the NI-DAQ driver from NI application software or from any 
programming environment that supports calling dynamic link libraries 
(DLLs) through ANSI C interfaces. Regardless of the programming 
environment, your DAQ application uses NI-DAQ, as shown in Figure 1.

Step 1. Install Application Software
Install your NI application software. If you are using NI-DAQmx to 
program the DAQ devices in your system, install LabVIEW 7.x, 
LabWindows/CVI 7.x, Measurement Studio 7.x, VI Logger 2.x, or the 
LabVIEW Real-Time Module 7.1 or later.

If you have an existing application written with an earlier version of your 
application software or NI-DAQ, make a backup copy of the application. 
You then can upgrade your software and modify the application.

Step 2. Install the NI-DAQ 7.x Software

Insert the CD

Caution Do not install NI-DAQ 7.x if your existing applications include unsupported 
components. Before installing the software, refer to the Support in NI-DAQ 7.4 section at 
the end of this guide.

The NI-DAQ 7.x installer should open automatically. If not, select 
Start»Run. Enter x:\setup.exe, where x is the letter of the CD drive. 
For troubleshooting instructions, refer to the Hardware Installation/ 
Configuration Troubleshooter at ni.com/support/install.

Install your driver software before installing new hardware devices, so 
Windows can detect your device.
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Choose the API(s) to Install

Caution NI-DAQ 7.x cannot exist on the same system with earlier versions of NI-DAQ. 
When you install NI-DAQ 7.x, the latest version of Traditional NI-DAQ (Legacy) replaces 
earlier versions of NI-DAQ and any support files installed by the earlier version. When you 
install only NI-DAQmx, versions of NI-DAQ earlier than NI-DAQ 6.9.x are removed.

NI-DAQ 7.x contains several drivers and their APIs—NI-DAQmx, 
NI-SWITCH, and Traditional NI-DAQ (Legacy). You can install any or all 
of the drivers, depending on the devices you are using. Refer to the Support 
in NI-DAQ 7.4 section at the end of this guide to see which drivers support 
the devices in your system.

You can use NI-SWITCH or NI-DAQmx to program an NI switch module. 

Install Support Files
The NI-DAQ 7.x installer detects the NI software installed on the system 
and automatically selects the latest versions of the driver, application 
software, and language support files from the CD, as shown in the 
following example.

 

1. Verify that the installer detected and selected the correct support files 
and version number of the application software and/or language.

If you install NI-DAQ 7.x before installing NI application software 
version 7.x, you must run the NI-DAQ 7.x installer again to install the 
correct application software support.

2. Click Next at the prompts.

3. Click Finish.
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4. When the installer completes, a message opens asking if you want to 
restart, shut down, or exit.

• Restart—If you are using a system running the LabVIEW 
Real-Time Module, restart. Download NI-DAQ 7.x to the target 
using Measurement & Automation Explorer (MAX). Refer to the 
Measurement & Automation Explorer Remote Systems Help by 
selecting Help»Help Topics»Remote Systems.

• Exit—If you have more NI software to install, exit and install it. 
If you are using a MXI-3 link from a PC to control a PXI chassis, 
exit and install the MXI-3 software, available at ni.com/
downloads, before using the DAQ device.

• Shut Down—If you are ready to install your device, shut down.

Step 3. Unpack the Devices, Accessories, and Cables
Your device is shipped in an antistatic package to prevent electrostatic 
damage (ESD) to the device and its components.

Caution Never touch the exposed pins of connectors.

To avoid such damage, take the following precautions:

• Ground yourself using a grounding strap or by touching a grounded 
object.

• Touch the antistatic package to a metal part of the computer chassis 
before removing the device from the package.

Remove the device from the package and inspect the device for loose 
components or any sign of damage. Notify NI if the device appears 
damaged in any way. Do not install a damaged device.

Store the device in the antistatic package when the device is not in use.

For safety and compliance information, refer to the device documentation 
as described in Step 9. Browse or Install Device Documentation.

Step 4. Install the Devices, Accessories, and Cables
If you have more than one DAQ device to install, install them all now. If 
your system includes SCXI modules to connect to DAQ devices, first 
install the DAQ components using this guide; you will install SCXI 
modules in Step 10. Install Signal Conditioning or Switch Devices.

To test NI-DAQmx applications without installing hardware, you can use 
an NI-DAQmx simulated device. Skip to Step 6. Launch MAX, and refer to 
the Measurement & Automation Explorer Help for NI-DAQmx by selecting 
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Help»Help Topics»NI-DAQmx for instructions on creating NI-DAQmx 
simulated devices and importing NI-DAQmx simulated device 
configurations to physical devices. 

Caution Follow proper ESD precautions to ensure you are grounded before installing the 
hardware. Refer to the specifications document for your device for important safety and 
compliance information.

PCI Devices
Complete the following steps to install the PCI device:

1. Power off and unplug the computer.

2. Remove the computer cover and/or the expansion slot cover.

3. Touch any metal part of the computer to discharge any static electricity.

4. Insert the device into a PCI system slot. Gently rock the device into 
place. Do not force the device into place.

 

Figure 2.  Installing a PCI Device

5. Secure the device mounting bracket to the computer back panel rail.

6. Replace the computer cover, if applicable.

1 PCI DAQ Device
2 PCI System Slot

3 PC with PCI Slot
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PXI Devices
Complete the following steps to install the PXI module.

1. Power off and unplug the PXI chassis.

Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document 
packaged with your PXI chassis or device before removing equipment covers or 
connecting or disconnecting any signal wires.

2. Remove the filler panel of an unused PXI slot. For information on 
slot requirements, refer to the device documentation as described 
in Step 9. Browse or Install Device Documentation.

3. Touch any metal part of the chassis to discharge static electricity.

4. Ensure that the PXI module injector/ejector handle is not latched and 
swings freely.

5. Place the PXI module edges into the module guides at the top and 
bottom of the chassis.

6. Slide the device into the PXI slot to the rear of the chassis.

7. When you begin to feel resistance, pull up on the injector/ejector 
handle to fully insert the device.

8. Secure the device front panel to the chassis front panel mounting rail 
using the front-panel mounting screws.

 

Figure 3.  Installing a PXI Device
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PCMCIA Devices
You can install the NI PCMCIA device in any available Type II PC Card 
slot. Complete the following steps to install the PCMCIA device.

1. Remove the PCMCIA slot cover on your computer, if any.

2. Insert the PCMCIA bus connector of the PCMCIA device in the 
slot until the connector is firmly seated.

3. Attach the I/O cable. Be careful not to put strain on the I/O cable when 
inserting or removing the cable connector. Always grasp the cable by 
the connector you are inserting or removing. Never pull directly on the 
I/O cable to unplug it from the PCMCIA device.

Figure 4.  Installing a PCMCIA Device

USB/IEEE 1394 Devices
Complete the following steps to install an NI device for USB or 
IEEE 1394:

1. Make power connections.

• If you are using the BP-1 battery pack, follow the installation 
instructions in your BP-1 installation guide.

• Some NI devices for USB or IEEE 1394 require external power.

– If your device has an external power supply, verify that the 
voltage on the external power supply, if any, matches the 
voltage in your area (120 or 230 VAC) and the voltage 
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required by your device. Connect one end of the power supply 
to an electrical outlet and the other end to your device.

– If your device has a power cord, connect one end of the power 
cord to the device and the other end to an electrical outlet.

2. Connect the cable from the computer USB or IEEE 1394 port or from 
any other hub or IEEE 1394 device to any available USB or IEEE 1394 
port on the device. 

3. If you have a USB or IEEE 1394 device with a power switch, power on 
the device. The computer should immediately detect your device.

Accessories
Install accessories and/or terminal blocks according to the instructions in 
their installation guides. For SCXI and SCC signal conditioning systems, 
continue with the instructions in this guide through Step 10. Install Signal 
Conditioning or Switch Devices.

Step 5. Power On Your Computer or PXI Chassis
Windows recognizes any newly installed device the first time the computer 
reboots after hardware is installed. On some Windows systems, the Found 
New Hardware wizard opens with a dialog box for every NI device 
installed. Install the software automatically (Recommended) is selected 
by default. Click Next or Yes to install the software for each device so 
Windows recognizes the device.

When the computer recognizes a USB or IEEE 1394 device, the power 
LED on the device blinks or lights up. NI devices for IEEE 1394 also have 
a COM LED, which blinks when the device is detected. For LED pattern 
descriptions for your specific device, refer to the device documentation as 
described in Step 9. Browse or Install Device Documentation. 

Step 6. Launch MAX
Double-click the Measurement & Automation icon on the desktop to 
open MAX.



© National Instruments Corporation 13 DAQ Quick Start Guide

Step 7. Confirm That the Device Is Recognized
Complete the following steps:

1. Expand Devices and Interfaces. If you are using a remote RT target, 
expand Remote Systems, find and expand your target, and then 
expand Devices and Interfaces.

2. Check that your device appears under Devices and Interfaces. 

If your device does not appear, press <F5> to refresh the view in MAX. 
If the device is still not recognized, refer to ni.com/support/ 
install for troubleshooting information.

3. Under the folder for the NI-DAQ API you are using to program the 
device, right-click the device you want to test. 

• If the device is under NI-DAQmx, select Self-Test.
 

1 When a device is supported by both NI-DAQmx and Traditional NI-DAQ 
(Legacy) and both are installed, the same device is listed with a different name 
under the NI-DAQmx and Traditional NI-DAQ (Legacy) folders under My 
System»Devices and Interfaces. 

2 Only NI-DAQmx Devices are listed under Remote Systems»Devices and 
Interfaces. 

1

2
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If you need help during the self-test, open Measurement & 
Automation Explorer Help for NI-DAQmx by selecting Help»
Help Topics»NI-DAQmx. 

• If the device is under Traditional NI-DAQ (Legacy), select 
Properties, then click Test Resources in the Properties window.

4. When the self-test finishes, a message indicates successful verification 
or if an error occurred. If an error occurs, refer to ni.com/support/
install for troubleshooting information.

Step 8. Configure the Device Settings
Configure each device you install:

1. Right-click the device name and select Properties. Be sure to click the 
device name under the folder for the NI-DAQ API in which you want 
to control the device. If you are using a remote RT target, NI-DAQmx 
devices are listed under Remote Systems»Devices and Interfaces.

2. Configure the device properties. To use a device in both NI-DAQmx 
and Traditional NI-DAQ (Legacy), you must configure its properties in 
each.

• If you are using an accessory, add the accessory information.

• If you are using a device in Traditional NI-DAQ (Legacy), select 
Help in MAX to refer to MAX Help for Traditional NI-DAQ.

• For IEEE 1451.4 transducer electronic data sheet (TEDS) sensors 
and accessories, configure the device and add the accessory as 
previously described. Click Scan for TEDS. To configure TEDS 
sensors cabled directly to a device, in MAX, right-click the device 
under Devices and Interfaces and select Configure TEDS.

3. Click OK to accept the changes.

To convert Traditional NI-DAQ (Legacy) virtual channels, scale 
configurations, and SCXI and accessory configurations to an NI-DAQmx 
configuration, select Tools»NI-DAQmx Configuration»Convert 
Traditional NI-DAQ (Legacy) Configuration to NI-DAQmx. The 
wizard does not convert SCC configurations; you must configure SCC 
information separately in each API you want to use. Click Help in the 
wizard for more information about converting your configurations.
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Step 9. Browse or Install Device Documentation
The NI-DAQ 7.x software kit includes online documentation for supported 
devices and accessories, including PDF and help files describing device 
terminals, specifications, features, and operation. To find, view, and print 
the documents for each device, insert the Device Documentation CD. You 
must have Internet Explorer version 5.0 or later to use some features of the 
NI-DAQ 7.x documentation, including the help system and Device 
Document Browser. After installation, the browser and device documents 
are accessible from Start»Programs»National Instruments»NI-DAQ» 
Browse Device Documentation. 

If you do not have this CD, online documentation for devices is available at 
ni.com/manuals. The Device Document Browser is available at 
ni.com/support; select Drivers and Updates»Most Popular and the 
NI-DAQ version you are using to open a Web page of Installation 
Instructions. Download NI-DAQ CD 2 and follow the instructions for 
installing the NI-DAQ Device Documentation Browser.

Step 10. Install Signal Conditioning or Switch Devices
If your system includes additional devices, such as signal conditioning or 
switch modules, refer to the following documents to install and configure 
the signal conditioning or switch hardware:

• SCXI signal conditioning modules, and Signal Conditioning 
Components (SCC), such as SC carriers and SCC modules—Refer to 
the quick start guide for the product.

• Switch modules—Refer to the NI Switches Getting Started Guide.

The rest of this guide applies only to DAQ or PXI integrated signal 
conditioning devices.

Step 11. Attach Sensors and Signal Lines
Wire sensors and signal lines to the terminal block or accessory terminals. 
Helpful information is available as follows: 

• Signal and terminal connections:

– You can view and print a connection diagram for NI-DAQmx 
tasks and virtual channels in your system through the DAQ 
Assistant. Select the task or virtual channel and click the 
Connection Diagram tab. Select each virtual channel in the task 
to view the terminal names and numbers for needed connections 
from sensor to connector block. 
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– M Series Help, E Series Help, device user manuals, and accessory 
guides are on the Device Document Browser.

– Pin assignments also are accessible from the MAX Help menu in 
the Device Terminals topics of the Measurement & Automation 
Explorer Help for NI-DAQmx and the Measurement & 
Automation Explorer Help for Traditional NI-DAQ.

• Sensors:

– Refer to ni.com/sensors.

– If you are using LabVIEW, refer to the LabVIEW Measurements 
Manual packaged with LabVIEW or available from ni.com/ 
manuals. 

– If you are using NI-DAQmx, refer to the Sensors topic of the 
NI-DAQmx Help, which you can access from Start»Programs» 
National Instruments»NI-DAQ»NI-DAQmx Help. 

– For information on IEEE 1451.4 TEDS smart sensors, refer to 
ni.com/zone. 

• Switches—Switch specifications include a topology of the device.

Step 12. Run Test Panels
Many devices have a test panel for testing specific device functionality, 
such as the ability to acquire and generate signals. 

1. In MAX, expand Devices and Interfaces»NI-DAQmx Devices or 
Devices and Interfaces»Traditional NI-DAQ (Legacy) Devices. If 
you are using a remote RT target, expand Remote Systems, find and 
expand your target, then expand Devices and Interfaces.

2. Right-click the device to test. Be sure to click the device name under 
the folder for the NI-DAQ API in which you want to use the device.

3. Select Test Panels to open a test panel for the selected device. 
Traditional NI-DAQ (Legacy) does not have test panels for the 
LabVIEW Real-Time Module.
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An example of a test panel is shown in the following figure.

4. Click the tabs to test different functions of the device. Click Help 
for instructions on operating the test panels in NI-DAQmx. Refer to the 
Measurement & Automation Explorer Help for Traditional NI-DAQ 
for instructions on operating the test panels in Traditional NI-DAQ 
(Legacy).

5. The test panel displays a message indicating whether an error 
occurred. If so, refer to the NI-DAQmx Help or ni.com/support 
for troubleshooting information. 

6. Click Close to exit the test panel.

Step 13. Configure Any Additional New Devices
If you installed more than one DAQ device, repeat Step 8. Configure the 
Device Settings through Step 12. Run Test Panels for each device. 

Step 14. Configure Channels and Tasks
This step applies only if you are programming your device using NI-DAQ 
or NI application software. 

A physical channel is a terminal or pin at which you can measure or 
generate an analog or digital signal. A virtual channel is a collection 
of settings such as a name, a physical channel, input terminal connections, 



DAQ Quick Start Guide 18 ni.com

the type of measurement or generation, and can include scaling 
information. In NI-DAQmx, virtual channels are integral to every 
measurement. In NI-DAQmx, use the DAQ Assistant, accessible from 
MAX or NI application software, to configure virtual channels and 
measurement tasks. Refer to the DAQ Assistant Help and Measurement & 
Automation Explorer Help for NI-DAQmx. You also can configure virtual 
channels with the NI-DAQmx API in your application program. In 
Traditional NI-DAQ (Legacy) and earlier versions, you can use MAX to 
configure virtual channels, an optional way to record which physical 
channels are being used for different measurements. 

A task, an important concept for NI-DAQmx, is a collection of one or more 
virtual channels with timing, triggering, and other properties. Conceptually, 
a task represents a measurement or generation you want to perform. You 
can set up and save all of the configuration information in a task and use the 
task in an application.

In NI-DAQmx, you can configure virtual channels as part of a task or 
separate from a task. Virtual channels created inside a task are local virtual 
channels. Virtual channels defined outside a task are global virtual 
channels. You can create global virtual channels in MAX or in your 
application software and then save them in MAX. You can use global 
virtual channels in any application or add them to a number of different 
tasks. If you modify a global virtual channel, the change affects all tasks in 
which you reference that global virtual channel. 

Configure a Task in NI-DAQmx
When using NI-DAQmx, configure tasks with the DAQ Assistant. You 
must have version 7.0 or later of an NI application software package to 
create tasks and virtual channels with the DAQ Assistant.

• In MAX, right-click Data Neighborhood and select Create New. 
In the Create New window, select NI-DAQmx Task and click Next.

If you are using a remote RT target, expand Remote Systems, find and 
expand your target, then right-click Data Neighborhood and select 
Create New.

• You also can open the DAQ Assistant directly within NI application 
software:

– In LabVIEW:

• Place on the block diagram the DAQ Assistant Express VI 
from the Express Input palette, as described in Getting 
Started with LabVIEW. 

• You also can place the DAQmx Task Name control from the 
DAQmx Name Controls palette on the front panel to open the 
DAQ Assistant. Right-click the control and select New Task 
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(DAQ Assistant). Taking an NI-DAQmx Measurement in 
LabVIEW has step-by-step instructions for creating a task 
from the DAQmx Task Name control and generating code 
based on the task. In LabVIEW, select Help»Taking an 
NI-DAQmx Measurement.

– In LabWindows/CVI:

1. Select Tools»Create/Edit DAQmx Tasks. The Create/Edit 
DAQmx Tasks dialog box opens. 

2. Select Create New Task In MAX or Create New Task In 
Project and click OK.

– In Measurement Studio:

1. Open Visual Studio .NET and the project in which you want 
to create a DAQmx task class.

2. Select Project»Add New Item. The Add New Item dialog 
box opens. 

3. In the Categories pane, select Measurement Studio» 
Assistants.

4. In the Templates pane, select DAQmx Task Class.

5. Specify a name for the DAQmx task file and click Open. 

6. Specify whether to create a new task or a project copy of a 
global task you create in MAX. 

7. Click Finish.

The DAQ Assistant prompts you to create a new task:

1. Select an I/O type, such as analog input.

2. Select the measurement or generation to perform.

3. Select the sensor to use, if applicable for that measurement.

4. Select the physical channel(s) from which to create local virtual 
channels in the task. Alternatively, you can add existing global virtual 
channels to the task or copy information from an existing global virtual 
channel to a local virtual channel. 

If your system is configured with a TEDS sensor, click the TEDS 
Channels tab. Select the physical channel(s). The DAQ Assistant 
imports the setting from the sensor and creates the task. 

Click Next.

5. If you launched the DAQ Assistant from MAX, type the new task 
name. Click Finish.
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6. Configure measurement-specific settings, timing, triggering, and 
scaling, if necessary. If one or more channels are configured for TEDS 
sensors, some settings loaded from TEDS are not editable.

7. You can add additional virtual channels to the task. Virtual channels 
added to a task can be of the same measurement type or a different 
measurement type, such as adding temperature virtual channels to a 
voltage task. Click the add button ( ) to add a virtual channel. 

a. Select the measurement type to add from the drop-down list.

b. Select the physical channel(s) from which to create local virtual 
channels in the task. Alternatively, you can add existing global 
virtual channels to the task or copy information from an existing 
global virtual channel to a local virtual channel. 

c. Click OK.

8. Save the task.

• If you opened the DAQ Assistant from LabVIEW or 
LabWindows/CVI, click OK. 

• If you opened the DAQ Assistant from Measurement Studio, 
select File»Save. 

• If you opened the DAQ Assistant from MAX, click Save Task. 

You now can use the task in an application. You also can edit or rename a 
virtual channel in the DAQ Assistant.
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Configure Global Virtual Channels in NI-DAQmx
When using NI-DAQmx, configure global virtual channels with the DAQ 
Assistant. You must use MAX to create global virtual channels, but you can 
add a global virtual channel from application software. 

• To open the DAQ Assistant in MAX, right-click Data Neighborhood 
and select Create New. 

If you are using a remote RT target, expand Remote Systems, find 
and expand your target, right-click Data Neighborhood, and select 
Create New.

In the Create New window, select NI-DAQmx Global Channel 
and click Next.

• You can open the DAQ Assistant directly in NI application software: 

– In LabVIEW, use the DAQmx Global Channel control to open the 
DAQ Assistant. Right-click the control and select New Channel 
(DAQ Assistant).

– In LabWindows/CVI or Measurement Studio, first you must 
create a task as previously described. In the DAQ Assistant, click 
the add button ( ), then select a global virtual channel from the 
Global tab in the Add Channels to Task dialog box. 

The DAQ Assistant prompts you to create a new global virtual channel:

1. Select an I/O type, such as analog input. 

2. Select the measurement or generation to perform. 

3. Select the sensor to use, if applicable for that measurement. 

4. Select the physical channel from which to create a global virtual 
channel. Alternatively, you can copy information from an existing 
global virtual channel.

If your system is configured with a TEDS sensor, click the TEDS 
Channels tab. Select the physical channel(s). The DAQ Assistant 
imports the setting from the sensor. If one or more physical channels 
are configured for TEDS sensors, some settings loaded from TEDS are 
not editable. Click Next.

5. Type the new global virtual channel name. Click Finish.

6. Configure measurement-specific settings and scaling, if necessary. 

7. Save your configuration.

You now can use the global virtual channel in an application or add the 
global virtual channel to a task.
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Configure Virtual Channels in Traditional NI-DAQ (Legacy)
When you use Traditional NI-DAQ (Legacy), complete the following steps 
to configure virtual channels in MAX:

1. Open the Create New Channel wizard. 

• In MAX, right-click Data Neighborhood and select Create New. 
In the Create New window, select Traditional NI-DAQ Virtual 
Channel and click Finish. 

• If you are using a remote RT target with Traditional NI-DAQ 
(Legacy), select Tools»Traditional NI-DAQ Configuration»
Remote DAQ Configuration. Traditional NI-DAQ (Legacy) 
devices in a remote system are listed in the Remote DAQ 
Configuration window. Select Channel and click Add.

2. Follow the instructions in the Create New Channel wizard to create a 
new channel. For information about configuring channels, refer to the 
Measurement & Automation Explorer Help for Traditional NI-DAQ.

Step 15. Use Your Task in an Application
Complete the following steps to use a measurement task in your 
application. Refer to the DAQ Assistant Help for more information about 
using a task or generating code.

To run examples without hardware installed, you can use NI-DAQmx 
simulated devices. In MAX, refer to the Measurement & Automation 
Explorer Help for NI-DAQmx by selecting Help»Help Topics» 
NI-DAQmx for instructions on creating NI-DAQmx simulated devices and 
importing NI-DAQmx simulated device configurations to physical devices. 
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LabVIEW
1. Open a blank VI in LabVIEW. 

2. Place the following constant on the block diagram: NI Measurement»
DAQmx-Data Acquisition»DAQmx Task Name Constant.

3. Select the task from the pull-down menu. 

4. Right-click the VI and select Generate Code»Example. 

5. Run the program from the front panel.

LabWindows/CVI
Refer to ni.com/info and type rddq73 for step-by-step instructions for 
using a task in LabWindows/CVI.

Measurement Studio
Refer to ni.com/info and type rddqms for step-by-step instructions for 
using a task in Measurement Studio.

Getting Started Developing an Application

Using Examples
Each API includes a collection of programming examples to help you get 
started developing an application. You can modify example code and save 
it in an application. You can use examples to develop a new application or 
add example code to an existing application.

To run examples without hardware installed, you can use an NI-DAQmx 
simulated device. In MAX, refer to the Measurement & Automation 
Explorer Help for NI-DAQmx by selecting Help»Help Topics» 
NI-DAQmx for information on NI-DAQmx simulated devices. 

To locate LabVIEW and LabWindows/CVI examples, select Help»Find 
Examples, which opens the National Instruments Example Finder.

NI-DAQmx examples for Measurement Studio-supported languages 
(Visual Basic .NET, C#, and MFC C++) are in the following directories:

• Measurement Studio MFC C++ examples— 
MeasurementStudioVS2003\VCNET\Examples\DAQmx 

• Visual C# and Visual Basic .NET examples (Measurement Studio not 
required)—MeasurementStudioVS2003\DotNET\Examples\ 

DAQmx

NI-DAQmx examples for ANSI C are in the NI-DAQ\Examples\
DAQmx ANSI C directory.
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Traditional NI-DAQ (Legacy) examples for Visual Basic are located as 
follows:

• The NI-DAQ\Examples\Visual Basic with Measurement 
Studio directory contains a link to the Traditional DAQ CWDAQ 
ActiveX control examples. These examples use an evaluation version 
of the ActiveX user interface if Measurement Studio is not present.

• The NI-DAQ\Examples\VBasic directory contains the examples 
not associated with Measurement Studio.

Traditional NI-DAQ (Legacy) examples for ANSI C are in the NI-DAQ\ 
Examples\VisualC directory.

For hundreds of additional examples, refer to ni.com/zone.

Information about Measurement Applications and Devices
You can find information about your measurement applications and 
devices in the following locations.

LabVIEW
If you are a new user, complete Getting Started with LabVIEW 
to get acquainted with LabVIEW. Select Start»Programs»National 
Instruments»LabVIEW 7.x»Search the LabVIEW Bookshelf.

The LabVIEW Measurements Manual contains API overviews 
of NI-DAQmx and Traditional NI-DAQ (Legacy) and describes 
measurement concepts. Select Start»Programs»National Instruments»
LabVIEW 7.x»Search the LabVIEW Bookshelf.

Taking an NI-DAQmx Measurement in LabVIEW has step-by-step 
instructions on how to set up a measurement in LabVIEW and describes 
key new NI-DAQmx features and concepts such as the DAQ Assistant and 
tasks. In LabVIEW, select Help»Taking an NI-DAQmx Measurement.

The LabVIEW Help contains a VI and Function Reference section that 
describes the LabVIEW VIs and properties for NI-DAQmx and Traditional 
NI-DAQ (Legacy). In LabVIEW, select Help»VI, Function, & How-To 
Help and browse the VI and Function Reference book in the Contents tab 
to find the VI reference help section for the NI-DAQ API you are using.

LabVIEW Real-Time Module
Select Start»Programs»National Instruments»LabVIEW 7.x»Module 
Documents»Search the LabVIEW Real-Time Module Bookshelf for 
links to the LabVIEW Real-Time Module documents. 



© National Instruments Corporation 25 DAQ Quick Start Guide

LabWindows/CVI
If you are a new user, complete Getting Started with LabWindows/CVI 
to get acquainted with LabWindows/CVI. In LabWindows/CVI, select 
Help»LabWindows/CVI Bookshelf. 

The LabWindows/CVI Help contains NI-DAQmx measurement concepts 
and function reference. In LabWindows/CVI, select Help»Contents.

Measurement Studio
The NI Measurement Studio Help contains the NI-DAQmx measurement 
concepts and function reference. This help file is integrated into the Visual 
Studio .NET documentation. In Visual Studio .NET, select Measurement 
Studio»NI Measurement Studio Help.

ANSI C without NI Application Software
The NI-DAQmx Help and the Traditional NI-DAQ User Manual contain 
API overviews. The NI-DAQmx Help also contains general information 
about measurement concepts. The Traditional NI-DAQ C Reference Help 
and the NI-DAQmx C Reference Help describe the C functions and 
attributes. Select Start»Programs»National Instruments»NI-DAQ» 
document title for the NI-DAQ API you are using.

.NET Languages without NI Application Software
The NI Measurement Studio Help contains the NI-DAQmx measurement 
concepts and function reference. This help file is integrated into the Visual 
Studio .NET documentation. In Visual Studio .NET, select Help» 
Contents. To view the NI-DAQmx .NET Library help, select NI 
Measurement Studio Help»NI Measurement Studio .NET Class 
Library»Reference»National Instruments.DAQmx. For tasks and 
concepts, select NI Measurement Studio Class .NET Library»Using the 
Measurement Studio .NET Class Libraries»Using the Measurement 
Studio NI-DAQmx .NET Library. 

Note If you use a .NET language without Visual Studio .NET, you might not be able to 
view the NI Measurement Studio Help.

Device Documentation
NI-DAQ 7.x includes online documentation for supported devices and 
accessories, including PDF and help files describing device terminals, 
specifications, features, and operation. To find, view, and print the 
documents for each device, insert the NI-DAQ Device Documentation CD. 
After installing the Device Document Browser, device documents are 
accessible from Start»Programs»National Instruments»NI-DAQ» 
Browse Device Documentation.
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Using NI-DAQmx and Traditional NI-DAQ (Legacy) on the 
Same Computer

Existing applications developed with earlier versions of NI-DAQ will run 
under Traditional NI-DAQ (Legacy). You can use both the Traditional 
NI-DAQ (Legacy) API and the NI-DAQmx API on the same computer 
with the following restrictions:

• Only one API controls a given device at one time.

– After using a device in NI-DAQmx, you must unreserve all 
NI-DAQmx tasks that are using that device before you can use 
that device through Traditional NI-DAQ (Legacy). If you use a 
device in NI-DAQmx and then use it in Traditional NI-DAQ 
(Legacy) without unreserving the NI-DAQmx tasks, error code 
-10461 is returned. To unreserve NI-DAQmx tasks, call the 
DAQmx Clear Task VI or functions. 

– After using a device in Traditional NI-DAQ (Legacy), you must 
reset the device before you can use that device in NI-DAQmx, or 
error code -200324 is returned.

For SCXI devices, you must reset the communicating DAQ device 
in Traditional NI-DAQ (Legacy) before using it in NI-DAQmx. 
For example, E Series DAQ devices use lines 0, 1, 2, and 4 on 
port 0 to communicate with the SCXI module. Error code 
-200158 is returned if you do not reset the communicating device 
in Traditional NI-DAQ (Legacy) before using it in NI-DAQmx as 
follows:

• Call the Traditional NI-DAQ (Legacy) Device Reset VI or the 
Init_DA_Brds function.

• To reset devices in Traditional NI-DAQ (Legacy) from MAX, 
you must reset all devices at once. Right-click the 
Traditional NI-DAQ (Legacy) Devices folder in MAX and 
select Reset Driver for Traditional NI-DAQ (Legacy). For 
a remote RT target, you must use the Traditional NI-DAQ 
(Legacy) Device Reset VI.

• In an SCXI data acquisition system, you must use the same API to 
program all devices—connected DAQ devices and inserted SCXI 
modules.

Refer to ni.com/support for details and instructions about the following 
topics:

• How to add NI-DAQmx code to a Traditional NI-DAQ (Legacy) 
application

• How to run both Traditional NI-DAQ (Legacy) applications and 
NI-DAQmx applications that use the same device
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Troubleshooting
Use the following resources if you have problems installing your DAQ 
hardware and/or software:

• For troubleshooting instructions, refer to the Hardware Installation/
Configuration Troubleshooter at ni.com/support/install.

• Refer to ni.com/kb for documents on troubleshooting common 
installation and programming problems and for answering frequently 
asked questions about NI products.

• If you think you have damaged your device and need to return your 
National Instruments hardware for repair or device calibration, refer to 
ni.com/info and enter the info code rdsenn to learn how to begin 
the Return Merchandise Authorization (RMA) process.

Worldwide Technical Support
Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources at ni.com/support 
include the following:

– Self-Help Resources—For answers and solutions, visit the 
award-winning National Instruments Web site for software drivers 
and updates, a searchable KnowledgeBase, product manuals, 
step-by-step troubleshooting wizards, thousands of example 
programs, tutorials, application notes, instrument drivers, and 
so on.

– Free Technical Support—All registered users receive free Basic 
Service, which includes access to hundreds of Application 
Engineers worldwide in the NI Developer Exchange at 
ni.com/exchange. National Instruments Application Engineers 
make sure every question receives an answer.

For information about other technical support options in your 
area, visit ni.com/services or contact your local office at 
ni.com/contact. 

• Training and Certification—Visit ni.com/training for 
self-paced training, eLearning virtual classrooms, interactive CDs, 
and Certification program information. You also can register for 
instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.
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• Declaration of Conformity (DoC)—A DoC is our claim of 
compliance with the Council of the European Communities using 
the manufacturer’s declaration of conformity. This system affords 
the user protection for electronic compatibility (EMC) and product 
safety. You can obtain the DoC for your product by visiting 
ni.com/certification.

• Calibration Certificate—If your product supports calibration, 
you can obtain the calibration certificate for your product at 
ni.com/calibration.

National Instruments corporate headquarters is located at 11500 North 
Mopac Expressway, Austin, Texas, 78759-3504. Visit the Worldwide 
Offices section at ni.com/niglobal to access the branch office Web 
sites, which provide up-to-date contact information, support phone 
numbers, email addresses, and current events.

Support in NI-DAQ 7.4
Version 7.4 of NI-DAQmx supports the full line of NI measurement 
devices. Future releases of NI-DAQ will add support for new devices in 
only NI-DAQmx; new devices will not be added to Traditional NI-DAQ 
(Legacy).

Operating System Support
NI-DAQmx and Traditional NI-DAQ (Legacy) version 7.4 and 
NI-SWITCH 2.3 support Windows 2000/NT/XP. NI-DAQ 7.x on 
Windows NT requires Service Pack 6 or later.

NI-DAQmx 7.4 supports PharLap only with the LabVIEW Real-Time 
Module 7.1.

Measurement Studio requires Visual Studio .NET 2003, which requires 
Windows 2000/NT 4.0/XP. 

If you are using the DAQmx .NET Library, the .NET 1.1 framework is 
required. .NET 1.1 requires Windows 2000/XP.

For operating system-specific installation instructions, use the Hardware 
Installation/Configuration Troubleshooter at ni.com/support/
install.

To find and download an earlier version of NI-DAQ that supports other 
operating systems, refer to ni.com/downloads. 
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Application Software Support
Table 1 lists the application software versions supported by NI-DAQmx 
and Traditional NI-DAQ (Legacy). If you are not using NI application 
software, refer to Table 2.

 

Programming Language and Compiler Support
 

Earlier versions of NI-DAQ support other application software and 
language versions. To find and download an earlier version, refer to 
ni.com/downloads.

Table 1.  NI-DAQ 7.x Application Software Support

NI Application Software

Versions 
Supported by 
NI-DAQmx

Versions 
Supported by 
Traditional 

NI-DAQ (Legacy)

LabVIEW  7.x 6.1–7.x

LabVIEW Real-Time Module 7.1* 6.1–7.x

LabWindows/CVI  7.x 6.0–7.x

Measurement Studio  7.x 6.0–7.x†

* To use the LabVIEW Real-Time Module 7.1 with NI-DAQmx, you must use NI-DAQmx 
version 7.2 or later.
† Traditional NI-DAQ (Legacy) does not include a Measurement Studio C++ or .NET 
interface.

Table 2.  NI-DAQ 7.x Programming Language Support

Programming Language

Versions 
Supported by 
NI-DAQmx

Versions 
Supported by 
Traditional 

NI-DAQ (Legacy)

Microsoft Visual C++
Class libraries
ANSI C

7.x *

6.0–7.x
—

6.0–7.x

Visual Basic — 6.0†

Microsoft .NET framework 
(C# and Visual Basic .NET)

.NET 1.1 —

Borland — ✓

* Requires Measurement Studio version 7.x.
† Support through ActiveX.
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Device Support
Table 3 lists the families of devices supported in NI-DAQ 7.4 by 
NI-DAQmx and Traditional NI-DAQ (Legacy). For specific device model 
names, refer to the NI-DAQ 7.x Readme on the CD. 

Table 3.  NI-DAQ 7.4 Device Support

Device NI-DAQmx

Traditional 
NI-DAQ 
(Legacy)

Multifunction DAQ

PCI, PCI express, and PXI M Series devices, such as the NI PCI-622X/625X/628X ✓ —

PCI and PXI E Series devices, such as the NI PCI-6052E ✓ ✓

PCMCIA E Series NI DAQCard-6024E, NI DAQCard-6036E, and NI DAQCard-6062E ✓ ✓

AT E Series — ✓

NI PCI-6010 ✓ —

NI PCI-6013/6014 basic devices ✓ ✓

NI DAQPad-6015 (BNC)/6015 (Mass Termination)/6016 devices for USB ✓ —

NI DAQPad-6020E/6052E/6070E devices for USB and FireWire® (IEEE 1394) — ✓

NI PCI-7041/6040E device for LabVIEW RT ✓ ✓

NI PXI and PCI-7030 device for LabVIEW RT — ✓

S Series NI PXI and PCI-6122/6123/6132/6133/6143 ✓ —

S Series, such as the NI PXI-6115/6120 and NI PCI-6110/6111 ✓ ✓

Analog Output/Waveform

NI PXI and PCI-6711/6713 waveform ✓ ✓

PCMCIA NI DAQCard-6715 ✓ ✓

NI PXI and PCI-6722/6723 ✓ —

NI PXI and PCI-6731/6733 ✓ ✓

NI PXI-6704 and PCI-6703/6704 ✓ ✓

AT-AO-6/10 — ✓

Analog Input: PCMCIA DAQCard-AI-16E-4 and DAQCard-AI-16XE-50 — ✓

Counter/Timer

NI PCI-6601/6602 and NI PXI-6602/6608 ✓ ✓

NI PXI and PCI-6624 isolated ✓ —

Digital I/O

NI 6503, NI PXI-6508, NI 6527, and NI PCI-DIO-96 ✓ ✓

NI 6509/6510/6511/6512/6513/6514/6515/6516/6517/6518/6519 and NI 6528 ✓ —

DAQCard-6533 and AT-DIO-32HS — ✓
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Devices No Longer Supported in NI-DAQ 7.x
The following products are not supported in NI-DAQ 7.x—NI-DAQmx 
nor Traditional NI-DAQ (Legacy)—and will not be supported in future 
versions. You must use NI-DAQ 6.9.x or earlier to program these devices:

Digital I/O (continued)

All other NI 653X high-speed digital ✓ ✓

PCMCIA NI DAQCard-DIO-24 ✓ ✓

NI DAQPad-6507/6508 for USB — ✓

PC-DIO-24 and PC-DIO-96 — ✓

AT-DIO-32F — ✓

Dynamic Signal Acquisition

NI PXI-4472/4472B and PCI-4472/4474 ✓ ✓

NI PXI-4461/4462 ✓ —

NI PCI-4451/4452/4454 and 4551/4552 — ✓

Signal Conditioning

SCXI-1521/B and SCXI-1600 modules ✓ —

All other SCXI signal conditioning modules ✓ ✓

NI PXI-4200/4204/4220/4225 integrated signal conditioning ✓ —

SCC Series modules ✓ ✓

TEDS devices: BNC-2096, SC-2350 carrier, and SCXI-1314T 
Note: These devices support reading from and writing to TEDS sensors.

✓ —

Switch

NI SCXI-1160, SCXI-1161, and SCXI-1163R modules ✓ ✓

All other SCXI switch modules ✓ —

PXI switch modules ✓ —

NI AT-MIO-16F-5
NI DAQCard-500
NI DAQCard-516
NI DAQCard-700
NI DAQCard-1200
NI DAQCard-AO-2DC
NI DAQPad-1200
NI DAQPad-MIO-16XE-50
NI Lab-PC and Lab-PC+
NI Lab-PC-1200/AI
NI PC-516

NI PC-AO-2DC
NI PC-LPM-16/PNP
NI PC-OPDIO-16
NI PC-TIO-10
NI PCI-1200
NI SCXI-1200
NI SCXI-2000
NI SCXI-2400
NI VXI DAQ modules
NI VXI-SC carriers and modules
NI VXI-TB terminal blocks for VXI bus

Table 3.  NI-DAQ 7.4 Device Support (Continued)

Device NI-DAQmx

Traditional 
NI-DAQ 
(Legacy)
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Guide de démarrage DAQ
Ce guide décrit les étapes à suivre pour installer et configurer le driver 
NI-DAQ 7.x, ainsi qu’un périphérique d’acquisition de données (DAQ), 
et confirmer que ce périphérique fonctionne correctement.

Ce guide ne décrit pas l’installation ni la configuration du module NI 
Switch ; reportez-vous pour cela au manuel NI Switches Getting Started 
Guide.
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Conventions
Les conventions suivantes sont utilisées dans ce manuel.

<> Les simples chevrons indiquent des touches de fonction.

» Le symbole » vous dirige vers les éléments de menu emboîtés et les options 
de boîtes de dialogue donnant lieu à une action finale. La séquence 
Fichier»Mise en page»Options vous invite à cliquer sur le menu déroulant 
Fichier, à sélectionner l’élément Mise en page, puis Options.

Cette icône signale une remarque qui vous donne des informations 
importantes.

Cette icône signale un avertissement qui vous indique les précautions à 
prendre pour éviter des préjudices corporels, des pertes de données ou un 
blocage du système. Si ce symbole est présent sur le périphérique, 
reportez-vous au document Read Me First: Safety and Radio-Frequency 
Interference, livré avec le périphérique, pour vous renseigner sur les 
précautions à prendre.

La présence de ce symbole sur un produit indique une mise en garde vous 
conseillant de prendre des précautions pour éviter les chocs électriques.

La présence de ce symbole sur un produit indique qu’un composant risque 
d’être brûlant. Toucher ce produit peut provoquer des préjudices corporels.

gras Le texte en gras signale les éléments que vous devez sélectionner ou sur 
lesquels vous devez cliquer dans le logiciel, par exemple les éléments de 
menus et les options de boîtes de dialogue. 
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italiques Le texte en italiques indique une référence croisée, une introduction à un 
concept clé, ou un texte qui est substituable par un mot ou une valeur que 
vous devez fournir.

italique monospace Le texte en italique de cette police signale le texte qui sert d’emplacement 
à un mot ou une valeur que vous devez fournir.

monospace Cette police signale du texte ou des caractères que vous devez saisir à partir 
du clavier, des codes d’erreur, les noms propres de disques durs, des 
chemins, des programmes, des fonctions, des noms de fichiers et des 
extensions.

Driver NI-DAQ 7.x
Les périphériques de mesure de National Instruments sont livrés avec le 
driver NI-DAQ, une bibliothèque de fonctions et de VIs que vous pouvez 
appeler à partir d’un environnement de développement, tel que LabVIEW 
ou LabWindows™/CVI™, pour programmer vos périphériques de mesure 
NI. Les périphériques de mesure comprennent les périphériques DAQ tels 
que les modules d’E/S multifonctions (MIO) de la série M, les modules de 
conditionnement de signal et les modules Switch. Le driver est constitué 
d’une API (Application Programming Interface), composée d’une 
bibliothèque de VIs, de fonctions, de classes, d’attributs et de propriétés qui 
servent à créer des applications pour votre périphérique.

NI-DAQ 7.x comprend deux drivers NI-DAQ, chacun avec sa propre API et 
sa propre configuration matérielle et logicielle. 

• NI-DAQmx est le tout dernier driver NI-DAQ doté des avantages 
suivants par rapport à NI-DAQ traditionnel (ancien driver) :

– Assistant DAQ : méthode graphique permettant de configurer des 
voies virtuelles et des tâches de mesure pour votre périphérique, et 
de générer du code NI-DAQmx basé sur vos voies virtuelles et vos 
tâches, en vue de l’utiliser avec LabVIEW, LabWindows/CVI et 
Measurement Studio.

– Performances accrues, notamment des E/S analogiques point par 
point et un multithreading plus rapides.

– Périphériques simulés NI-DAQmx permettant de tester et de 
modifier des applications sans avoir à connecter de matériel. 

– Des API plus simples et plus intuitives pour créer des applications 
DAQ grâce à un nombre réduit de fonctions et de VIs, comparé 
aux versions antérieures de NI-DAQ.

– Fonctionnalité étendue pour LabVIEW, notamment le support des 
nœuds de propriété et du type de données waveform.
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– Fonctionnalités et API similaires pour ANSI C, LabWindows/CVI 
et Measurement Studio, y compris les interfaces natives .NET 
et C++.

– Support et performances améliorés du Module LabVIEW 
Real-Time.

• NI-DAQ traditionnel (ancien driver) est une mise à jour de la version 
antérieure de NI-DAQ. NI-DAQ traditionnel (ancien driver) comprend 
les mêmes VIs et fonctions que NI-DAQ 6.9.3 et fonctionne de la 
même manière, à ces exceptions près : vous pouvez utiliser NI-DAQ 
traditionnel (ancien driver) et NI-DAQmx sur le même ordinateur et 
certains composants matériels ne sont plus supportés. 

Qui peut se servir de NI-DAQmx ?
Vous devriez installer et utiliser NI-DAQmx si les situations suivantes vous 
concernent :

• Vous êtes un nouvel utilisateur de NI-DAQ.

• Vous utilisez des périphériques supportés par NI-DAQmx ; 
reportez-vous à la section Support dans NI-DAQ 7.4 à la fin de ce 
guide.

• Vous utilisez Windows 2000/NT/XP.

Si vous utilisez des logiciels d’application NI avec NI-DAQmx, vous devez 
utiliser LabVIEW, LabWindows/CVI, Measurement Studio version 7.x, 
VI Logger 2.x ou le Module LabVIEW Real-Time 7.1 ou version 
ultérieure.

Si vous utilisez un des langages .NET, Visual C# et/ou Visual Basic .NET 
de Microsoft, ou un périphérique supporté uniquement par NI-DAQmx, 
comme un périphérique de la série M, vous devez utiliser NI-DAQmx.

Vous pouvez aussi utiliser NI-DAQmx avec un compilateur supporté, 
comme par exemple, un compilateur ANSI C.

Qui peut se servir de NI-DAQ traditionnel (ancien driver) ?
Vous devriez utiliser NI-DAQmx si vous êtes un nouvel utilisateur de 
NI-DAQ ou si votre application remplit les conditions suivantes. Installez 
et utilisez NI-DAQ traditionnel (ancien driver) si l’une des situations 
suivantes s’applique :

• Vous avez un périphérique qui n’est pas supporté par NI-DAQmx, 
comme les périphériques DAQ multifonctions de la série E au 
format AT.

• Vous utilisez une version de LabVIEW, LabWindows/CVI ou 
Measurement Studio antérieure à la version 7.0.
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• Vous utilisez le Module LabVIEW Real-Time pour Macintosh.

• Vous effectuez une mise à niveau à partir de NI-DAQ 6.9.x et vous avez 
des applications existantes que vous ne voulez pas convertir en 
NI-DAQmx tout de suite. 

Remarque NI-DAQ traditionnel (ancien driver) ne supporte les logiciels d’application NI 
qu’à partir de la version 6.0. LabVIEW, LabWindows/CVI et Measurement Studio version 
6.x peuvent utiliser le logiciel NI-DAQ traditionnel (ancien driver) de la distribution 
NI-DAQ 7.x.

Comment NI-DAQ s’intègre-t-il à votre système ?
La figure 1 représente une vue d’ensemble du système de mesure, illustrant 
le chemin à partir du phénomène physique réel jusqu’à votre application de 
mesure.

Des capteurs et des transducteurs détectent des phénomènes physiques. Les 
éléments de conditionnement de signaux conditionnent ces phénomènes 
physiques de sorte que le périphérique de mesure puisse recevoir les 
données. L’ordinateur reçoit les données par l’intermédiaire du 
périphérique de mesure. Le logiciel contrôle le système de mesure, 
précisant au périphérique de mesure à quel moment il doit acquérir ou 
générer les données, et sur quelles voies physiques. Le logiciel prend aussi 
les données brutes, les analyse et les présente dans un format que vous 
pouvez comprendre, comme un graphe, un graphe déroulant ou un fichier 
de rapport. 
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Figure 1.  Présentation du système de mesure

Les périphériques de mesure et les logiciels d’application NI sont livrés 
avec le driver NI-DAQ, lequel permet de programmer toutes les 
fonctionnalités de vos périphériques de mesure NI, comme la 
configuration, l’acquisition et la génération de données, ainsi que l’envoi de 
données à des périphériques de mesure NI. NI-DAQ vous évite d’avoir à 
écrire tous ces programmes vous-même. L’environnement de 
développement, comme LabVIEW, LabWindows/CVI, Measurement 
Studio et VI Logger, émet des commandes au driver, comme celles 
d’acquérir et de renvoyer la lecture d’un thermocouple, puis affiche et 
analyse les données acquises.

Vous pouvez utiliser le driver NI-DAQ à partir de l’environnement de 
développement NI ou de n’importe quel environnement de développement 
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qui supporte les appels de DLLs (Dynamic Link Libraries) au moyen 
d’interfaces ANSI C. Quel que soit votre environnement de 
développement, votre application DAQ utilise NI-DAQ, comme illustré 
dans la figure 1.

Étape 1. Installez le logiciel d’application
Installez votre logiciel d’application NI. Si vous utilisez NI-DAQmx pour 
programmer les périphériques DAQ de votre système, installez 
LabVIEW 7.x, LabWindows/CVI 7.x, Measurement Studio 7.x, 
VI Logger 2.x ou le Module LabVIEW Real-Time 7.1 ou version 
ultérieure.

Si vous avez une application qui a été développée avec une version 
antérieure de votre logiciel d’application ou de NI-DAQ, faites-en une 
copie de sauvegarde. Vous pouvez ensuite mettre à jour votre logiciel et 
modifier l’application.

Étape 2. Installez le driver NI-DAQ 7.x

Insérez le CD

Mise en garde N’installez pas NI-DAQ 7.x si vos applications existantes comprennent des 
éléments non supportés ! Avant d’installer ce logiciel, reportez-vous à la section Support 
dans NI-DAQ 7.4 à la fin de ce guide.

L’installeur NI-DAQ 7.x devrait s’ouvrir automatiquement. Si ce n’est pas 
le cas, sélectionnez Démarrer»Exécuter. Entrez x:\setup.exe, où x 
correspond à la lettre du lecteur de CD. Pour consulter des instructions de 
dépannage, reportez-vous à la rubrique Hardware Installation / 
Configuration Troubleshooter sur ni.com/support/install.
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Installez le driver avant d’installer de nouveaux périphériques matériels, de 
sorte que Windows puisse détecter votre périphérique.

Sélectionnez l’API (ou les API) à installer

Mise en garde NI-DAQ 7.x ne peut pas coexister avec une version antérieure de NI-DAQ 
sur le même ordinateur. Lorsque vous installez NI-DAQ 7.x, la dernière version de 
NI-DAQ traditionnel (ancien driver) remplace les versions précédentes de NI-DAQ et tous 
les fichiers support installés par celles-ci. Quand vous installez uniquement NI-DAQmx, 
les versions de NI-DAQ antérieures à NI-DAQ 6.9.x sont supprimées.

NI-DAQ 7.x comprend plusieurs drivers avec leur API : NI-DAQmx, 
NI-SWITCH et NI-DAQ traditionnel (ancien driver). Selon les 
périphériques que vous utilisez, vous pouvez choisir d’installer tous ces 
drivers ou un seul. Reportez-vous à la section Support dans NI-DAQ 7.4 à 
la fin de ce guide pour savoir quels drivers supportent les périphériques 
installés dans votre système.

Vous pouvez utiliser NI-SWITCH ou NI-DAQmx pour programmer un 
module NI Switch. 

Installez les fichiers support
L’installeur NI-DAQ 7.x détecte tous les logiciels NI installés sur le 
système et sélectionne automatiquement sur le CD les fichiers support des 
versions les plus récentes des drivers, logiciels d’application et langages 
qu’il a détectés, comme illustré dans l’exemple qui suit.
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1. Vérifiez que l’installeur a détecté et sélectionné les fichiers support 
appropriés et que le numéro de version du logiciel d’application et/ou 
du langage est correct.

Si vous installez NI-DAQ 7.x avant d’installer un logiciel d’application 
NI de la version 7.x, vous devez à nouveau exécuter l’installeur 
NI-DAQ 7.x afin d’installer le fichier support qui convient pour ce 
logiciel d’application.

2. Cliquez sur Suivant à l’invite.

3. Cliquez sur Terminer.

4. Une fois que l’installeur a terminé, un message apparaît pour vous 
demander si vous voulez redémarrer, quitter ou arrêter.

• Redémarrer — Si vous utilisez un système qui exécute le Module 
LabVIEW Real-Time, redémarrez l’ordinateur. Téléchargez 
NI-DAQ 7.x vers la cible à l’aide de MAX (Measurement & 
Automation Explorer). Reportez-vous à l’Aide Measurement & 
Automation Explorer sur les systèmes déportés en sélectionnant 
Aide»Rubriques de l’aide»Systèmes déportés.

• Quitter — Si vous avez d’autres logiciels NI à installer, quittez le 
programme et installez-les. Si vous utilisez un lien MXI-3 à partir 
d’un PC pour contrôler un châssis PXI, vous devez quitter le 
programme et installer le logiciel MXI-3, disponible sur 
ni.com/downloads, avant d’utiliser le périphérique DAQ.

• Arrêter — Si vous êtes prêt(e) à installer votre périphérique, 
arrêtez le système.

Étape 3. Déballez les périphériques, les accessoires et 
les câbles

Votre périphérique est livré dans un sachet antistatique pour protéger le 
périphérique et ses composants contre les décharges électrostatiques 
(ESD).

Mise en garde Ne touchez jamais les broches des connecteurs.

Pour éviter de tels dommages, respectez les précautions suivantes :

• Utilisez un bracelet antistatique ou touchez un objet en contact avec la 
masse pour être relié à la masse.

• Mettez en contact le sachet antistatique avec la partie métallique du 
châssis de l’ordinateur avant de retirer le périphérique du sachet.

Retirez le périphérique de son sachet. Examinez les composants pour 
repérer tout signe d’endommagement. Contactez NI si le périphérique 
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apparaît endommagé d’une façon quelconque. N’installez pas un 
périphérique endommagé.

Conservez le périphérique dans le sachet antistatique quand il n’est pas 
utilisé.

Pour consulter les informations de conformité et de sécurité, reportez-vous 
à la documentation du périphérique, comme elle est décrite dans l’Étape 9. 
Naviguez dans la documentation du périphérique ou installez celle-ci.

Étape 4. Installez les périphériques, les accessoires et 
les câbles

Si vous avez plusieurs périphériques DAQ à installer, installez-les tous 
maintenant. Si votre système comprend des modules SCXI qui doivent être 
connectés à des périphériques DAQ, installez d’abord les composants DAQ 
à l’aide de ce guide ; vous installerez les modules SCXI dans l’Étape 10. 
Installez les périphériques de conditionnement de signal ou de 
commutation.

Pour tester des applications NI-DAQmx sans installer de matériel, vous 
pouvez utiliser un périphérique simulé NI-DAQmx. Passez directement 
à l’Étape 6. Lancez MAX et reportez-vous à l’Aide MAX pour NI-DAQmx 
en sélectionnant Aide»Rubriques de l’aide»NI-DAQmx pour obtenir des 
instructions sur la manière de créer des périphériques simulés NI-DAQmx 
et d’importer des configurations de périphériques simulés NI-DAQmx dans 
des périphériques matériels. 

Mise en garde Respectez les précautions à suivre contre les dommages électrostatiques 
avant d’installer le matériel. Consultez le document des spécifications se rapportant à votre 
périphérique pour lire des informations importantes concernant la sécurité et la 
compatibilité.

Périphériques PCI
Effectuez les étapes suivantes pour installer le périphérique PCI :

1. Mettez le châssis hors tension et débranchez-le de l’ordinateur.

2. Retirez le capot de votre ordinateur et/ou le cache de l’emplacement 
d’extension.

3. Touchez n’importe quelle partie métallique de l’ordinateur pour 
décharger l’électricité statique.

4. Insérez le périphérique dans l’emplacement PCI. Ajustez-le 
soigneusement pour qu’il soit parfaitement inséré. Ne forcez pas le 
périphérique dans son emplacement.
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Figure 2.  Installation d’un périphérique PCI

5. Fixez le support de fixation du périphérique au rail du panneau arrière 
de l’ordinateur.

6. Remettez en place le capot de l’ordinateur.

Périphériques PXI
Effectuez les étapes suivantes pour installer le module PXI.

1. Mettez le châssis PXI hors tension et débranchez-le.

Mise en garde Reportez-vous au document Read Me First: Safety and Radio-Frequency 
Interference livré avec votre châssis ou périphérique PXI avant de retirer le couvercle du 
matériel ou de connecter et de déconnecter des câbles de signal.

2. Retirez le cache de protection d’un emplacement PXI vide. Pour savoir 
quels emplacements utiliser dans le châssis, reportez-vous à la 
documentation du périphérique, comme expliqué dans l’Étape 9. 
Naviguez dans la documentation du périphérique ou installez celle-ci.

3. Touchez n’importe quelle partie métallique du châssis pour décharger 
l’électricité statique.

4. Vérifiez que la poignée d’insertion/éjection du module PXI n’est pas 
verrouillée et qu’elle tourne librement.

5. Placez les bords du module PXI dans les guides pour module en haut 
et en bas du châssis.
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6. Faites glisser le périphérique dans l’emplacement PXI à l’arrière du 
châssis.

7. Dès que vous sentez une résistance, relevez la poignée 
d’insertion/éjection pour insérer complètement le périphérique.

8. Vissez le périphérique sur le support de fixation situé à l’avant du 
châssis à l’aide des vis de montage.

 

Figure 3.  Installation d’un périphérique PXI

Périphériques PCMCIA
Vous pouvez installer le périphérique NI PCMCIA dans n’importe quel 
emplacement de carte PC de type II disponible. Effectuez les étapes 
suivantes pour installer le périphérique PCMCIA.

1. Si nécessaire, retirez le cache de protection de l’emplacement 
PCMCIA.

2. Insérez le connecteur de bus PCMCIA du périphérique PCMCIA dans 
l’emplacement jusqu’à ce qu’il soit solidement installé.

3. Branchez le câble d’E/S. Prenez garde à ne pas tirer trop fort sur le 
câble d’E/S quand vous insérez ou retirez son connecteur. Saisissez 
toujours le câble par son connecteur quand vous le connectez ou 
l’enlevez. Ne tirez jamais directement sur le câble d’E/S pour le 
débrancher du périphérique PCMCIA.
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Figure 4.  Installation d’un périphérique PCMCIA

Périphériques USB/IEEE 1394
Exécutez les étapes suivantes pour installer un périphérique NI de type 
USB ou IEEE 1394 :

1. Effectuez les connexions d’alimentation.

• Si vous utilisez un pack batterie BP-1, suivez les instructions de 
votre guide d’installation BP-1.

• Certains périphériques NI de type USB ou IEEE 1394 nécessitent 
une alimentation externe.

– Si votre périphérique utilise une alimentation externe, 
assurez-vous que la tension sur le bloc d’alimentation 
externe, le cas échéant, est compatible avec le courant secteur 
dans votre région (120 ou 230 VAC) et avec la tension exigée 
par votre périphérique. Connectez une extrémité du bloc 
d’alimentation à une prise secteur et branchez l’autre 
extrémité à l’arrière du périphérique.

– Si votre périphérique est doté d’un cordon d’alimentation, 
connectez une extrémité du cordon d’alimentation au 
périphérique et l’autre à une prise secteur.

2. Reliez le câble entre le port USB ou IEEE 1394, situé directement sur 
le PC ou sur tout autre hub ou périphérique IEEE 1394, et le port USB 
ou IEEE 1394 du périphérique. 
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3. Si votre périphérique USB ou IEEE 1394 est équipé d’un bouton 
d’alimentation, mettez-le sous tension. L’ordinateur devrait détecter 
immédiatement votre périphérique.

Accessoires
Installez les accessoires et/ou les blocs de terminaison suivant les 
instructions fournies dans leurs guides d’installation respectifs. Pour les 
systèmes de conditionnement de signal SCXI et SCC, continuez à suivre les 
instructions de ce guide jusqu’à l’Étape 10. Installez les périphériques de 
conditionnement de signal ou de commutation.

Étape 5. Mettez votre ordinateur ou châssis PXI sous 
tension

Windows détecte et reconnaît tous les périphériques nouvellement installés 
dès le premier redémarrage qui suit l’installation. Sur certains systèmes 
Windows, l’Assistant Nouveau matériel détecté s’ouvre avec une boîte de 
dialogue pour chaque périphérique NI installé. Installer le logiciel 
automatiquement (Recommandé) est sélectionné par défaut. Cliquez sur 
Suivant ou sur Oui pour installer le logiciel pour chaque périphérique et 
permettre ainsi à Windows de le reconnaître.

Lorsque l’ordinateur reconnaît un périphérique USB ou IEEE 1394, le 
voyant LED d’alimentation clignote ou s’allume. Les périphériques NI de 
type IEEE 1394 possèdent aussi un voyant LED COM qui clignote quand 
le périphérique est détecté. Pour connaître la signification des états de la 
LED sur votre périphérique particulier, reportez-vous à la documentation 
du périphérique, comme expliqué dans l’Étape 9. Naviguez dans la 
documentation du périphérique ou installez celle-ci. 

Étape 6. Lancez MAX
Double-cliquez sur l’icône Measurement & Automation qui se trouve sur 
le bureau pour ouvrir MAX.

Étape 7. Confirmez que le périphérique est reconnu
Suivez ces étapes :

1. Développez la catégorie Périphériques et interfaces. Si vous utilisez 
une cible RT déportée, développez l’élément Systèmes déportés, 
recherchez et développez votre cible, et développez ensuite la 
catégorie Périphériques et interfaces.
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2. Vérifiez que votre périphérique apparaît bien sous Périphériques et 
interfaces. 

Si votre périphérique n’apparaît pas, appuyez sur <F5> pour rafraîchir 
l’affichage dans MAX. Si votre périphérique n’est toujours pas 
reconnu, reportez-vous à la page ni.com/support/install pour 
obtenir des informations de dépannage.

3. Dans le dossier de l’API NI-DAQ que vous utilisez pour programmer 
votre périphérique, cliquez avec le bouton droit sur le périphérique que 
vous voulez tester. 

• Si le périphérique est sous NI-DAQmx, sélectionnez Auto-test.
 

1 Quand un périphérique est supporté à la fois par NI-DAQmx et NI-DAQ 
traditionnel (ancien driver) et que ces deux drivers sont installés, le même 
périphérique apparaît sous un nom différent dans les dossiers NI-DAQmx et 
NI-DAQ traditionnel sous Système»Périphériques et interfaces. 

2 Seuls les périphériques NI-DAQmx sont recensés sous Systèmes 
déportés»Périphériques et interfaces. 

1

2
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Si vous avez besoin d’aide au cours de l’auto-test, ouvrez Aide 
Measurement & Automation Explorer pour NI-DAQmx en 
sélectionnant Aide»Rubriques de l’aide»NI-DAQmx. 

• Si votre périphérique est sous NI-DAQ traditionnel (ancien 
driver), sélectionnez Propriétés, puis cliquez sur Tester les 
ressources dans la fenêtre de propriétés.

4. Au terme de l’auto-test, un message s’affiche, indiquant si la 
vérification s’est déroulée sans problème ou si une erreur a eu lieu. 
Si une erreur s’est produite, reportez-vous à ni.com/support/
install pour obtenir des informations de dépannage.

Étape 8. Configurez les paramètres du périphérique
Configurez chaque périphérique que vous installez :

1. Effectuez un clic droit sur le nom du périphérique et sélectionnez 
Propriétés. Assurez-vous de cliquer sur le nom du périphérique se 
trouvant dans le dossier de l’API de NI-DAQ que vous voulez utiliser 
pour commander le périphérique. Si vous utilisez une cible RT 
déportée, les périphériques NI-DAQmx sont répertoriés sous Systèmes 
déportés»Périphériques et interfaces.

2. Configurez les propriétés du périphérique. Pour utiliser un 
périphérique à la fois dans NI-DAQmx et dans NI-DAQ traditionnel 
(ancien driver), vous devez configurer ses propriétés dans chacun de 
ces drivers.

• Si vous utilisez un accessoire, ajoutez les informations qui le 
concernent.

• Si vous utilisez un périphérique dans NI-DAQ traditionnel (ancien 
driver), sélectionnez Aide dans MAX pour vous référer à l’Aide 
Measurement & Automation Explorer pour NI-DAQ traditionnel.

• Pour des capteurs et des accessoires TEDS (Transducer Electronic 
Data Sheet) IEEE 1451.4, configurez le périphérique et ajoutez les 
accessoires comme décrit plus haut. Cliquez sur Recherche de 
TEDS. Pour configurer des capteurs TEDS qui sont connectés 
directement à un périphérique, faites un clic droit dans MAX sur 
le périphérique figurant sous Périphériques et interfaces et 
sélectionnez Configurer un TEDS.

3. Cliquez sur OK pour valider les changements.

Pour convertir des voies virtuelles, des configurations d’échelles et des 
configurations SCXI et d’accessoires NI-DAQ traditionnel (ancien driver) 
en une configuration NI-DAQmx, sélectionnez Outils»Configuration 
NI-DAQmx»Convertir la configuration NI-DAQ traditionnel (ancien 
driver) en NI-DAQmx. L’Assistant ne convertit pas les configurations 
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SCC ; vous devez configurer les informations SCC séparément dans chaque 
API que vous souhaitez utiliser. Cliquez sur Aide dans l’Assistant pour 
obtenir des informations complémentaires sur la conversion de vos 
configurations.

Étape 9. Naviguez dans la documentation du 
périphérique ou installez celle-ci

Le kit logiciel NI-DAQ 7.x comprend une documentation en ligne pour les 
périphériques et les accessoires supportés, notamment des fichiers PDF et 
des fichiers d’aide décrivant les terminaux, les spécifications, les 
fonctionnalités et le mode d’opération du périphérique. Pour trouver, 
afficher et imprimer les documents se rapportant à chaque périphérique, 
insérez le CD Device Documentation. Vous devez avoir Internet Explorer 
version 5.0 ou version ultérieure pour utiliser certaines fonctionnalités de 
la documentation NI-DAQ 7.x, comme par exemple l’aide et l’explorateur 
Device Document Browser. Après l’installation, vous pouvez accéder à 
l’explorateur et à la documentation du périphérique à partir de 
Démarrer»Programmes»National Instruments»NI-DAQ»
Browse Device Documentation. 

Si vous ne possédez pas ce CD, vous pouvez vous procurer la 
documentation en ligne sur les périphériques en allant sur 
ni.com/manuals. L’explorateur Device Document Browser est 
disponible sur ni.com/support ; sélectionnez Drivers and 
Updates»Most Popular et la version NI-DAQ que vous utilisez pour 
ouvrir une page Web des instructions d’installation. Téléchargez le CD 2 de 
NI-DAQ et suivez les instructions pour installer NI-DAQ Device 
Documentation Browser.

Étape 10. Installez les périphériques de 
conditionnement de signal ou de commutation

Si votre système comprend des périphériques supplémentaires, comme des 
modules de conditionnement de signal ou des modules de commutation 
(switch), reportez-vous aux documents suivants pour installer et configurer 
le matériel de conditionnement de signal ou de commutation :

• Modules de conditionnement de signal SCXI et SCC (Signal 
Conditioning Components), comme les boîtiers SC et les modules 
SCC : reportez-vous au guide de démarrage du produit.

• Modules Switch : reportez-vous au document intitulé NI Switches 
Getting Started Guide.
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Le reste de ce guide s’applique uniquement aux périphériques DAQ ou aux 
périphériques de conditionnement de signal intégré PXI.

Étape 11. Connectez les lignes de capteurs et de 
signaux

Connectez les lignes de capteurs et de signaux aux blocs de connexion ou 
aux terminaux accessoires. Des informations utiles sont disponibles 
comme suit : 

• Connexions de signaux et de terminaux :

– Vous pouvez afficher et imprimer un schéma des connexions pour 
les tâches et les voies virtuelles NI-DAQmx dans votre système à 
l’aide de l’Assistant DAQ. Sélectionnez la tâche ou la voie 
virtuelle et cliquez sur l’onglet Diagramme des connexions. 
Sélectionnez chaque voie virtuelle dans la tâche pour afficher les 
noms et les numéros des terminaux pour les connexions 
nécessaires entre les capteurs et les blocs de connexion. 

– L’aide M Series Help, E Series Help et les manuels de l’utilisateur 
des périphériques et des accessoires sont compris dans 
l’explorateur Device Document Browser.

– Les affectations de broches, également accessibles à partir du 
menu d’aide MAX, sont décrites dans les rubriques Device 
Pinouts de l’Aide Measurement & Automation Explorer pour 
NI-DAQmx et dans l’Aide Measurement & Automation Explorer 
pour NI-DAQ traditionnel.

• Capteurs :

– Reportez-vous à ni.com/sensors.

– Si vous utilisez LabVIEW, reportez-vous au manuel LabVIEW 
Measurements Manual livré avec LabVIEW ou disponible à 
l’adresse ni.com/manuals. 

– Si vous utilisez NI-DAQmx, reportez-vous à la rubrique Sensors 
de NI-DAQmx Help, accessible à partir de Démarrer»
Programmes»National Instruments»NI-DAQ»
NI-DAQmx Help. 

– Pour obtenir des informations sur les capteurs intelligents TEDS 
IEEE 1451.4, consultez le site ni.com/zone. 

• Commutateurs : les spécifications d’un module de commutation 
comprennent une topologie de ce périphérique.
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Étape 12. Exécutez les panneaux de test
De nombreux périphériques comportent un panneau de test pour tester des 
fonctionnalités spécifiques à ce périphérique, par exemple sa capacité à 
acquérir ou à générer des signaux. 

1. Dans MAX, développez la catégorie Périphériques et interfaces»
Périphériques NI-DAQmx ou Périphériques et interfaces»
Périphériques NI-DAQ traditionnel. Si vous utilisez une cible RT 
déportée, développez l’élément Systèmes déportés, recherchez et 
développez votre cible, et développez ensuite la catégorie 
Périphériques et interfaces.

2. Cliquez avec le bouton droit sur le périphérique à tester. Assurez-vous 
de cliquer sur le nom du périphérique se trouvant dans le dossier de 
l’API de NI-DAQ que vous voulez utiliser.

3. Sélectionnez Panneaux de test pour ouvrir le panneau de test 
correspondant au périphérique sélectionné. NI-DAQ traditionnel 
(ancien driver) ne comporte pas de panneaux de test pour le Module 
LabVIEW Real-Time.
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Un exemple de panneau de test est représenté dans la figure suivante.

4. Cliquez sur les onglets pour tester différentes fonctions du 
périphérique. Cliquez sur Aide pour obtenir des instructions sur le 
fonctionnement des panneaux de tests dans NI-DAQmx. 
Reportez-vous à l’Aide Measurement & Automation Explorer pour 
NI-DAQ traditionnel pour obtenir des instructions sur le 
fonctionnement des panneaux de tests dans NI-DAQ traditionnel 
(ancien driver).

5. Le panneau de test affiche un message indiquant si une erreur s’est 
produite. Reportez-vous à NI-DAQmx Help ou à ni.com/support 
pour obtenir des informations de dépannage. 

6. Cliquez sur Fermer pour quitter le panneau de test.

Étape 13. Configurez tous les nouveaux périphériques
Si vous avez installé plus d’un périphérique DAQ, répétez l’Étape 8. 
Configurez les paramètres du périphérique à l’Étape 12. Exécutez les 
panneaux de test pour chacun d’eux. 
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Étape 14. Configurez les voies et les tâches
Cette étape ne s’applique que si vous programmez votre périphérique à 
l’aide de NI-DAQ ou d’un logiciel d’application NI. 

Une voie physique est un terminal ou broche sur lequel vous pouvez 
mesurer ou générer un signal analogique ou numérique. Une voie virtuelle 
est un ensemble de paramètres, comme un nom, une voie physique, des 
connexions d’entrée, le type de mesure ou de génération et peut inclure des 
informations de mise à l’échelle. Dans NI-DAQmx, les voies virtuelles font 
partie intégrante de la mesure. Dans NI-DAQmx, utilisez l’Assistant DAQ, 
auquel vous accédez à partir de MAX ou d’un logiciel d’application NI, 
pour configurer des voies virtuelles et des tâches de mesure. Reportez-vous 
à l’Aide Assistant DAQ et à l’Aide Measurement & Automation Explorer 
pour NI-DAQmx. Vous pouvez également configurer les voies virtuelles 
dans votre programme avec l’API de NI-DAQmx. Dans NI-DAQ 
traditionnel (ancien driver) et les versions précédentes, vous pouvez utiliser 
MAX pour configurer des voies virtuelles, ce qui offre un moyen 
d’enregistrer les voies physiques utilisées pour différentes mesures. 

Une tâche, concept essentiel de NI-DAQmx, est un ensemble d’une ou de 
plusieurs voies virtuelles qui comprend le cadencement, le déclenchement 
et d’autres propriétés. Fondamentalement, une tâche représente la mesure 
ou la génération que vous voulez réaliser. Vous pouvez définir et enregistrer 
toutes les informations de configuration dans une tâche et l’utiliser dans 
une application.

Dans NI-DAQmx, les voies virtuelles peuvent être définies comme faisant 
partie d’une tâche ou être configurées séparément de celle-ci. Les voies 
virtuelles créées à l’intérieur d’une tâche sont des voies virtuelles locales. 
Les voies virtuelles créées à l’extérieur d’une tâche sont des voies virtuelles 
globales. Vous pouvez créer des voies virtuelles globales dans MAX ou 
dans votre application logicielle, puis les enregistrer sous MAX. Vous 
pouvez utiliser les voies virtuelles globales dans n’importe quelle 
application ou les ajouter à différentes tâches. Si vous modifiez une voie 
virtuelle globale, les changements affectent toutes les tâches dans 
lesquelles cette voie est utilisée. 

Configuration d’une tâche dans NI-DAQmx
Lorsque vous utilisez NI-DAQmx, configurez les tâches à l’aide de 
l’Assistant DAQ. Vous devez avoir la version 7.0 ou une version ultérieure 
du logiciel d’application NI pour créer des tâches et des voies virtuelles 
avec l’Assistant DAQ.
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• Dans MAX, cliquez avec le bouton droit sur Voisinage de données et 
sélectionnez Créer un nouvel objet. Dans la fenêtre Créer un nouvel 
objet, sélectionnez Tâche NI-DAQmx, puis cliquez sur Suivant.

Si vous utilisez une cible RT déportée, développez la catégorie 
Systèmes déportés, recherchez et développez votre cible, puis faites 
un clic droit sur Voisinage de données et sélectionnez Créer un 
nouvel objet.

• Vous pouvez également ouvrir directement l’Assistant DAQ à partir de 
votre logiciel d’application NI :

– Dans LabVIEW :

• Déposez le VI Express Assistant DAQ sur le diagramme à 
partir de la palette “Entrée” des VIs Express, comme expliqué 
dans le manuel Initiation à LabVIEW. 

• Vous pouvez également placer la commande Nom de tâche 
DAQmx sur la face-avant, à partir de la palette de commandes 
Nom de tâche DAQmx, pour ouvrir l’Assistant DAQ. Cliquez 
avec le bouton droit sur la commande et sélectionnez 
Nouvelle tâche (Assistant DAQ). Le tutorial d’aide Prendre 
une mesure NI-DAQmx dans LabVIEW contient des 
instructions pas à pas pour créer une tâche à partir de la 
commande Nom de tâche DAQmx et générer le code associé 
à la tâche. Dans LabVIEW, sélectionnez Aide»Prendre une 
mesure NI-DAQmx.

– Dans LabWindows/CVI :

1. Sélectionnez Tools»Create/Edit DAQmx Tasks. La boîte 
de dialogue Create/Edit DAQmx Tasks s’ouvre. 

2. Sélectionnez Create New Task In MAX ou Create New 
Task In Project et cliquez sur OK.

– Dans Measurement Studio : 

1. Ouvrez Visual Studio .NET et le projet dans lequel vous 
voulez créer une classe de tâche DAQmx.

2. Sélectionnez Project»Add New Item. La boîte de dialogue 
Add New Item s’affiche. 

3. Dans la sous-fenêtre Categories, sélectionnez Measurement 
Studio»Assistants.

4. Dans la sous-catégorie Templates, sélectionnez DAQmx 
Task Class.

5. Spécifiez le nom du fichier de tâche DAQmx et cliquez sur 
Open. 
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6. Précisez si vous voulez créer une nouvelle tâche ou faire une 
copie de projet d’une tâche globale que vous créez dans 
MAX. 

7. Cliquez sur Terminer.

L’Assistant DAQ vous invite alors à créer une nouvelle tâche :

1. Choisissez un type d’E/S, comme par exemple, une entrée analogique.

2. Sélectionnez la mesure ou la génération à réaliser.

3. Sélectionnez le capteur à utiliser, le cas échéant.

4. Sélectionnez la ou les voies physiques à partir desquelles seront créées 
les voies virtuelles locales dans la tâche. Vous pouvez également 
ajouter des voies virtuelles globales existantes à la tâche ou copier ces 
informations dans la voie virtuelle locale à partir d’une voie virtuelle 
globale existante. 

Si votre système est configuré avec un capteur TEDS, cliquez sur 
l’onglet Voies TEDS. Sélectionnez la ou les voies physiques à utiliser. 
L’Assistant DAQ importe le paramètre du capteur et crée la tâche. 

Cliquez sur Suivant.

5. Si vous lancez l’Assistant DAQ à partir de MAX, tapez le nom de la 
nouvelle tâche. Cliquez sur Terminer.
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6. Si nécessaire, configurez des paramètres de mesures spécifiques, le 
cadencement, le déclenchement et les informations de mise à l’échelle. 
Si une ou plusieurs voies sont configurées pour des capteurs TEDS, il 
est possible que certains paramètres chargés à partir de TEDS ne 
puissent pas être modifiés.

7. Vous pouvez ajouter d’autres voies virtuelles à la tâche. Les voies 
virtuelles ajoutées à une tâche peuvent être du même type de mesure 
ou d’un type de mesure différent ; il est possible, par exemple, 
d’ajouter des voies virtuelles de température à une tâche de tension. 
Cliquez sur le bouton d’ajout ( ) afin d’ajouter une voie virtuelle. 

a. Sélectionnez dans la liste déroulante le type de mesure à ajouter.

b. Sélectionnez la ou les voies physiques à partir desquelles seront 
créées les voies virtuelles locales dans la tâche. Vous pouvez 
également ajouter des voies virtuelles globales existantes à la 
tâche ou copier ces informations dans la voie virtuelle locale à 
partir d’une voie virtuelle globale existante. 

c. Cliquez sur le bouton OK.

8. Enregistrez la tâche.

• Si vous avez ouvert l’Assistant DAQ à partir de LabVIEW ou de 
LabWindows/CVI, cliquez sur OK. 

• Si vous l’avez ouvert à partir de Measurement Studio, 
sélectionnez File»Save. 

• Si vous l’avez ouvert à partir de MAX, cliquez sur Enregistrer la 
tâche. 

Vous pouvez maintenant utiliser la tâche dans une application. Vous pouvez 
aussi éditer ou renommer une voie virtuelle dans l’Assistant DAQ.

Configuration de voies virtuelles globales dans NI-DAQmx
Si vous utilisez NI-DAQmx, configurez les voies virtuelles globales à 
l’aide de l’Assistant DAQ. Vous devez utiliser MAX pour créer des voies 
virtuelles globales, mais vous pouvez ajouter une voie virtuelle globale à 
partir du logiciel d’application. 

• Pour ouvrir l’Assistant DAQ dans MAX, faites un clic droit sur 
Voisinage de données et sélectionnez Créer un nouvel objet. 

Si vous utilisez une cible RT déportée, développez la catégorie 
Systèmes déportés, recherchez et développez votre cible, faites un clic 
droit sur Voisinage de données et sélectionnez Créer un nouvel 
objet.

Dans la fenêtre Créer un nouvel objet, sélectionnez Voie globale 
NI-DAQmx, puis cliquez sur Suivant.
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• Vous pouvez également ouvrir directement l’Assistant DAQ depuis le 
logiciel d’application NI : 

– Dans LabVIEW, utilisez la commande Voie globale DAQmx pour 
ouvrir l’Assistant DAQ. Cliquez avec le bouton droit sur la 
commande et sélectionnez Nouvelle voie (Assistant DAQ).

– Dans LabWindows/CVI ou Measurement Studio, vous devez au 
préalable créer une tâche, comme expliqué précédemment. Dans 
l’Assistant DAQ, cliquez sur le bouton d’ajout ( ), puis 
sélectionnez une voie virtuelle globale dans l’onglet Globales de 
la boîte de dialogue Ajouter des voies à la tâche. 

L’Assistant DAQ vous invite alors à créer une nouvelle voie virtuelle 
globale :

1. Choisissez un type d’E/S, comme par exemple, une entrée analogique. 

2. Sélectionnez la mesure ou la génération à réaliser. 

3. Sélectionnez le capteur à utiliser, le cas échéant. 

4. Sélectionnez la voie physique à partir de laquelle vous voulez créer une 
voie virtuelle globale. Si vous préférez, vous pouvez copier les 
informations d’une voie virtuelle globale existante.

Si votre système est configuré avec un capteur TEDS, cliquez sur 
l’onglet Voies TEDS. Sélectionnez la ou les voies physiques à utiliser. 
L’Assistant DAQ importe la configuration à partir du capteur. Si une 
ou plusieurs voies physiques sont configurées pour des capteurs 
TEDS, il est possible que certains paramètres chargés à partir de TEDS 
ne puissent pas être modifiés. Cliquez sur Suivant.

5. Tapez le nom de la nouvelle voie virtuelle globale. Cliquez sur 
Terminer.

6. Si nécessaire, configurez des paramètres de mesures spécifiques et les 
informations de mise à l’échelle. 

7. Enregistrez votre configuration.

Vous pouvez maintenant utiliser la voie virtuelle globale dans une 
application ou l’ajouter à une tâche.

Configuration de voies virtuelles pour NI-DAQ traditionnel 
(ancien driver)

Si vous utilisez NI-DAQ traditionnel (ancien driver), effectuez les étapes 
suivantes pour configurer des voies virtuelles dans MAX :

1. Ouvrez l’Assistant Création d’une nouvelle voie. 

• Dans MAX, cliquez avec le bouton droit sur Voisinage de 
données et sélectionnez Créer un nouvel objet. Dans la fenêtre 
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Créer un nouvel objet, sélectionnez Voie virtuelle NI-DAQ 
traditionnel, puis cliquez sur Terminer. 

• Si vous utilisez une cible RT déportée avec NI-DAQ traditionnel 
(ancien driver), sélectionnez Outils»Configuration NI-DAQ 
traditionnel»Configuration DAQ déportée. Les périphériques 
NI-DAQ traditionnel (ancien driver) d’un système déporté sont 
recensés dans la fenêtre Configuration DAQ déportée. 
Sélectionnez Voie et cliquez sur Ajouter.

2. Suivez les instructions de cet assistant pour créer une nouvelle voie. 
Pour obtenir des informations complémentaires sur la manière de 
configurer des voies, reportez-vous à l’Aide Measurement & 
Automation Explorer pour NI-DAQ traditionnel.

Étape 15. Utilisez votre tâche dans une application
Effectuez les étapes suivantes pour utiliser une tâche de mesure dans votre 
application. Reportez-vous à l’Aide Assistant DAQ pour obtenir de plus 
amples informations sur la manière d’utiliser une tâche ou de générer du 
code.

Pour exécuter des exemples sans avoir à installer de matériel, vous pouvez 
utiliser des périphériques simulés NI-DAQmx. Dans MAX, reportez-vous 
à l’Aide Measurement & Automation Explorer pour NI-DAQmx en 
sélectionnant Aide»Rubriques de l’aide»NI-DAQmx pour obtenir des 
instructions sur la manière de créer des périphériques simulés NI-DAQmx 
et d’importer des configurations de périphériques simulés NI-DAQmx dans 
des périphériques matériels. 
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LabVIEW
1. Ouvrez un VI vide dans LabVIEW. 

2. Placez la constante suivante sur le diagramme : Mesures NI»
DAQmx-Acquisition de données»Constante de nom de tâche 
DAQmx.

3. Sélectionnez la tâche dans la liste déroulante. 

4. Faites un clic droit sur le VI et sélectionnez Générer le code»
Exemple. 

5. Exécutez le programme à partir de la face-avant.

LabWindows/CVI
Reportez-vous à ni.com/info et tapez rddq73 pour obtenir des 
instructions pas à pas sur l’utilisation d'une tâche dans LabWindows/CVI.

Measurement Studio
Reportez-vous à ni.com/info et tapez rddqms pour obtenir des 
instructions pas à pas sur l’utilisation d’une tâche dans Measurement 
Studio.

Conseils pour le développement d’une application

Comment utiliser les exemples
Chaque API inclut un ensemble d’exemples de programmation vous 
permettant de démarrer le développement d’une application. Vous pouvez 
modifier le code d’un exemple et l’enregistrer dans une nouvelle 
application. Vous pouvez utiliser les exemples pour développer une 
nouvelle application ou ajouter le code des exemples dans une application 
existante.

Pour exécuter des exemples sans matériel installé, vous pouvez utiliser des 
périphériques simulés NI-DAQmx. Dans MAX, reportez-vous à l’Aide 
MAX pour NI-DAQmx en sélectionnant Aide»Rubriques de l’aide»
NI-DAQmx pour obtenir des informations sur les périphériques simulés 
NI-DAQmx. 

Pour trouver des exemples en LabVIEW ou en LabWindows/CVI, 
sélectionnez Aide»Recherche d’exemples, afin d’ouvrir l’Outil de 
recherche d’exemples National Instruments.
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Les exemples de NI-DAQmx pour les différents langages supportés par 
Measurement Studio (Visual Basic .NET, C# et MFC C++)  se trouvent 
dans les répertoires suivants :

• Exemples Measurement Studio MFC C++ — 
MeasurementStudioVS2003\VCNET\Examples\DAQmx 

• Exemples Visual C# et Visual Basic .NET (Measurement Studio non 
exigé) — MeasurementStudioVS2003\DotNET\
Examples\DAQmx

Les exemples de NI-DAQmx en ANSI C se trouvent dans le répertoire 
NI-DAQ\Examples\DAQmx ANSI C.

Les exemples de NI-DAQ traditionnel (ancien driver)  pour Visual Basic se 
trouvent dans les répertoires suivants :

• Le répertoire NI-DAQ\Examples\Visual Basic with 
Measurement Studio contient un lien vers les exemples de 
commande ActiveX CWDAQ DAQ traditionnel. Ces exemples 
utilisent une version d’évaluation de l’interface utilisateur ActiveX si 
Measurement Studio n’est pas installé.

• Le répertoire NI-DAQ\Examples\VBasic contient des exemples non 
associés à Measurement Studio.

Les exemples de NI-DAQ traditionnel (ancien driver) en ANSI C se 
trouvent dans le répertoire NI-DAQ\Examples\VisualC.

Pour consulter des centaines d’autres exemples, visitez le site 
ni.com/zone.

Informations sur les périphériques et les applications de mesure
Vous pouvez vous procurer des informations sur vos périphériques et 
applications de mesure aux endroits suivants.

LabVIEW
Si vous êtes un nouvel utilisateur, lisez la totalité du document Initiation à 
LabVIEW pour vous familiariser avec LabVIEW. Sélectionnez 
Démarrer»Programmes»National Instruments»LabVIEW 7.x»
Recherche dans les manuels PDF.

Le manuel LabVIEW Measurements Manual contient une vue d’ensemble 
des API de NI-DAQmx et de NI-DAQ traditionnel (ancien driver), ainsi 
qu’une description des concepts de mesure. Sélectionnez Démarrer»
Programmes»National Instruments»LabVIEW 7.x»Recherche dans 
les manuels PDF.
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Le tutorial d’aide Prendre une mesure NI-DAQmx dans LabVIEW contient 
des instructions pas à pas pour configurer une mesure avec LabVIEW. 
Il décrit aussi les nouvelles fonctionnalités clés de NI-DAQmx et les 
nouveaux concepts, comme l’Assistant et les tâches DAQ. Dans LabVIEW, 
sélectionnez Aide»Prendre une mesure NI-DAQmx.

L’Aide LabVIEW comprend une section Référence des VIs et des fonctions 
qui décrit les VIs LabVIEW et les propriétés pour NI-DAQmx et NI-DAQ 
traditionnel (ancien driver). Dans LabVIEW, sélectionnez Aide»Aide 
LabVIEW et parcourez la rubrique principale Référence des VIs et des 
fonctions dans l’onglet Sommaire pour trouver la section Référence des VIs 
et des fonctions pour l’API NI-DAQ que vous utilisez.

Module LabVIEW Real-Time
Sélectionnez Démarrer»Programmes»National Instruments»
LabVIEW 7.x»Module Documents»Search the LabVIEW Real-Time 
Module Bookshelf pour obtenir des liens vers les documents du Module 
LabVIEW Real-Time.

LabWindows/CVI
Si vous êtes un nouvel utilisateur, lisez la totalité du document Getting 
Started with LabWindows/CVI afin de  vous familiariser avec 
LabWindows/CVI. Dans LabWindows/CVI, sélectionnez 
Help»LabWindows/CVI Bookshelf. 

L’aide LabWindows/CVI Help contient une référence des concepts de 
mesure et des fonctions NI-DAQmx. Dans LabWindows/CVI, sélectionnez 
Help»Contents.

Measurement Studio
L’aide NI Measurement Studio Help contient une référence des concepts de 
mesure et des fonctions NI-DAQmx. Ce fichier d’aide est intégré dans la 
documentation de Visual Studio .NET. Dans Visual Studio .NET, 
sélectionnez Measurement Studio»NI Measurement Studio Help.

ANSI C sans logiciel d’application NI
Les documents NI-DAQmx Help et Traditional NI-DAQ User Manual 
contiennent une vue d’ensemble des API. L’aide NI-DAQmx Help contient 
aussi des informations d’ordre général sur les concepts de mesure. Les 
documents Traditional NI-DAQ C Reference Help et NI-DAQmx C 
Reference Help décrivent l’ensemble des fonctions et des attributs en C. 
Sélectionnez Démarrer»Programmes»National Instruments»
NI-DAQ»titre du document pour l’API de NI-DAQ que vous utilisez.
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Langages .NET sans logiciel d’application NI
L’aide NI Measurement Studio Help contient une référence des concepts de 
mesure et des fonctions NI-DAQmx. Ce fichier d’aide est intégré dans la 
documentation de Visual Studio .NET. Dans Visual Studio .NET, 
sélectionnez Help»Contents. Pour afficher l’aide NI-DAQmx .NET 
Library, sélectionnez NI Measurement Studio Help»NI Measurement 
Studio .NET Class Library»Reference»National 
Instruments.DAQmx. Pour les tâches et les concepts, sélectionnez 
NI Measurement Studio Class .NET Library»Using the Measurement 
Studio .NET Class Libraries»Using the Measurement Studio 
NI-DAQmx .NET Library. 

Remarque Si vous utilisez un langage .NET sans Visual Studio .NET, il se peut que vous 
ne puissiez pas ouvrir NI Measurement Studio Help.

Documentation des périphériques
NI-DAQ 7.x comprend une documentation en ligne pour les périphériques 
et les accessoires supportés, notamment des fichiers PDF et des fichiers 
d’aide décrivant les terminaux, les spécifications, les fonctionnalités et le 
mode d’opération du périphérique. Pour trouver, afficher et imprimer les 
documents se rapportant à chaque périphérique, insérez le CD Device 
Documentation NI-DAQ. Après avoir installé l’explorateur Device 
Document Browser, les documents du périphérique sont accessibles en 
allant dans Démarrer»Programmes»National Instruments»
NI-DAQ»Browse Device Documentation.

Utilisation de NI-DAQmx et de NI-DAQ traditionnel (ancien driver) sur le 
même ordinateur

Les applications existantes développées avec une version antérieure de 
NI-DAQ s’exécuteront avec NI-DAQ traditionnel (ancien driver). Vous 
pouvez utiliser simultanément les API de NI-DAQ traditionnel (ancien 
driver) et de NI-DAQmx sur le même ordinateur, à condition de respecter 
les restrictions suivantes :

• Une seule API contrôle un périphérique donné à un moment donné.

– Après avoir utilisé un périphérique avec NI-DAQmx, vous devez 
réinitialiser toutes les tâches NI-DAQmx qui l’ont utilisé avant de 
vous en servir avec NI-DAQ traditionnel (ancien driver). Si vous 
utilisez un périphérique dans NI-DAQmx, puis dans NI-DAQ 
traditionnel (ancien driver) sans réinitialiser les tâches 
NI-DAQmx, le code d’erreur -10461 est renvoyé. Pour 
réinitialiser les tâches NI-DAQmx, appelez le VI ou les fonctions 
DAQmx - Réinitialiser une tâche. 
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– Après avoir utilisé un périphérique avec NI-DAQ traditionnel 
(ancien driver), vous devez le réinitialiser avant de vous en servir 
avec NI-DAQmx ; sinon, vous obtiendrez le code d’erreur 
-200324.

Pour les périphériques SCXI, vous devez d’abord réinitialiser le 
périphérique DAQ dans NI-DAQ traditionnel (ancien driver) avant 
de pouvoir l’utiliser dans NI-DAQmx. Par exemple, les 
périphériques DAQ de la série E utilisent les lignes 0, 1, 2 et 4 sur 
le port 0 pour communiquer avec le module SCXI. Le code 
d’erreur -200158 est renvoyé si vous ne réinitialisez pas le 
périphérique de communication dans NI-DAQ traditionnel 
(ancien driver) avant de l’utiliser dans NI-DAQmx, comme 
indiqué ci-après :

• Appelez le VI Réinitialiser un périphérique de NI-DAQ 
traditionnel (ancien driver) ou la fonction Init_DA_Brds.

• Pour réinitialiser des périphériques dans NI-DAQ traditionnel 
(ancien driver) à partir de MAX, vous devez d’abord 
réinitialiser tous les périphériques à la fois. Effectuez un clic 
droit sur le répertoire Périphériques NI-DAQ traditionnel 
(ancien driver) dans MAX et sélectionnez Réinitialiser le 
driver pour NI-DAQ traditionnel (ancien driver). Pour 
une cible RT déportée, vous devez utiliser le VI Réinitialiser 
un périphérique de NI-DAQ traditionnel (ancien driver).

• Dans un système d’acquisition de données SCXI, vous devez utiliser 
la même API pour programmer tous les périphériques : périphériques 
DAQ connectés et modules SCXI insérés.

Reportez-vous à l’adresse ni.com/support pour obtenir des détails et des 
instructions sur les sujets suivants :

• Comment ajouter du code NI-DAQmx dans une application NI-DAQ 
traditionnel (ancien driver)

• Comment exécuter deux applications développées avec NI-DAQmx et 
NI-DAQ traditionnel (ancien driver) et qui utilisent le même 
périphérique.

Dépannage
Utilisez les ressources suivantes si vous vous heurtez à des problèmes lors 
de l’installation de votre matériel et/ou logiciel DAQ :

• Pour consulter des instructions de dépannage, reportez-vous à la 
rubrique Hardware Installation / Configuration Troubleshooter sur 
ni.com/support/install.
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• Reportez-vous à ni.com/kb pour accéder aux documents de 
dépannage se rapportant aux problèmes courants d’installation et de 
programmation, et pour obtenir les réponses aux questions 
fréquemment posées concernant les produits NI.

• Si vous pensez avoir endommagé votre périphérique et que vous jugez 
devoir retourner votre matériel National Instruments pour le faire 
réparer ou étalonner, reportez-vous à ni.com/info et entrez le code 
d’information rdsenn pour savoir comment procéder pour obtenir une 
autorisation de renvoi de marchandise (RMA - Return Merchandise 
Authorization).

Support technique dans le monde entier
Visitez les sections suivantes du site Web de National Instruments sur 
ni.com pour obtenir une assistance technique et des services 
professionnels :

• Support : les ressources de support technique en ligne sur 
ni.com/support comprennent notamment :

– Ressources d’auto-assistance : pour obtenir des réponses et des 
solutions, visitez le site Web réputé de National Instruments pour 
vous procurer des drivers et des mises à jour de logiciels, avoir 
accès à une KnowledgeBase dans laquelle vous pouvez effectuer 
des recherches, aux manuels sur les produits, à des assistants de 
dépannage pas à pas, obtenir des milliers d’exemples de 
programmes, des tutoriaux, des notes d’application, des drivers 
d’instruments et bien plus encore.

– Support technique gratuit : tous les utilisateurs enregistrés 
peuvent bénéficier du Service de base gratuit, qui vous offre la 
possibilité de contacter des centaines d’ingénieurs d’application 
dans le monde entier, dans le cadre de NI Developer Exchange sur 
ni.com/exchange. Les ingénieurs d’application de National 
Instruments veillent à répondre à chacune de vos questions.

Pour obtenir des informations sur d’autres options de support 
technique disponibles dans votre région, visitez ni.com/
services ou contactez notre filiale dans votre ville, grâce aux 
coordonnées qui se trouvent sur ni.com/contact. 

• Formation et certification : visitez ni.com/training pour avoir 
accès à une formation dont vous contrôlez l’allure, à des salles de cours 
d’instruction virtuelle (eLearning), vous procurer des CD interactifs et 
des informations sur le programme de certification. Vous pouvez 
également vous inscrire à des cours de formation dispensés par des 
instructeurs partout dans le monde.
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• Intégrateurs : si vous devez concilier délais serrés, ressources 
techniques limitées et toute autre contrainte, nous vous invitons à faire 
appel aux intégrateurs du Programme National Instruments Alliance 
Partner. Pour en savoir plus, appelez votre filiale locale ou visitez le 
site ni.com/alliance.

• Declaration of Conformity (DoC) : la déclaration de conformité ou 
DoC est notre déclaration de conformité avec le Conseil des 
communautés européennes et s’appuie sur la déclaration de conformité 
du fabricant. Ce système confère à l’utilisateur une protection en 
matière de compatibilité des produits électroniques (EMC). Vous 
pouvez vous procurer la DoC pour votre produit en visitant 
ni.com/certification.

• Certificat d’étalonnage : si votre produit supporte l’étalonnage, vous 
pouvez obtenir un certificat d’étalonnage sur ni.com/calibration.

Le siège social de National Instruments est situé à cette adresse : 11500 
North Mopac Expressway, Austin, Texas, 78759-3504, États-Unis. Visitez 
la section sur les filiales internationales, sur ni.com/niglobal, pour 
accéder à leurs sites Web et obtenir des informations à jour sur leurs 
coordonnées, le numéro de téléphone et adresse e-mail de leur service de 
support technique, ainsi que des informations sur les événements 
d’actualité.

Support dans NI-DAQ 7.4
La version 7.4 de NI-DAQmx supporte la totalité de la gamme de 
périphériques de mesure NI. Les versions futures de NI-DAQ prévoiront le 
support de nouveaux périphériques uniquement dans NI-DAQmx, mais 
aucun support pour les nouveaux périphériques ne sera ajouté à NI-DAQ 
traditionnel (ancien driver).

Support du système d’exploitation
NI-DAQmx et NI-DAQ traditionnel (ancien driver) version 7.4, et 
NI-SWITCH 2.3 supportent Windows 2000/NT/XP. NI-DAQ 7.x sous 
Windows NT exige le Service Pack 6 ou plus récent.

NI-DAQmx 7.4 supporte PharLap uniquement avec le Module LabVIEW 
Real-Time 7.1.

Measurement Studio nécessite Visual Studio .NET 2003, qui lui-même 
nécessite Windows 2000/NT 4.0/XP. 

Si vous utilisez DAQmx .NET Library, .NET 1.1 framework est requis. 
.NET 1.1 exige Windows 2000/XP.
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Pour connaître les instructions d’installation spécifiques à un système 
d’exploitation, consultez la rubrique Hardware Installation / Configuration 
Troubleshooter à l’adresse ni.com/support/install.

Pour trouver et télécharger une version antérieure de NI-DAQ qui supporte 
les autres systèmes d’exploitation, reportez-vous à la page 
ni.com/downloads. 

Support de l’environnement de développement
Le tableau 1 liste les versions des logiciels d’application supportés par 
NI-DAQmx et NI-DAQ traditionnel (ancien driver). Si vous n’utilisez pas 
un logiciel d’application NI, reportez-vous au tableau 2.

 
Tableau 1.  Logiciels d’application supportés par NI-DAQ 7.x

Logiciels d’application NI

Versions 
supportées par 

NI-DAQmx

Versions 
supportées par 

NI-DAQ 
traditionnel 

(ancien driver)

LabVIEW  7.x 6.1–7.x

Module LabVIEW Real-Time 7.1* 6.1–7.x

LabWindows/CVI  7.x 6.0–7.x

Measurement Studio  7.x 6.0–7.x†

* Pour utiliser le Module LabVIEW Real-Time 7.1 avec NI-DAQmx, vous devez utiliser 
NI-DAQmx version 7.2 ou ultérieure.
† NI-DAQ traditionnel (ancien driver) n’inclut pas d’interface Measurement Studio C++ 
ou .NET.
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Support de langage de programmation et de compilateur
 

Les versions plus anciennes de NI-DAQ supportent d’autres versions de ces 
langages et logiciels d’application. Pour trouver et télécharger une version 
plus ancienne, reportez-vous à ni.com/downloads.

Support des périphériques
Le tableau 3 recense les familles de périphériques supportées dans 
NI-DAQ 7.4 par NI-DAQmx et NI-DAQ traditionnel (ancien driver). Pour 
obtenir les noms spécifiques des périphériques, consultez le fichier 
NI-DAQ 7.x Readme du CD. 

Tableau 2.  Langages de programmation supportés par NI-DAQ 7.x

Langage de programmation

Versions 
supportées par 

NI-DAQmx

Versions 
supportées par 

NI-DAQ 
traditionnel 

(ancien driver)

Microsoft Visual C++
Bibliothèques de classes
ANSI C

7.x *

6.0–7.x
—

6.0–7.x

Visual Basic — 6.0†

Microsoft .NET framework 
(C# et Visual Basic .NET)

.NET 1.1 —

Borland — ✓

* Nécessite Measurement Studio version 7.x.
† Support par l’intermédiaire d’ActiveX.

Tableau 3.  Périphériques supportés par NI-DAQ 7.4

Périphérique NI-DAQmx

NI-DAQ 
traditionnel 

(ancien 
driver)

DAQ multifonction

Périphériques PCI, PCI express et PXI de la série M, comme le NI PCI-622X/625X/628X ✓ —

Périphériques PCI et PXI de la série E, comme le NI PCI-6052E ✓ ✓

Périphériques NI DAQCard-6024E, NI DAQCard-6036E et NI DAQCard-6062E de la 
série E au format PCMCIA

✓ ✓

Série E au format AT — ✓

NI PCI-6010 ✓ —

Périphériques de base NI PCI-6013/6014 ✓ ✓

Périphériques pour USB NI DAQPad-6015 (BNC)/6015 (Terminaisons en série)/6016 ✓ —
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DAQ multifonction (Suite)

Périphériques NI DAQPad-6020E/6052E/6070E pour USB et FireWire® (IEEE 1394) — ✓

Périphériques NI PCI-7041/6040E pour LabVIEW RT ✓ ✓

Périphérique NI PXI et PCI-7030 pour LabVIEW RT — ✓

NI PXI et PCI-6122/6123/6132/6133/6143 de la série S ✓ —

Périphériques de la série S, comme le NI PXI-6115/6120 et NI PCI-6110/6111 ✓ ✓

Sorties/waveform analogiques

Waveform NI PXI et PCI-6711/6713 ✓ ✓

NI DAQCard-6715 au format PCMCIA ✓ ✓

NI PXI et PCI-6722/6723 ✓ —

NI PXI et PCI-6731/6733 ✓ ✓

NI PXI-6704 et PCI-6703/6704 ✓ ✓

AT-AO-6/10 — ✓

Entrées analogiques : DAQCard-AI-16E-4 et DAQCard-AI-16XE-50 au format PCMCIA — ✓

Compteur

NI PCI-6601/6602 et NI PXI-6602/6608 ✓ ✓

NI PXI et PCI-6624 isolé ✓ —

E/S numériques

NI 6503, NI PXI-6508, NI 6527 et NI PCI-DIO-96 ✓ ✓

NI 6509/6510/6511/6512/6513/6514/6515/6516/6517/6518/6519 et NI 6528 ✓ —

DAQCard-6533 et AT-DIO-32HS — ✓

Tous les autres NI 653X numériques haute vitesse ✓ ✓

NI DAQCard-DIO-24 pour PCMCIA ✓ ✓

NI DAQPad-6507/6508 pour USB — ✓

PC-DIO-24 et PC-DIO-96 — ✓

AT-DIO-32F — ✓

Acquisition du signal dynamique

NI PXI-4472/4472B et PCI-4472/4474 ✓ ✓

NI PXI-4461/4462 ✓ —

NI PCI-4451/4452/4454 et 4551/4552 — ✓

Tableau 3.  Périphériques supportés par NI-DAQ 7.4 (Suite)

Périphérique NI-DAQmx

NI-DAQ 
traditionnel 

(ancien 
driver)
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Périphériques qui ne sont plus supportés par 
NI-DAQ 7.x
Les produits suivants ne sont pas supportés par NI-DAQ 7.x, ni par 
NI-DAQmx ni par NI-DAQ traditionnel (ancien driver), et ne le seront pas 
non plus par les versions futures de NI-DAQ. Vous devez utiliser la version 
6.9.x de NI-DAQ ou une version antérieure pour programmer ces 
périphériques :

Conditionnement du signal

Modules SCXI-1521/B et SCXI-1600 ✓ —

Tous les autres modules de conditionnement de signal SCXI ✓ ✓

Conditionnement de signal intégré NI PXI-4200/4204/4220/4225 ✓ —

Modules de la série SCC ✓ ✓

Périphériques TEDS : BNC-2096, boîtier SC-2350 et SCXI-1314T
Remarque : Ces périphériques supportent la lecture et l’écriture dans les capteurs TEDS.

✓ —

Commutation (Switch)

Modules NI SCXI-1160, SCXI-1161 et SCXI-1163R ✓ ✓

Tous les autres modules de commutation SCXI ✓ —

Modules de commutation PXI ✓ —

NI AT-MIO-16F-5
NI DAQCard-500
NI DAQCard-516
NI DAQCard-700
NI DAQCard-1200
NI DAQCard-AO-2DC
NI DAQPad-1200
NI DAQPad-MIO-16XE-50
NI Lab-PC et Lab-PC+
NI Lab-PC-1200/AI
NI PC-516
NI PC-AO-2DC

NI PC-LPM-16/PNP
NI PC-OPDIO-16
NI PC-TIO-10
NI PCI-1200
NI SCXI-1200
NI SCXI-2000
NI SCXI-2400
Modules NI VXI DAQ
Boîtiers et modules NI VXI-SC
Blocs de connexion NI VXI-TB pour 
bus VXI

Tableau 3.  Périphériques supportés par NI-DAQ 7.4 (Suite)

Périphérique NI-DAQmx

NI-DAQ 
traditionnel 

(ancien 
driver)
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DAQ-Schnellstartanleitung
In der vorliegenden Broschüre erhalten Sie eine Anleitung zur Installation 
Ihrer Datenerfassungsgeräte und der Treibersoftware NI-DAQ 7.x und 
erfahren, wie die Geräte auf Funktionstüchtigkeit überprüft werden.

Die Installation von SCXI-Schaltmodulen wird im NI Switches Getting 
Started Guide erläutert.
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Symbole und Darstellungen
In dieser Anleitung werden folgende Symbole und Darstellungen 
verwendet:

<> Mit eckigen Klammern sind Funktionstasten gekennzeichnet.

» Das Symbol » gibt die Reihenfolge an, in der Menübefehle und 
Dialogoptionen anzuklicken sind. So wird zum Beispiel mit der Abfolge 
Datei»Seiteneinstellungen»Optionen angezeigt, dass zunächst das Menü 
Datei zu öffnen ist, hieraus die Option Seiteneinstellungen und 
anschließend der Befehl Optionen zu wählen ist.

Dieses Symbol kennzeichnet einen Hinweis und macht auf wichtige 
Informationen aufmerksam.

Mit diesem Symbol soll vor Datenverlust, Systemabsturz oder 
Verletzungen gewarnt werden. Welche Vorsichtsmaßnahmen bei Produkten 
zu treffen sind, die mit diesem Symbol gekennzeichnet sind, wird im 
Faltblatt Read Me First: Safety and Radio-Frequency Interference in der 
Packungsbeilage erläutert.

Wenn ein Produkt mit diesem Symbol gekennzeichnet ist, besteht die 
Gefahr eines elektrischen Schlags.

Bei Produkten mit diesem Zeichen kann eines der Bauteile heiß werden. 
Bei Berührung besteht die Gefahr von Verletzungen.

fett In fettgedruckter Schrift sind Elemente dargestellt, die ausgewählt oder 
angeklickt werden müssen, wie Menüpunkte oder Optionen in 
Dialogfeldern. 
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kursiv Kursiv sind Querverweise gedruckt, erstmals erwähnte wichtige Termini 
und Textstellen, die als Platzhalter fungieren.

monospace In Schreibmaschinenschrift sind Textstellen oder Zeichen dargestellt, die 
über die Tastatur einzugeben sind, wie Laufwerksbuchstaben, Fehlercodes, 
Pfade, Verzeichnisse, Programme, Funktionen, Dateinamen oder 
Erweiterungen.

monospace kursiv An Textstellen, die im kursiver Schreibmaschinenschrift dargestellt sind, 
sind Eingaben per Tastatur erforderlich.

NI-DAQ 7.x
Alle messtechnischen Geräte von National Instruments werden mit dem 
NI-DAQ-Treiber ausgeliefert, der zur Steuerung der Geräte dient und zu 
dem es eine Vielzahl von Funktionen und VIs für Anwendungen wie 
LabVIEW oder LabWindows™/CVI™ gibt. Zu den messtechnischen Gerä-
ten werden neben Datenerfassungsgeräten (DAQ-Geräten) wie 
Multifunktions-I/O-Karten (MIO-Karten der M-Serie) auch Signalaufbe-
reitungs- und Schaltmodule gerechnet. Der Treiber ist mit einer eigenen 
API in Form einer Bibliothek von VIs, Funktionen, Klassen, Attributen und 
Eigenschaften ausgestattet, mit der Sie Anwendungen für Ihre Geräte 
erstellen können.

NI-DAQ 7.x umfasst zwei eigenständige NI-DAQ-Treiber mit jeweils 
eigener Funktionen- und VI-Bibliothek sowie Hardware- und 
Softwarekonfiguration. 

• NI-DAQmx ist der neueste NI-DAQ-Treiber. Er weist gegenüber dem 
alten, traditionellen NI-DAQ-Treiber folgende Vorteile auf:

– Zu NI-DAQmx gehört ein so genannter DAQ-Assistent, in dem 
Sie virtuelle Kanäle und Tasks für Messungen mit einem 
bestimmten Gerät konfigurieren und diese Einstellungen in Pro-
grammcode für LabVIEW, LabWindows/CVI und 
Measurement Studio umwandeln lassen können.

– Leistungsfähigere Funktionen, zum Beispiel schnellere Ein- und 
Ausgabe einzelner Werte oder Multithreading.

– Möglichkeit der Simulation von Geräten, so dass Sie Anwendun-
gen auch ohne die benötigten Geräte testen können. 

– Einfachere, intuitiver gestaltete Programmieroberfläche, die mit 
weniger VIs und Funktionen als frühere NI-DAQ-Versionen 
auskommt.

– Größere Vielfalt von LabVIEW-Funktionen, beispielsweise durch 
Eigenschaftsknoten oder Funktionen zur Verarbeitung von 
Signalverläufen.
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– Ähnliche Programmieroberfläche und Funktionen für ANSI C, 
LabWindows/CVI und Measurement Studio, einschließlich 
systemeigener .NET- und C++-Schnittstellen.

– Verbesserte Unterstützung für das LabVIEW Real-Time Module 
und höhere Leistung in LabVIEW Real-Time.

• Der alte, traditionelle NI-DAQ-Treiber ist eine Weiterentwicklung des 
früheren NI-DAQ-Treibers. Er unterscheidet sich nur insofern von 
NI-DAQ 6.9.3, dass er zusammen mit NI-DAQmx auf demselben 
Computer verwendet werden kann, und dass einige ältere Geräte nicht 
mehr unterstützt werden. 

Anwendungsbereiche von NI-DAQmx
Der NI-DAQmx-Treiber sollte in folgenden Fällen verwendet werden:

• Wenn Sie zum ersten Mal mit NI-DAQ arbeiten.

• Wenn Sie mit Geräten arbeiten, die von NI-DAQmx unterstützt werden 
(siehe dazu auch Abschnitt Unterstützung in NI-DAQ 7.4 am Ende 
dieses Leitfadens).

• Unter Windows 2000/NT/XP.

Wenn Sie NI-DAQmx mit einer Entwicklungsumgebung von National 
Instruments verwenden möchten (LabVIEW, LabWindows/CVI oder Mea-
surement Studio), benötigen Sie mindestens die Version 7.x dieser 
Software bzw. VI Logger 2.x oder eine Version des LabVIEW Real-Time 
Module ab 7.1.

Für Microsoft-.NET-Sprachen, Visual C# und/oder Visual Basic .NET 
muss NI-DAQmx verwendet werden.

NI-DAQmx arbeitet auch mit bestimmten Compilern zusammen, beispiels-
weise ANSI-C-Compilern.

Anwendungsbereiche des (alten) traditionellen NI-DAQ-Treibers
Prinzipiell sollte NI-DAQmx Ihre erste Wahl sein, insbesondere wenn Sie 
zum ersten Mal mit NI-DAQ arbeiten. Der (alte) traditionelle 
NI-DAQ-Treiber wird unter folgenden Umständen benötigt:

• Bei Geräten, für die NI-DAQmx nicht geeignet ist (zum Beispiel bei 
Multifunktions-DAQ-Geräten der AT-E-Serie).

• Bei Nutzung einer LabVIEW-, LabWindows/CVI- oder 
Measurement-Studio-Version vor 7.0.

• Beim LabVIEW Real-Time Module für Mac OS.

• Wenn Sie bisher mit NI-DAQ 6.9.x gearbeitet haben, Ihre Anwendun-
gen jedoch noch nicht auf NI-DAQmx umstellen möchten. 
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Hinweis Entwicklungsumgebungen von National Instruments werden seit der Version 6.0 
des traditionellen NI-DAQ-Treibers unterstützt. Für LabVIEW, LabWindows/CVI und 
Measurement Studio 6.x kann daher auch der traditionelle NI-DAQ-Treiber verwendet 
werden.

Systemintegration von NI-DAQ
In Abbildung 1 wird dargestellt, in welchen Schritten in einem messtechni-
schen System eine physikalische Größe der Software zur Verarbeitung 
zugeführt wird.

Zunächst wird eine physikalische Größe mit Hilfe von Sensoren oder 
Messwandlern erfasst. Anschließend wird das gemessene Signal von Bau-
gruppen zur Signalaufbereitung so verstärkt, dass es von der Messkarte im 
PC aufgenommen werden kann, die die Messwerte für den Computer 
bereitstellt. Der gesamte Messaufbau ist softwaregesteuert, das heißt, ein 
bestimmtes Programm gibt der Messkarte Anweisungen, wann und auf 
welchen physikalischen Kanälen Messwerte aufgenommen oder ausgege-
ben werden sollen. Anschließend werden die aufgenommenen Werte in der 
Software ausgewertet und zum besseren Verständnis grafisch dargestellt 
(zum Beispiel in einem Diagramm) oder in schriftlicher Form festgehalten. 
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Abbildung 1.  Aufbau eines Messsystems

Der NI-DAQ-Treiber, der allen von National Instruments vertriebenen 
Hard- und Softwareprodukten zur Messtechnik beiliegt, ermöglicht eine 
individuelle Konfiguration der Geräte und ihrer Funktionen, wie der Daten-
erfassung, der Signalerzeugung oder des Datenaustauschs zwischen Gerät 
und Computer. Die Verwendung von NI-DAQ erspart Ihnen somit eine 
eigenständige Programmierung auf Registerebene. Von Entwicklungsum-
gebungen wie LabVIEW, LabWindows/CVI, Measurement Studio oder 
VI Logger aus werden wiederum Befehle an den Treiber übermittelt, damit 
dieser zum Beispiel Messwerte abfragt, analysiert oder anzeigt.

Der NI-DAQ-Treiber ist zu allen NI-Entwicklungsumgebungen kompati-
bel und arbeitet mit allen Programmiersprachen, in denen DLLs über 
ANSI-C-Schnittstellen aufgerufen werden können. Die Zusammenarbeit 
zwischen Ihrer DAQ-Anwendung und dem NI-DAQ-Treiber erfolgt 
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jedoch unabhängig von der Programmierumgebung wie in Abbildung 1 
dargestellt.

Schritt 1: Installation der Entwicklungsumgebung
Installieren Sie Ihre Entwicklungsumgebung von National Instruments. 
Für NI-DAQmx wird entweder LabVIEW 7.x, LabWindows/CVI 7.x, 
Measurement Studio 7.x, VI Logger 2.x oder das LabVIEW Real-Time 
Module ab Version 7.1 benötigt.

Von Anwendungen, die mit einer früheren Version einer Entwicklungsum-
gebung von National Instruments oder des NI-DAQ-Treibers erstellt 
wurden, sollte eine Sicherheitskopie angelegt werden, so dass die Software 
und die damit erstellten Anwendungen risikolos modifiziert werden 
können.

Schritt 2: Installation von NI-DAQ 7.x

Einlegen der CD

Vorsicht! Installieren Sie NI-DAQ 7.x nur, wenn alle Komponenten Ihrer Anwendungen 
von diesem Treiber unterstützt werden. Lesen Sie bitte vor Installation der Software den 
Abschnitt Unterstützung in NI-DAQ 7.4 am Ende dieser Anleitung.

Der NI-DAQ-7.x-Installationsassistent sollte sich automatisch öffnen. 
Falls nicht, wählen Sie Start»Ausführen und geben Sie x:\setup.exe 
ein (x steht dabei für den Buchstaben des CD-Laufwerks). Bei Problemen 
besuchen Sie bitte unsere Website ni.com/support/install und 
gehen Sie nach den Anweisungen im Hardware Installation/Configuration 
Troubleshooter vor.
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Installieren Sie den Treiber vor Anschluss der neuen Geräte, da die Geräte 
so automatisch erkannt werden.

Auswahl der zu installierenden APIs

Vorsicht! Es kann immer nur jeweils eine Version von NI-DAQ 7.x auf dem System 
installiert sein. Bei der Installation von NI-DAQ 7.x wird die vorherige Version des tradi-
tionellen NI-DAQ-Treibers einschließlich aller dazugehörigen Hilfsdateien überschrieben. 
Wenn Sie nur NI-DAQmx installieren, werden alle Versionen vor NI-DAQ 6.9.x gelöscht.

NI-DAQ 7.x umfasst NI-DAQmx, NI-SWITCH und den alten, traditionel-
len NI-DAQ-Treiber sowie die dazugehörigen APIs,  die je nach Art der 
verwendeten Geräte einzeln oder gemeinsam installiert werden können. 
Welche Treiber für Ihre Geräte erforderlich sind, erfahren Sie im Abschnitt 
Unterstützung in NI-DAQ 7.4 am Ende dieser Anleitung.

Für Schaltmodule von National Instruments eignet sich sowohl 
NI-SWITCH als auch NI-DAQmx. 

Installation der Hilfsdateien
Das Installationsprogramm von NI-DAQ 7.x erkennt alle installierten Ent-
wicklungsumgebungen von National Instruments und wählt automatisch 
die neueste Version der Software sowie des Treibers und der Hilfsdateien 
für die unterstützten Programmiersprachen aus.

 

1. Überprüfen Sie, ob die verwendete Programmiersprache oder Ent-
wicklungsumgebung einschließlich der dazugehörigen Hilfsdateien 
richtig erkannt wurde.
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NI-DAQ-7.x muss immer nach der NI-Entwicklungsumgebung instal-
liert werden. Wenn Sie NI-DAQ als erstes installiert haben, starten Sie 
das Installationsprogramm für den Treiber noch einmal.

2. Klicken Sie auf Weiter, bis Sie beim letzten Dialogfeld des Installa-
tionsprogramms angelangt sind.

3. Klicken Sie auf Beenden.

4. Am Ende des Installationsvorgangs werden Sie gefragt, ob Sie den 
Computer neu starten, ihn herunterfahren oder das Dialogfeld abbre-
chen möchten.

• Neustart—Wenn Sie das LabVIEW Real-Time Module verwen-
den, starten Sie den Rechner neu. Laden Sie mit Hilfe des 
Measurement & Automation Explorers (MAX) NI-DAQ 7.x auf 
das Netzwerksystem herunter. Hilfestellung erhalten Sie dazu in 
der Measurement & Automation Explorer-Hilfe zu Systemen im 
Netzwerk, die sich unter Hilfe»Hilfethemen»Netzwerkumge-
bung befindet.

• Beenden—Um weitere Software von National Instruments zu 
installieren, verlassen Sie das Programm und starten Sie das 
jeweilige Installationsprogramm. Wenn Ihr PC über eine 
MXI-3-Schnittstelle mit einem PXI-Chassis verbunden ist, verlas-
sen Sie das Programm und installieren Sie die MXI-3-Software, 
die bei Bedarf von der Website ni.com/downloads herunterge-
laden werden kann.

• Herunterfahren—Wenn alles zum Anschließen des Geräts bereit 
ist, wählen Sie Herunterfahren.

Schritt 3: Auspacken der Geräte, Zusatzbauteile und 
Kabel

Ihr Modul wurde in einer antistatischen Verpackung ausgeliefert, um Schä-
den durch elektrostatische Entladung zu vermeiden.

Vorsicht! Freiliegende Kontakte niemals mit den Fingern berühren!

Ergreifen Sie beim Auspacken folgende Vorsichtsmaßnahmen:

• Legen Sie sich ein Erdungskabel an oder berühren Sie ein mit Masse 
verbundenes Objekt.

• Bringen Sie die Verpackung der Karte vor dem Auspacken mit einem 
blanken Metallteil des Computergehäuses in Kontakt.

Packen Sie die Karte aus und überprüfen Sie, ob sich eventuell Teile davon 
gelöst haben, oder ob sie anderweitig beschädigt ist. Sollte die Karte schad-
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haft erscheinen, setzen Sie sich bitte mit uns in Verbindung. Bauen Sie auf 
keinen Fall eine schadhafte Karte ein!

Wenn Sie die Karte nicht nutzen, bewahren Sie sie in der antistatischen Ori-
ginalverpackung auf.

Sicherheitshinweise und Informationen zur Einhaltung von Sicherheits-
standards finden Sie in den unter Schritt 9: Installation der 
Gerätedokumentation beschriebenen Begleitmaterialien.

Schritt 4: Anschließen der einzelnen Komponenten
Bauen Sie alle vorhandenen DAQ-Karten ein. Wenn Sie Ihre DAQ-Karte 
an ein SCXI-Modul anschließen möchten, installieren Sie zunächst die 
DAQ-Karte. Der Einbau von SCXI-Modulen folgt später im Schritt 10: 
Installation von Signalkonditionierungs- und Schaltmodulen.

Geräte lassen sich auch simulieren, so dass NI-DAQmx-Anwendungen 
auch ohne ein angeschlossenes Gerät getestet werden können. Mehr zur 
Simulation von Geräten und zum Übertragen der Konfiguration simulierter 
auf echte Geräte mit NI-DAQmx erfahren Sie in Schritt 6: Starten des MAX 
und in der Hilfe zum Measurement & Automation Explorer für NI-DAQmx, 
die im MAX über Hilfe»Hilfethemen»NI-DAQmx geöffnet wird. 

Vorsicht! Vor der Installation der Hardware ist unbedingt eine Erdung gemäß VDE erfor-
derlich. Alle weiteren wichtigen Informationen zu Sicherheitsbestimmungen und den 
Sicherheitsstandards, die Ihre Karte erfüllt, finden Sie auf dem mitgelieferten Datenblatt.

PCI-Karten
Gehen Sie zum Einbau einer PCI-Karte folgendermaßen vor:

1. Schalten Sie den Computer aus und ziehen Sie den Netzstecker.

2. Entfernen Sie das Computergehäuse und die Abdeckung für den 
Erweiterungssteckplatz.

3. Berühren Sie ein beliebiges Metallteil des Computers.

4. Führen Sie die Karte in den PCI-Steckplatz ein und drücken Sie sie 
vollständig hinein. Wenden Sie dabei keine Gewalt an!
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Abbildung 2.  Einbau einer PCI-Karte

5. Schrauben Sie die Metallschiene der Karte an der Rückwand des Com-
puters fest.

6. Befestigen Sie das Computergehäuse.

PXI-Module
PXI-Module werden folgendermaßen eingebaut:

1. Schalten Sie das PXI-Gehäuse aus und ziehen Sie den Netzstecker.

Vorsicht! Lesen Sie bitte vor dem Entfernen von Abdeckungen oder Kabeln das Faltblatt 
Read Me First: Safety and Radio-Frequency Interference in der Packungsbeilage des 
PXI-Gehäuses oder -Moduls.

2. Entfernen Sie die Blende eines freien PXI-Steckplatzes. Manche 
Karten können nur in einen bestimmten Steckplatz montiert werden. 
Lesen Sie dazu bitte in der Dokumentation nach, die nach der 
Beschreibung in Schritt 9: Installation der Gerätedokumentation 
geöffnet wird.

3. Berühren Sie zur elektrostatischen Entladung ein beliebiges Metallteil 
des Gehäuses.

4. Vergewissern Sie sich, dass der Arretierhebel des PXI-Moduls nicht 
eingerastet ist.

5. Schieben Sie das Modul in das Gehäuse ein.

1 PCI-DAQ-Karte
2 PCI-Steckplatz

3 PC mit PCI-Steckplatz
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6. Drücken Sie das Modul so weit in das Gehäuse, bis es die Steckerleiste 
berührt.

7. Wenn Sie einen Widerstand fühlen, ziehen Sie den Arretierhebel hoch 
und drücken Sie die Karte vollständig in den Steckplatz.

8. Schrauben Sie die Frontplatte am Gehäuse fest. 
 

Abbildung 3.  Einbau eines PXI-Moduls

PCMCIA-Karten
PCMCIA-Karten von National Instruments passen in alle PC-Kartensteck-
plätze des Typs II. Gehen Sie zum Einstecken einer PCMCIA-Karte 
folgendermaßen vor:

1. Entfernen Sie die Abdeckung des PCMCIA-Steckplatzes (sofern 
vorhanden).

2. Führen Sie den Busanschluss des Gerätes in den Steckplatz ein, bis 
dieser fest sitzt.

3. Schließen Sie das Kabel an. Gehen Sie dabei vorsichtig vor. Beim Ein-
stecken und Herausziehen sollte immer der Stecker angefasst werden. 
Ziehen Sie auf keinen Fall direkt am Kabel!

1 PXI-Gehäuse
2 PXI-Controller
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Abbildung 4.  Einbau einer PCMCIA-Karte

Geräte mit USB/IEEE-1394-Schnittstelle
NI-Geräte mit USB- oder IEEE-1394-Schnittstelle werden wie folgt 
angeschlossen:

1. Schließen Sie die Kabel für die Stromversorgung an.

• Wenn Sie mit einem BP-1-Akkupack arbeiten, schließen Sie 
dieses der Beschreibung nach an.

• Einige National-Instruments-Geräte mit USB- oder 
IEE-1394-Anschluss benötigen eine externe Stromzufuhr.

– Überprüfen Sie bei Geräten mit einem Netzteil zunächst, ob 
die Netzspannung (120 oder 230 V~) und die für das Gerät 
benötigte Spannung mit den Angaben auf dem Netzteil über-
einstimmen. Schließen Sie dann das Netzteil an.

– Wenn ein Netzkabel vorhanden ist, schließen Sie das Gerät 
damit an die Steckdose an.

2. Verbinden Sie das Gerät über ein USB-Kabel entweder mit dem USB- 
bzw. IEEE-1394-Anschluss des Rechners, einem Hub oder einem 
anderen Gerät. 

3. Betätigen Sie nun den Netzschalter (sofern vorhanden). Das Gerät 
sollte automatisch vom Computer erkannt werden.

1 Computer mit PCMCIA-Steckplatz
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Zubehör
Der Anschluss von Zubehörteilen und Anschlussblöcken wird in der dazu-
gehörigen Anleitung beschrieben. Für SCXI- und SCC-Systeme folgen Sie 
bitte den Anweisungen bis Schritt 10: Installation von Signalkonditionie-
rungs- und Schaltmodulen.

Schritt 5: Einschalten des Computers bzw. PXI-Chassis
Nach einem Neustart des Computers wird neu angeschlossene Hardware in 
Windows automatisch erkannt. In manchen Windows-Versionen öffnet 
sich in diesem Fall das Dialogfeld “Neue Hardware gefunden”. Die Vor-
einstellung lautet: Software automatisch installieren (empfohlen). 
Klicken Sie auf Weiter bzw. Ja, um einen Treiber zu installieren, so dass 
das jeweilige Gerät beim nächsten Start erkannt wird.

Wenn ein Gerät mit USB- oder IEEE-1394-Anschluss erkannt wurde, wird 
dies durch eine aufleuchtende oder blinkende LED am Gerät signalisiert. 
Bei NI-Geräten mit IEEE-1394-Schnittstelle gibt es eine COM-LED, die 
zu blinken beginnt, wenn das Gerät gefunden wurde. Beschreibungen zu 
den einzelnen LED-Signalen finden Sie in den Unterlagen zu Ihrem Gerät. 

Schritt 6: Starten des MAX
Klicken Sie das Symbol Measurement & Automation auf dem Desktop 
doppelt an, um den MAX zu öffnen.

Schritt 7: Überprüfung der automatischen Erkennung 
von Geräten

Gehen Sie dazu folgendermaßen vor:

1. Erweitern Sie in der Baumstruktur die Kategorie Geräte und Schnitt-
stellen. Bei Systemen im Netzwerk, die mit LabVIEW Real-Time 
arbeiten, klicken Sie zunächst die Kategorie Netzwerkumgebung, 
dann das System und anschließend die Kategorie Geräte und Schnitt-
stellen doppelt an.

2. Überprüfen Sie, ob das Gerät unter “Geräte und Schnittstellen” ange-
zeigt wird. 
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Sollte eine Komponente nicht automatisch angezeigt werden, muss die 
Anzeige unter Umständen mit der <F5>-Taste aktualisiert werden. 
Wenn das Gerät dann immer noch nicht erscheint, liegt ein Fehler vor. 
In diesem Fall ist Ihnen möglicherweise die Website ni.com/
support/install eine Hilfe.

3. Klicken Sie das zu testende Gerät mit der rechten Maustaste an. 

• Wenn sich das Gerät unter NI-DAQmx befindet, wählen Sie 
Selbsttest.

 

Hilfe bei Schwierigkeiten während des Selbsttests des Geräts 
finden Sie in der Hilfe zum Measurement & Automation Explorer 
für NI-DAQmx, die sich unter Hilfe»Hilfethemen»NI-DAQmx 
befindet. 

1 Falls ein Gerät sowohl mit NI-DAQmx als auch dem alten traditionellen 
NI-DAQ-Treiber arbeitet, und beide Treiber installiert sind, wird das Gerät unter 
Mein System»Geräte und Schnittstellen mit unterschiedlichen Namen in 
beiden Kategorien aufgeführt. 

2 Beachten Sie bitte, dass unter Netzwerkumgebung»Geräte und 
Schnittstellen nur die NI-DAQmx-Geräte angezeigt werden. 

1

2
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• Wenn das Gerät unter dem traditionellen NI-DAQ-Treiber aufge-
führt ist, wählen Sie Eigenschaften und klicken dann auf die 
Schaltfläche Ressourcen testen.

4. Nach Abschluss des Selbsttests erscheint eine Meldung darüber, ob ein 
Fehler festgestellt wurde. Für Unterstützung bei der Fehlerdiagnose 
besuchen Sie bitte unsere Website ni.com/support/install.

Schritt 8: Konfiguration der Geräteeinstellungen
Konfigurieren Sie alle angeschlossenen Geräte wie nachfolgend 
beschrieben:

1. Klicken Sie mit der rechten Maustaste auf den Namen des Geräts und 
wählen Sie Eigenschaften. Vergewissern Sie sich, dass Sie das Gerät 
unter der korrekten NI-DAQ-API ausgewählt haben. Wenn Ihr Rech-
ner mit einem System im Netzwerk verbunden ist, auf dem LabVIEW 
Real-Time läuft, werden alle daran angeschlossenen NI-DAQmx-
Geräte unter Netzwerkumgebung»Geräte und Schnittstellen 
angezeigt.

2. Nehmen Sie die gewünschten Einstellungen vor. Wenn eine Kompo-
nente sowohl mit NI-DAQmx als auch mit dem alten, traditionellen 
NI-DAQ-Treiber arbeiten soll, müssen beide Treiber konfiguriert 
werden.

• Zusätzliche Bauteile können unter Zubehör angegeben werden.

• Wenn Sie mit einem Gerät arbeiten, für das es nur den alten, tra-
ditionellen DAQ-Treiber gibt, finden Sie im MAX unter Hilfe in 
der Hilfe zum Measurement & Automation Explorer für den tradi-
tionellen NI-DAQ-Treiber ausführliche Informationen.

• Dem Standard IEEE 1451.4 entsprechende Sensoren, deren 
Grunddaten in einem speziellen integrierten Speicher enthalten 
sind (Transducer Electronic Data Sheet, elektronisches Datenblatt 
zum Sensor) – sogenannten TEDS-Sensoren – sind zunächst zu 
konfigurieren, bevor entsprechende Zubehörteile hinzugefügt 
werden können. Wählen Sie Nach TEDS suchen. Zur Konfigura-
tion von TEDS-Sensoren, die direkt an ein Gerät angeschlossen 
sind, klicken Sie das entsprechende Gerät im MAX unter “Geräte 
und Schnittstellen” mit der rechten Maustaste an und wählen Sie 
TEDS konfigurieren.

3. Klicken Sie zum Speichern der Änderungen auf OK.

Um die virtuellen Kanäle, Skalierungen und Einstellungen des alten tradi-
tionellen NI-DAQ-Treibers mit NI-DAQmx zu nutzen, klicken Sie auf 
Werkzeuge»NI-DAQmx-Konfiguration»Konfiguration des trad. 
NI-DAQ (alt) nach NI-DAQmx konvertieren. Eine Ausnahme bilden 
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SCC-Konfigurationen; diese lassen sich nur einzeln umwandeln. Klicken 
Sie für weitere Hinweise im Assistenten auf die Hilfe-Schaltfläche.

Schritt 9: Installation der Gerätedokumentation
Im Softwarepaket von NI-DAQ 7.x gibt es PDF- und Hilfedateien, in denen 
die Anschlüsse, Leistungsmerkmale und die Betriebsweise der Geräte 
erläutert werden, für die der Treiber geeignet ist, und in denen Grunddaten 
zu den Geräten enthalten sind. Alle Dokumente lassen sich öffnen und aus-
drucken. Legen Sie dazu die CD mit dem Titel “Device Documentation” 
ein. Für einige Funktionen der NI-DAQ-7.x-Dokumentation wie die Hilfe 
oder den Device Document Browser nutzen zu können, muss eine Inter-
net-Explorer-Version ab 5.0 installiert sein. Klicken Sie zum Öffnen des 
Device Document Browser auf Start»Programme»National 
Instruments»NI-DAQ»Browse Device Documentation. 

Wenn Sie die CD nicht haben, finden Sie die Beschreibungen und Hilfen 
auch unter ni.com/manuals. Der Device Document Browser kann unter 
ni.com/support heruntergeladen werden. Klicken Sie dazu auf Drivers 
and Updates»Most Popular und wählen Sie die verwendete NI-DAQ-
Version aus. Laden Sie sich dann die CD 2 herunter und folgen Sie der 
Installationsanleitung.

Schritt 10: Installation von Signalkonditionierungs- und 
Schaltmodulen

Der Einbau und die Konfiguration von Signalkonditionierungs- oder 
Schaltmodulen wird in den folgenden Dokumenten beschrieben:

• Signalkonditionierungskomponenten (SCC), wie SC-Modulträger und 
SCC-Module: Der Quick Start Guide zum verwendeten Produkt.

• Schaltmodule: NI Switches Getting Started Guide.

Die nachfolgenden Anweisungen gelten nur für DAQ-Karten und 
PXI-Module mit integrierter Signalaufbereitung.
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Schritt 11: Anschließen der Sensoren und 
Signalleitungen

Schließen Sie die Sensoren bzw. Signalquellen an den Anschlussblock oder 
andere Zubehörteile an. Nachfolgend wird beschrieben, wie Sie zu den ein-
zelnen Komponenten hilfreiche Informationen finden:

• Anschlüsse für Signalleitungen und Pinbelegungen:

– Im DAQ-Assistenten ist zu den NI-DAQmx-Tasks und virtuellen 
Kanälen auf Ihrem System ein Anschlussplan enthalten, der auch 
ausgedruckt werden kann. Wählen Sie dazu den Task oder virtu-
ellen Kanal aus und klicken auf die Registerkarte Anschlussplan. 
Um zu sehen, wie der Sensor im Einzelnen mit dem 
Anschlussblock zu verbinden ist, klicken Sie die virtuellen Kanäle 
im Task an. 

– Im Device Document Browser können Sie sich die M Series Help, 
die E Series Help, Bedienungsanleitungen zu Geräten und zusätz-
liche Anleitungen anzeigen lassen.

– Pinbelegungen finden Sie auch unter Device Terminals in der 
Hilfe zum Measurement & Automation Explorer für NI-DAQmx 
und der Hilfe zum Measurement & Automation Explorer für den 
traditionellen NI-DAQ-Treiber, die über das MAX-Hilfemenü 
geöffnet werden.

• Sensoren:

– Auf der Website ni.com/sensors.

– Im LabVIEW Measurements Manual in der Packungsbeilage von 
LabVIEW bzw. auf ni.com/manuals. 

– Zu NI-DAQmx im Kapitel Sensors der NI-DAQmx Help 
(Start»Programme»National Instruments»NI-DAQ»
NI-DAQmx Help). 

– Auf unserer Website ni.com/zone zu TEDS-Sensoren (intelli-
genten Sensoren, die dem Standard IEEE 1451.4 entsprechen). 

• Schaltmodule: In den Beschreibungen der Schaltmodule finden Sie 
auch Angaben zur Gerätearchitektur.

Schritt 12: Starten der Test-Panels
Bei vielen Geräten sind Testläufe zur Überprüfung bestimmter Funktionen 
möglich, wie beispielsweise der Ein- und Ausgabe von Signalen. Ein Test-
panel wird folgendermaßen gestartet: 

1. Erweitern Sie im MAX die Kategorie Geräte und Schnittstellen»
NI-DAQmx - Geräte oder Geräte und Schnittstellen»Traditionelle 
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NI-DAQ - Geräte. Bei RT-Systemen im Netzwerk klicken Sie 
zunächst die Kategorie Netzwerkumgebung, dann das System und 
anschließend die Kategorie Geräte und Schnittstellen doppelt an.

2. Klicken Sie mit der rechten Maustaste auf den Namen der Kompo-
nente. Vergewissern Sie sich, dass Sie das Gerät unter der korrekten 
NI-DAQ-API ausgewählt haben.

3. Wählen Sie anschließend die Option Testpanels aus. Beim traditionel-
len NI-DAQ-Treiber gibt es für das LabVIEW Real-Time Module 
keine Testpanels.

In der nachstehenden Abbildung sehen Sie ein Beispiel für ein 
Testpanel.

4. Klicken Sie zur Überprüfung der einzelnen Funktionen des Geräts auf 
die verschiedenen Registerkarten. Hilfestellung bei der Handhabung 
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der Test-Panels in NI-DAQmx erhalten Sie im Menü unter Hilfe. Der 
Umgang mit den Testpanels des alten, traditionellen NI-DAQ-Treibers 
ist in der Hilfe zum Measurement & Automation Explorer für den tra-
ditionellen NI-DAQ-Treiber beschrieben.

5. Wenn ein Fehler vorliegt, wird im Testpanel eine entsprechende Mel-
dung ausgegeben. Für Hilfe in diesem Fall stehen Ihnen die 
NI-DAQmx Help und die Website ni.com/support zur Verfügung. 

6. Klicken Sie zum Verlassen des Testpanels auf Schließen.

Schritt 13: Konfiguration aller neu angeschlossenen 
Geräte

Wenn Sie in Ihren Rechner mehrere DAQ-Karten eingebaut haben, müssen 
Sie Schritt 8: Konfiguration der Geräteeinstellungen bis Schritt 12: Starten 
der Test-Panels für jede Karte wiederholen. 

Schritt 14: Konfiguration der Kanäle und Tasks
Dieser Schritt ist nur dann erforderlich, wenn Sie Ihre Karte mit NI-DAQ 
oder einer Entwicklungsumgebung von National Instruments program-
mieren. 

Ein physikalischer Kanal ist ein Anschluss oder Steckkontakt, an dem ein 
analoges oder digitales Signal gemessen werden kann oder erzeugt wird. 
Ein virtueller Kanal ist die Gesamtheit der Einstellungen zu einem physi-
kalischen Kanal, und zwar Bezeichnung, verwendete Anschlüsse, Art der 
Messung/Signalerzeugung, Art und Weise der Messwertskalierung. Bei 
NI-DAQmx sind virtuelle Kanäle Bestandteil einer jeden Messung. Mit 
dem DAQ-Assistenten von NI-DAQmx, der im MAX oder in einer Ent-
wicklungsumgebung von National Instruments gestartet wird, können Sie 
virtuelle Kanäle und Mess-Tasks konfigurieren. Weitere Informationen 
erhalten Sie in der Hilfe zum DAQ-Assistenten und in der Hilfe zum Mea-
surement & Automation Explorer für NI-DAQmx. Ein Konfigurieren 
virtueller Kanäle ist aber auch mit der NI-DAQmx-API Ihrer NI-Entwick-
lungsumgebung möglich. Beim traditionellen NI-DAQ-Treiber und in 
früheren Versionen von NI-DAQ wird durch die Konfiguration virtueller 
Kanäle festgelegt, mit welchen Kanälen bestimmte Messungen durchge-
führt werden sollen. 

Ein Task – ein wichtiger neuer Bestandteil von NI-DAQmx – besteht aus 
virtuellen Kanälen und den dazugehörigen Takt- und Triggereinstellungen. 
Ein Task beschreibt alle Parameter einer durchzuführenden Messung oder 
Signalerzeugung. Sämtliche Einstellungen eines Tasks sind konfigurierbar 
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und lassen sich speichern, so dass dieser auch in anderen Applikationen 
eingesetzt werden kann.

In NI-DAQmx können virtuelle Kanäle als Teil eines Tasks oder separat 
konfiguriert werden. Virtuelle Kanäle, die innerhalb eines Tasks erstellt 
wurden, werden als lokale virtuelle Kanäle bezeichnet, und solche, die 
separat erstellt wurden, als globale virtuelle Kanäle. Globale virtuelle 
Kanäle zeichnen sich dadurch aus, dass sie an keine bestimmte Anwendung 
gebunden sind, und können daher einer Vielzahl von Tasks hinzugefügt 
werden. Die Erstellung eines globalen Kanals ist entweder im MAX oder 
in einer Entwicklungsumgebung von National Instruments möglich. Eine 
Änderung an einem globalen Kanal wirkt sich auf alle Tasks aus, in denen 
der Kanal verwendet wird. 

Konfiguration eines Tasks in NI-DAQmx
Tasks für NI-DAQmx werden mit Hilfe des DAQ-Assistenten konfiguriert. 
Zum Erstellen von Tasks und Kanälen mit dem DAQ-Assistenten muss 
eine Entwicklungsumgebung von National Instruments ab Version 7.0 
installiert sein.

• Klicken Sie im MAX mit der rechten Maustaste auf Datenumgebung 
und wählen Sie Neu. Wählen Sie NI-DAQmx-Task und klicken Sie 
auf Weiter.

Bei Systemen im Netzwerk, die mit LabVIEW Real-Time arbeiten, 
klicken Sie zunächst die Kategorie Netzwerkumgebung, dann das 
System und anschließend die Kategorie Datenumgebung doppelt an 
und wählen Neu.

• Der DAQ-Assistent lässt sich auch direkt von einer Entwicklungsum-
gebung öffnen.

– In LabVIEW:

• Fügen Sie entsprechend der Beschreibung unter Erste 
Schritte mit LabVIEW das Express-VI “DAQ-Assistent” in 
das Blockdiagramm ein, das sich auf der Express-Palette 
“Eingabe” befindet. 

• Fügen Sie aus der Palette “DAQmx-Namenelemente” ein 
Bedienelement des Typs “DAQmx-Taskname” in das Front-
panel ein, um den DAQ-Assistenten zu öffnen. Klicken Sie 
das Element mit der rechten Maustaste an und wählen Sie 
Neuer Task (DAQ-Assistent). Alle Schritte zum Erstellen 
eines Tasks einschließlich der Erstellung von Blockdia-
grammcode ist in der Hilfedatei Messungen mit NI-DAQmx 
in LabVIEW beschrieben, die in LabVIEW über Hilfe»Mes-
sungen mit NI-DAQmx in LabVIEW geöffnet wird.
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– In LabWindows/CVI:

1. Wählen Sie Tools»Create/Edit DAQmx Tasks. Es öffnet 
sich das Dialogfeld “Create/Edit DAQmx Tasks”. 

2. Wählen Sie Create New Task In MAX oder Create New 
Task In Project und klicken Sie auf OK.

– In Measurement Studio:

1. Öffnen Sie Visual Studio .NET und das Projekt, in dem der 
DAQmx-Task erzeugt werden soll.

2. Wählen Sie Project»Add New Item. Sie sehen das 
Dialogfeld “Add new item”. 

3. Klicken Sie unter “Categories” auf Measurement Studio» 
Assistent.

4. Wählen Sie anschließend aus den Vorlagen DAQmx Task 
Class aus.

5. Geben Sie für die Datei zum DAQmx-Task einen Namen an 
und klicken Sie auf Open. 

6. Geben Sie an, ob Sie einen neuen Task oder eine Kopie eines 
globalen Tasks erstellen möchten, der im MAX erzeugt 
wurde.

7. Klicken Sie auf Finish.

Nach dem Öffnen des DAQ-Assistenten kann nun auf folgende Weise ein 
Task erstellt werden:

1. Wählen Sie einen I/O-Typ aus (z. B. Analogeingabe).

2. Bestimmen Sie anschließend die zu messende bzw. zu erzeugende 
Größe.

3. Wählen Sie – sofern erforderlich – einen Sensor für die Messung aus.

4. Wählen Sie für Ihre Tasks die physikalischen Kanäle aus, die als lokale 
virtuelle Kanäle im Task enthalten sein sollen. Statt dessen können Sie 
dem Task auch einen vorhandenen globalen virtuellen Kanal hinzufü-
gen oder einen globalen oder lokalen virtuellen Kanal in einen Task 
hineinkopieren. 

Wenn Sie mit einem TEDS-Sensor arbeiten, klicken Sie auf die Regi-
sterkarte TEDS-Kanäle. Wählen Sie die physikalischen Kanäle aus. 
Der DAQ-Assistent importiert nun die Daten vom Sensor und erstellt 
den Task. 

Klicken Sie auf Weiter.

5. Wenn der DAQ-Assistent vom MAX aus gestartet wurde, geben Sie 
einen neuen Namen für den Task ein. Klicken Sie auf Beenden.
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6. Nehmen Sie nun bei Bedarf Einstellungen zum Mess-/Ausgabesignal, 
-takt, -modus, zur Triggerung und zur Skalierung vor. Wenn Kanäle 
zur Messung mit TEDS-Sensoren konfiguriert wurden, können 
manche Einstellungen, die von den Sensoren übernommen wurden, 
nicht bearbeitet werden.

7. Es ist möglich, einem Task neue virtuelle Kanäle hinzuzufügen. Die 
Art der Messung ist dabei unerheblich. So lässt sich zum Beispiel ein 
Task zur Spannungsmessung auch um einen Temperaturkanal erwei-
tern. Klicken Sie zum Hinzufügen eines virtuellen Kanals auf die 
Schaltfläche “Hinzufügen” ( ). 

a. Wählen Sie aus der Liste die Art der Messung aus.

b. Wählen Sie für Ihre Tasks die physikalischen Kanäle aus, die als 
lokale virtuelle Kanäle im Task enthalten sein sollen. Statt dessen 
können Sie dem Task auch einen vorhandenen globalen virtuellen 
Kanal hinzufügen oder einen globalen oder lokalen virtuellen 
Kanal in einen Task hineinkopieren. 

c. Klicken Sie auf OK.

8. Speichern Sie den Task.

• Wenn der DAQ-Assistent von LabVIEW oder von 
LabWindows/CVI aus geöffnet wurde, klicken Sie auf OK. 

• In Measurement Studio klicken Sie auf File»Save. 
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• Wenn der DAQ-Assistent vom MAX aus geöffnet wurde, wählen 
Sie Task speichern. 

Nun kann der Task in einer Applikation verwendet werden. Ein Bearbeiten 
oder Umbenennen von virtuellen Kanälen ist auch im DAQ-Assistenten 
möglich.

Konfiguration globaler virtueller Kanäle in NI-DAQmx
Globale virtuelle Kanäle für NI-DAQmx werden mit Hilfe des DAQ-Assi-
stenten konfiguriert. Zum Erstellen globaler virtueller Kanäle kann nur der 
Measurement and Automation Explorer verwendet werden, allerdings ist 
es auch möglich, einen globalen virtuellen Kanal von einer Entwicklungs-
umgebung aus hinzuzufügen.  

• Um den DAQ-Assistenten im MAX zu öffnen, klicken Sie mit der 
rechten Maustaste auf Datenumgebung und wählen Neu. 

Bei Systemen im Netzwerk, die mit LabVIEW Real-Time arbeiten, 
klicken Sie zunächst die Kategorie Netzwerkumgebung, dann das 
System und anschließend die Kategorie Datenumgebung doppelt an 
und wählen Neu.

Klicken Sie auf NI-DAQmx - Globaler Kanal und anschließend auf 
Weiter.

• Der DAQ-Assistent lässt sich auch direkt von einer NI-Entwicklungs-
umgebung aus öffnen.

– Fügen Sie dazu in LabVIEW das Element “DAQmx - Globaler 
Kanal” in das Blockdiagramm ein. Klicken Sie es mit der rechten 
Maustaste an und wählen Sie Neuer Kanal (DAQ-Assistent).

– In LabWindows/CVI und Measurement Studio muss zunächst, 
wie zuvor beschrieben, ein Task erstellt werden. Klicken Sie dazu 
im DAQ-Assistenten auf die Schaltfläche “Hinzufügen” ( ), und 
wählen Sie dann im Dialogfeld “Add Channels to Task” aus der 
Registerkarte Global einen virtuellen Kanal aus.  

Der DAQ-Assistent fordert Sie daraufhin zu Angaben zum neuen virtuellen 
Kanal auf:

1. Wählen Sie einen I/O-Typ aus (z. B. Analogeingabe). 

2. Bestimmen Sie anschließend die zu messende bzw. zu erzeugende 
Größe. 

3. Wählen Sie – sofern erforderlich – einen Sensor für die Messung aus. 

4. Wählen Sie den physikalischen Kanal aus, auf den sich der globale vir-
tuelle Kanal stützen soll, oder kopieren Sie die Spezifikationen eines 
vorhandenen globalen Kanals in den DAQ-Assistenten.
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Wenn Sie mit einem TEDS-Sensor arbeiten, klicken Sie auf die Regi-
sterkarte TEDS-Kanäle. Wählen Sie die physikalischen Kanäle aus. 
Der DAQ-Assistent importiert nun die Daten vom Sensor. Wenn phy-
sikalische Kanäle zur Messung mit TEDS-Sensoren konfiguriert 
wurden, können manche Einstellungen, die von den Sensoren über-
nommen wurden, nicht bearbeitet werden. Klicken Sie auf Weiter.

5. Geben Sie den Namen des neuen globalen Kanals ein. Klicken Sie auf 
Beenden.

6. Nehmen Sie nun die Einstellungen zur Messung und – wenn erforder-
lich – zur Messwertskalierung vor. 

7. Speichern Sie die Einstellungen.

Der globale virtuelle Kanal kann nun in jeder beliebigen Anwendung ein-
gesetzt oder einem beliebigen Task hinzugefügt werden.

Konfiguration virtueller Kanäle für den traditionellen 
NI-DAQ-Treiber (alt)

Beim alten, traditionellen NI-DAQ-Treiber werden virtuelle Kanäle im 
MAX konfiguriert. Gehen Sie dazu wie folgt vor:

1. Öffnen Sie den Assistenten zum Erstellen neuer Kanäle. 

• Klicken Sie im MAX mit der rechten Maustaste auf Datenumge-
bung und wählen Sie Neu. Wählen Sie anschließend Virtueller 
Kanal und klicken Sie auf Beenden. 

• Wenn Sie auf einem RT-System im Netzwerk mit dem traditionel-
len NI-DAQ-Treiber arbeiten, wählen Sie Werkzeuge»Trad. 
NI-DAQ-Konfiguration»RDA-DAQ-Konfiguration. Darauf-
hin öffnet sich das Fenster “DAQ-Netzwerkkonfiguration” mit 
einer Liste aller erkannten Geräte. Wählen Sie Kanal und klicken 
Sie auf Hinzufügen.
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2. Folgen Sie den Anweisungen des Assistenten. Die Konfiguration eines 
Kanals wird in der Hilfe zum Measurement & Automation Explorer für 
den traditionellen NI-DAQ-Treiber beschrieben.

Schritt 15: Verwenden eines Tasks in einer Applikation
Über die folgenden Schritte binden Sie einen Task in Ihre Applikation ein. 
Der Einsatz von Tasks und das Erzeugen von Programmcode wird in der 
DAQ Assistant Help und der Beschreibung zu Ihrer Entwicklungsumge-
bung näher erläutert.

Mit der NI-DAQmx-Simulationsfunktion lassen sich Beispiele auch aus-
führen, ohne dass die benötigten Geräte angeschlossen sind. Lesen Sie dazu 
auch die Hilfe zum Measurement & Automation Explorer für NI-DAQmx, 
die im MAX über Hilfe»Hilfethemen»NI-DAQmx geöffnet wird. 

LabVIEW
1. Öffnen Sie in LabVIEW ein leeres VI. 

2. Legen Sie die folgende Konstante auf dem Blockdiagramm ab: 
NI-Messtechnik»DAQmx - Datenerfassung»DAQmx - Taskname 
(Konstante).

3. Wählen Sie aus dem Pulldown-Menü einen Task aus. 

4. Klicken Sie das VI mit der rechten Maustaste an, und wählen Sie Pro-
grammcode erzeugen»Beispiel. 

5. Wechseln Sie zum Frontpanel und starten Sie das VI.
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LabWindows/CVI
Eine detaillierte Anleitung zur Verwendung von Tasks in 
LabWindows/CVI erhalten auf ni.com/info nach Eingabe von rddq73.

Measurement Studio
Für eine detaillierte Anleitung zur Verwendung von Tasks in Measurement 
Studio geben Sie auf der Website ni.com/info die Zeichenkombination 
rddqms ein.

Erste Schritte der Entwicklung einer Applikation

Umgang mit Beispielen
Jede API enthält Programmierbeispiele, die das Erstellen einer Applikation 
vereinfachen sollen. Diese lassen sich bearbeiten und zur Weiterverwen-
dung speichern. So kann auf Grundlage eines Beispiels eine neue 
Applikationen erstellt oder eine bestehende Applikation erweitert werden.

Mit der NI-DAQmx-Simulationsfunktion lassen sich Beispiele auch aus-
führen, ohne dass die benötigten Geräte angeschlossen sind. Lesen Sie dazu 
auch die Hilfe zum Measurement & Automation Explorer für NI-DAQmx, 
die im MAX über Hilfe»Hilfethemen»NI-DAQmx geöffnet wird. 

Zum Auffinden von LabVIEW- und LabWindows/CVI-Beispielen öffnen 
Sie über Hilfe»Beispiele suchen die Suchmaschine für Beispiele von 
National Instruments.

NI-DAQmx-Beispiele für von Measurement Studio unterstützte Program-
miersprachen (Visual Basic .NET, C# und MFC C++):

• Beispiele zu Measurement Studio MFC C++:
MeasurementStudioVS2003\VCNET\Examples\DAQmx 

• Beispiele zu Visual C# und Visual Basic .NET (ohne Measurement 
Studio): MeasurementStudioVS2003\DotNET\Examples\
DAQmx

Im Verzeichnis NI-DAQ\Examples\DAQmx ANSI C befinden sich 
NI-DAQmx-Beispiele für ANSI C.

Beispiele für den traditionellen NI-DAQ-Treiber in Visual Basic:

• NI-DAQ\Examples\Visual Basic with Measurement Studio 
enthält einen Link zu Anwendungsbeispielen für die Traditional DAQ 
CWDAQ ActiveXControls. Wenn Measurement Studio nicht instal-
liert ist, laufen die Beispiele auf einer Evaluierungsversion der 
ActiveX-Benutzeroberfläche.
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• Das Verzeichnis NI-DAQ\Examples\VBasic enthält von Measure-
ment Studio unabhängige Beispiele.

Im Verzeichnis NI-DAQ\Examples\VisualC sind Beispiele für den 
alten, traditionellen NI-DAQ-Treiber für ANSI C verfügbar.

Hunderte weiterer Beispiele gibt es auf ni.com/zone.

Informationen zu Messapplikationen und -geräten
Nachfolgend einige Hinweise dazu, wo Sie Informationen über Ihre mess-
technischen Anwendungen und Geräte finden können.

LabVIEW
Neuanwender sollten sich zunächst mit dem Handbuch Erste Schritte mit 
LabVIEW befassen, um mit LabVIEW vertraut zu werden. Zum Öffnen der 
entsprechenden PDF-Datei klicken Sie auf Start»Programme»National 
Instruments»LabVIEW 7.x»Im LabVIEW-Bücherregal suchen.

Im LabVIEW Measurements Manual finden Sie eine Übersicht über die 
API des NI-DAQmx-Treibers und des alten, traditionellen NI-DAQ-Trei-
bers, und es werden einige Grundlagen der Messtechnik besprochen. Zum 
Öffnen der entsprechenden PDF-Datei klicken Sie auf Start»
Programme»National Instruments»LabVIEW 7.x»
Im LabVIEW-Bücherregal suchen.

In der Hilfedatei Messungen mit NI-DAQmx in LabVIEW wird schrittweise 
beschrieben, wie eine Messung in LabVIEW vorbereitet wird, und es 
werden die neuen NI-DAQmx-Funktionen sowie DAQmx-spezifische 
Begriffe wie “DAQ-Assistent” oder “Task” erläutert. Die Hilfe wird in 
LabVIEW über Hilfe»Messungen mit NI-DAQmx in LabVIEW 
geöffnet.

In der LabVIEW-Hilfe gibt es eine Übersicht über VIs und Funktionen, in 
der auch die Eigenschaften für NI-DAQmx und den traditionellen 
NI-DAQ-Treiber beschrieben sind. Zum Öffnen der Datei wählen Sie in 
LabVIEW Hilfe»LabVIEW-Hilfe und klicken unter Inhalt auf VI- und 
Funktionsreferenz, um die VI-Übersicht für die von Ihnen verwendete 
NI-DAQ-API zu finden.

LabVIEW Real-Time Module
Wählen Sie Start»Programme»National Instruments»LabVIEW 7.x»
Module Documents»Search the LabVIEW Real-Time Module 
Bookshelf. Hier finden Sie Links zu LabVIEW-RT-Beschreibungen. 
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LabWindows/CVI
Wenn Sie erstmals mit dem LabWindows/CVI arbeiten, sollten Sie sich 
zunächst mit Hilfe des Handbuchs Getting Started with LabWindows/CVI 
mit dem Programm vertraut machen. Zum Öffnen der entsprechenden 
PDF-Datei klicken Sie in LabWindows/CVI auf Help»LabWindows/CVI 
Bookshelf. 

Die LabWindows/CVI Help enthält eine Übersicht über NI-DAQmx-Funk-
tionen und Beschreibungen zu Messungen in NI-DAQmx. Um die Hilfe zu 
öffnen, wählen Sie in LabWindows/CVI Help»Contents.

Measurement Studio
Die NI Measurement Studio Help enthält eine Übersicht über NI-DAQmx-
Funktionen und Beschreibungen zu Messungen in NI-DAQmx. Diese Hil-
fedatei ist Bestandteil der Dokumentation zu Visual Studio .NET. Sie wird 
in Visual Studio .NET über Measurement Studio»Measurement Studio 
Help geöffnet.

ANSI C ohne NI-Anwendungssoftware
Übersichten über APIs finden Sie in der NI-DAQmx Help und im Traditio-
nal NI-DAQ User Manual. Die NI-DAQmx Help enthält zusätzlich 
allgemeine Informationen zur Messtechnik. In der Traditional NI-DAQ C 
Reference Help und der NI-DAQmx C Reference Help finden Sie eine 
Übersicht über die Funktionen und Attribute von C. Wählen Sie Start»
Programme»National Instruments»NI-DAQ und den Titel des Doku-
ments zur verwendeten NI-DAQ-API aus.

.NET-Sprachen ohne NI-Anwendungssoftware
Die NI Measurement Studio Help enthält eine Übersicht über 
NI-DAQmx-Funktionen und Beschreibungen zu Messungen in 
NI-DAQmx. Diese Hilfedatei ist Bestandteil der Dokumentation zu Visual 
Studio .NET. Um sie zu öffnen, klicken Sie in Visual Studio .NET die 
Option Help»Contents an. Zur Anzeige der NI-DAQmx .NET Library 
wählen Sie NI Measurement Studio Help»NI Measurement Studio 
.NET Class Library»Reference»National Instruments.DAQmx. 
Beschreibungen zu Tasks und Erklärungen zur verwendeten Terminologie 
finden Sie unter NI Measurement Studio Class .NET Library»Using the 
Measurement Studio .NET Class Libraries»Using the Measurement 
Studio NI-DAQmx .NET Library. 

Hinweis Bei Verwendung einer .NET-Sprache ohne Visual Studio .NET kann es vorkom-
men, dass die NI Measurement Studio Help nicht eingesehen werden kann.
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Gerätedokumentation
NI-DAQ 7.x umfasst neben Direkthilfen zur Hardware, die mit dem Treiber 
unterstützt wird, PDF- und Hilfedateien, in denen die Anschlüsse, Lei-
stungsmerkmale und die Betriebsweise der Geräte erläutert werden und die 
Grunddaten zu den Geräten enthalten sind. Alle Dokumente lassen sich 
öffnen und ausdrucken. Legen Sie dazu die NI-DAQ-CD mit dem Titel 
“Device Documentation” ein. Nach der Installation kann das Programm 
über Start»Programme»National Instruments»NI-DAQ»Browse 
Device Documentation aufgerufen werden.

Verwendung des NI-DAQmx-Treibers und des traditionellen 
NI-DAQ-Treibers auf demselben Computer

Bestehende Applikationen, die mit früheren Versionen von NI-DAQ 
erstellt wurden, können mit dem alten, traditionellen NI-DAQ-Treiber aus-
geführt werden. Wenn allerdings beide APIs auf demselben Computer 
verwendet werden, gelten folgende Einschränkungen:

• Ein Gerät kann nur von jeweils einer API gesteuert werden.

– Nach der Verwendung eines Geräts mit NI-DAQmx müssen alle 
NI-DAQmx-Tasks, bei denen auf das Gerät zugegriffen wird, 
zurückgesetzt werden, bevor das Gerät mit dem alten, traditionel-
len NI-DAQ-Treiber verwendet werden kann. Ansonsten wird ein 
Fehler mit dem Code -10461 ausgegeben. NI-DAQmx-Tasks 
werden mit dem VI “DAQmx - Task zurücksetzen” aufgehoben. 

– Geräte, die mit dem alten, traditionellen NI-DAQ-Treiber ange-
steuert werden, müssen vor dem Wechsel zu NI-DAQmx in den 
Ausgangszustand zurückversetzt werden, sonst wird ein Fehler 
mit der Nummer -200324 ausgegeben.

Bei SCXI-Modulen muss vor Verwendung von NI-DAQmx das 
Modul, durch das der Datenaustausch mit dem Rechner erfolgt, 
zurückgesetzt werden, wenn zuvor mit dem traditionellen 
NI-DAQ-Treiber gearbeitet wurde. Bei DAQ-Karten der E-Serie 
verläuft die Kommunikation mit dem SCXI-Modul beispiels-
weise über die Leitungen 0, 1, 2 und 4 des Ports 0. Wenn die Karte 
nicht über den traditionellen NI-DAQ-Treiber zurückgesetzt wird, 
erscheint eine Fehlermeldung mit dem Code -200158, wenn sie 
in NI-DAQmx verwendet wird. Zum Zurücksetzen der Karte 
gehen Sie wie folgt vor:

• Rufen Sie das VI “Gerät zurücksetzen” des traditionellen 
NI-DAQ-Treibers oder die Funktion Init_DA_Brds auf.

• Beim traditionellen NI-DAQ-Treiber ist nur ein Zurücksetzen 
aller Geräte auf einmal möglich. Klicken Sie dazu im MAX 
die Kategorie Traditionelle NI-DAQ - Geräte mit der rech-
ten Maustaste an und wählen Sie die Option Treiber für 
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traditionellen NI-DAQ zurücksetzen. Bei RT-Systemen im 
Netzwerk ist dazu das VI “Gerät zurücksetzen” des traditio-
nellen NI-DAQ-Treibers einzusetzen.

• Bei der Datenerfassung mit SCXI müssen alle Geräte (sowohl die 
angeschlossene DAQ-Karte als auch die im Chassis befindlichen 
SCXI-Module) mit derselben API programmiert werden.

Auf der Internetseite ni.com/support finden Sie Beschreibungen und 
Anleitungen zu folgenden Themen:

• Integration von NI-DAQmx-Programmcode in Anwendungen für den 
traditionellen NI-DAQ-Treiber.

• Ausführen von Anwendungen, in denen ein Gerät sowohl mit dem tra-
ditionellen NI-DAQ-Treiber als auch mit NI-DAQmx gesteuert wird.

Fehlersuche
Nachfolgend einige Informationsquellen, die Ihnen bei Problemen mit der 
Installation Ihrer Hard- oder Software zur Datenerfassung von Nutzen sein 
können:

• Bei Problemen besuchen Sie bitte unsere Website ni.com/
support/install und gehen Sie nach den Anweisungen im 
Hardware Installation/Configuration Troubleshooter vor.

• Auf ni.com/kb finden Sie häufig gestellte Fragen und Hilfe bei Pro-
blemen bei der Installation oder Programmierung.

• Falls Sie ein Gerät aufgrund einer Beschädigung zur Reparatur oder 
Kalibrierung an National Instruments zurücksenden müssen, besuchen 
Sie bitte unsere Website ni.com/info und geben die Buchstaben-
kombination rdsenn ein. Hier erfahren Sie, was bei der 
Warenrücksendung an National Instruments zu beachten ist.

Weltweite technische Unterstützung
Für professionelle Serviceleistungen und technische Unterstützung lesen 
Sie bitte auf unserer Website ni.com unter folgenden Kategorien nach:

• Support: Die unter ni.com/support verfügbaren Ressourcen zur 
technischen Unterstützung umfassen:

– Hilfe zur Selbsthilfe: Die preisgekrönte National-Instruments-
Website bietet unter anderem Treiber und Updates, eine umfas-
sende Informationsdatenbank (Knowledgebase), 
Bedienungsanleitungen, Anleitungen zur Fehlersuche, Tausende 
Beispielprogramme, Lernhilfen, Application Notes und 
Messgerätetreiber.
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– Kostenlose technische Unterstützung: Alle registrierten Benut-
zer können den kostenlosen Basis-Support in Anspruch nehmen, 
der unter anderem auch den Zugriff auf das Diskussionsforum 
ni.com/exchange einschließt, in dem Sie sich bei Problemen 
mit Hunderten Applikationsingenieuren weltweit austauschen 
können. Die Applikationsingenieure von National Instruments 
sorgen dafür, dass alle Ihre Fragen beantwortet werden.

Welche Art der technischen Unterstützung in Ihrer Nähe verfüg-
bar ist, erfahren Sie unter ni.com/services oder bei einer 
Niederlassung in Ihrer Nähe (ni.com/contact). 

• Schulung und Zertifizierung: Auf unserer Internetseite ni.com/
training finden Sie Lernhandbücher, virtuelle Schulungsräume, 
interaktive CDs und Informationen über Zertifizierungsprogramme. 
Hier können Sie sich auch für eine der weltweit angebotenen Soft-
ware-Schulungen anmelden.

• System-Integration: Wenn Sie aus Zeit-, Personalmangel oder ande-
ren Gründen bei der Fertigstellung eines Projekts in Verzug geraten, 
können Ihnen die Mitglieder des NI-Alliance-Programms weiterhel-
fen.  Für Informationen zu diesem Programm setzen Sie sich entweder 
telefonisch mit einer National-Instruments-Niederlassung in Ihrer 
Nähe in Verbindung oder besuchen Sie die Website ni.com/
alliance.

• Konformitätserklärung (DoC): Bescheinigt, dass die Firma National 
Instruments unter Verwendung der Konformitätserklärungen der ent-
sprechenden Hersteller die EG-Richtlinien zum Verbraucherschutz 
einhält. Mit dem DoC werden elektromagnetische Verträglichkeit und 
Sicherheit unserer Produkte garantiert. Das Zertifikat zu Ihrem Pro-
dukt finden Sie unter ni.com/certification.

• Kalibrierungszertifikat: Wenn das von Ihnen verwendete Produkt 
kalibrierbar ist, erhalten Sie unter ni.com/calibration das zuge-
hörige Kalibrierungszertifikat.

Die Adresse der Hauptgeschäftsstelle von National Instruments lautet 
11500 North Mopac Expressway, Austin TX, 78759-3504, USA. Auf die 
Websites unserer einzelnen Niederlassungen mit Kontaktangaben, Tele-
fonnummern des technischen Supports, E-Mail-Adressen sowie Hinweisen 
auf aktuelle Ereignisse und Veranstaltungen gelangen Sie über 
ni.com/niglobal.

Unterstützung in NI-DAQ 7.4
NI-DAQmx 7.4 unterstützt alle messtechnischen Geräte von National 
Instruments. Neue Geräte werden zukünftig ebenfalls nur noch zu 
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NI-DAQmx hinzugefügt. Das heißt, der alte traditionelle NI-DAQ-Treiber 
wird nicht mehr erweitert. 

Unterstützte Betriebssysteme
NI-DAQmx 7.4, der traditionelle NI-DAQ-Treiber 7.4 und NI-SWITCH 
2.3 sind nur unter Windows 2000, NT und XP lauffähig. Für NI-DAQ 7.x 
ist unter Windows NT mindestens Service Pack 6 erforderlich.

PharLap wird von NI-DAQmx 7.4 nur mit dem LabVIEW Real-Time 
Module 7.1 unterstützt.

Für Measurement Studio wird Visual Studio .NET 2003 benötigt, was wie-
derum Windows 2000/NT 4.0/XP voraussetzt. 

Für die DAQmx .NET Library wird das .NET 1.1 Framework benötigt. 
.NET 1.1 läuft nur unter Windows 2000/XP.

Systemspezifische Installationshinweise sind im Hardware Installation/
Configuration Troubleshooter auf ni.com/support/install 
nachzulesen.

Auf ni.com/downloads können frühere Versionen von NI-DAQ, die 
auch auf anderen Betriebssystemen lauffähig sind, heruntergeladen 
werden. 

Unterstützte Anwendungsprogramme
In der Tabelle 1 sind alle Versionen der Anwendungssoftware von National 
Instruments aufgeführt, die zu NI-DAQmx und zum alten, traditionellen 
NI-DAQ-Treiber kompatibel sind. Für andere Programmiersprachen gilt 
Tabelle 2.

 
Tabelle 1.  Von NI-DAQ 7.x unterstützte Anwendungssoftware

NI-Applikationssoftware

Über NI-DAQmx 
unterstützte 
Versionen

Traditioneller 
NI-DAQ-Treiber 

(alt)

LabVIEW  7.x 6.1–7.x

LabVIEW Real-Time Module 7.1* 6.1–7.x

LabWindows/CVI  7.x 6.0–7.x

Measurement Studio  7.x 6.0–7.x†

* Für das LabVIEW Real-Time Module 7.1 ist mindestens NI-DAQmx 7.2 erforderlich.
† Der alte traditionelle NI-DAQ-Treiber hat keine Measurement-Studio-C++- oder 
.NET-Schnittstelle.
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Unterstützte Programmiersprachen und Kompilierprogramme
 

Frühere Versionen von NI-DAQ unterstützen andere Versionen von Ent-
wicklungsumgebungen und Programmiersprachen. Frühere Versionen 
können unter ni.com/downloads heruntergeladen werden.

Unterstützte Hardware
In Tabelle 3 sind alle Gerätefamilien aufgeführt, die in NI-DAQ 7.4 mit 
NI-DAQmx und dem traditionellen NI-DAQ-Treiber unterstützt werden. 
Die genauen Modellbezeichnungen finden Sie in der NI-DAQ 7.x Readme 
auf der CD. 

Tabelle 2.  Von NI-DAQ 7.x unterstützte Programmiersprachen

Programmiersprache

Über NI-DAQmx 
unterstützte 
Versionen

Traditioneller 
NI-DAQ-Treiber 

(alt)

Microsoft Visual C++
Klassenbibliotheken
ANSI C

7.x *

6.0–7.x
—

6.0–7.x

Visual Basic — 6.0†

Microsoft .NET Framework
(C# und Visual Basic .NET)

.NET 1.1 —

Borland — ✓

* Measurement Studio 7.x erforderlich.
† Wird über ActiveX-Komponenten unterstützt.

Tabelle 3.  Von NI-DAQ 7.4 unterstützte Geräte

Gerät NI-DAQmx

Traditioneller 
NI-DAQ-Treiber 

(alt)

Multifunktions-DAQ-Karten

PCI-, PCI-express und PXI-Karten der M-Serie wie NI-PCI-622X/625X/628X ✓ —

PCI- und PXI-Karten der E-Serie wie NI-PCI-6052E ✓ ✓

PCMCIA-Karten der E-Serie, NI-DAQCard-6024E, NI-DAQCard-6036E und 
NI-DAQCard-6062E

✓ ✓

AT-E-Serie — ✓

NI-PCI-6010 ✓ —

NI-PCI-6013/6014 (Karten für Grundfunktionen) ✓ ✓

NI-DAQPad-6015 (BNC)/6015 (Vielfachkontaktierung)/6016-Geräte für USB ✓ —

NI-DAQPad-6020E/6052E/6070E-Geräte für USB und FireWire® (IEEE 1394) — ✓

NI-PCI-Karten des Typs 7041/6040E für LabVIEW Real-Time ✓ ✓
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Multifunktions-DAQ-Karten (Fortsetzung)

NI-PXI- und PCI-7030 für LabVIEW Real-Time — ✓

NI-PXI und PCI-6122/6123/6132/6133/6143 der S-Serie ✓ —

Geräte der S-Serie wie NI-PXI-6115/6120 oder NI-PCI-6110/6111 ✓ ✓

Analogausgabe/Signalverlauf

NI-PXI- und PCI-6711/6713 Signalverlauf ✓ ✓

PCMCIA-NI-DAQCard-6715 ✓ ✓

NI-PXI- und PCI-6722/6723 ✓ —

NI-PXI- und PCI-6731/6733 ✓ ✓

NI-PXI-6704 und PCI-6722/6704 ✓ ✓

AT-AO-6/10 — ✓

Analogeingabe: PCMCIA-DAQCard-AI-16E-4 und DAQCard-AI-16XE-50 — ✓

Counter/Timer

NI-PCI-6601/6602 und NI-PXI-6602/6608 ✓ ✓

NI-PXI- und PCI-6624 mit isolierten Eingängen ✓ —

Digital-I/O

NI-6503, NI-PXI-6508, NI-6527 und NI-PCI-DIO-96 ✓ ✓

NI-6509/6510/6511/6512/6513/6514/6515/6516/6517/6518/6519 und NI-6528 ✓ —

DAQCard-6533 und AT-DIO-32HS — ✓

Alle anderen NI-653X-Karten (Hochgeschwindigkeitskarten zur digitalen I/O) ✓ ✓

PCMCIA-NI-DAQCard-DIO-24 ✓ ✓

NI-DAQPad-6507/6508 für USB — ✓

PC-DIO-24 und PC-DIO-96 — ✓

AT-DIO-32F — ✓

Erfassung dynamischer Signale

NI-PXI-4472/4472B und NI-PCI-4472/4474 ✓ ✓

NI-PXI-4461/4462 ✓ —

NI-PCI-4451/4452/4454 und 4551/4552 — ✓

Tabelle 3.  Von NI-DAQ 7.4 unterstützte Geräte (Fortsetzung)

Gerät NI-DAQmx

Traditioneller 
NI-DAQ-Treiber 

(alt)
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Geräte, die von NI-DAQ 7.x nicht mehr unterstützt 
werden
Die nachfolgend aufgeführten Produkte werden nicht von NI-DAQ 7.x 
unterstützt – also weder von NI-DAQmx noch vom alten, traditionellen 
NI-DAQ-Treiber – und werden auch in zukünftigen Versionen von 
NI-DAQ nicht mehr enthalten sein. Zur Programmierung dieser Geräte ist 
NI-DAQ 6.9.x oder eine frühere Version erforderlich.

Signalkonditionierung

SCXI-1521/B und SCXI-1600-Module ✓ —

Alle anderen SCXI-Signalkonditionierungsmodule ✓ ✓

NI-PXI-4200/4204/4220/4225 (Karten mit integrierter Signalaufbereitung) ✓ —

Module der SCC-Serie ✓ ✓

TEDS-Sensoren: BNC-2096, SC-2350-Anschlussblock und SCXI-1314T
Hinweis: Mit diesen Geräten können TEDS-Sensoren ausgelesen und beschrieben 
werden.

✓ —

Schaltmodule

NI-SCXI-1160, SCXI-1161 und SCXI-1163R ✓ ✓

Alle anderen SCXI-Schaltmodule ✓ —

PXI-Schaltmodule ✓ —

NI-AT-MIO-16F-5
NI-DAQCard-500
NI-DAQCard-516
NI-DAQCard-700
NI-DAQCard-1200
NI-DAQCard-AO-2DC
NI-DAQPad-1200
NI-DAQPad-MIO-16XE-50
NI-Lab-PC und Lab-PC+
NI-Lab-PC-1200/AI
NI-PC-516
NI-PC-AO-2DC

NI-PC-LPM-16/PNP
NI-PC-OPDIO-16
NI-PC-TIO-10
NI-PCI-1200
NI-SCXI-1200
NI-SCXI-2000
NI-SCXI-2400
NI-VXI-DAQ-Module
NI-VXI-SC (Modulträger und Module)
NI-VXI-TB (Anschlussblöcke für den 
VXIbus)

Tabelle 3.  Von NI-DAQ 7.4 unterstützte Geräte (Fortsetzung)

Gerät NI-DAQmx

Traditioneller 
NI-DAQ-Treiber 

(alt)
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DAQクイックスタートガイド
この文書では、NI-DAQ 7.xドライバソフトウェアおよびデータ集録
（DAQ）デバイスのインストール、構成方法、およびデバイスが適切に動
作しているかどうかを確認する方法について説明します。

この文書では、NIスイッチモジュールのインストールおよび構成方法に
ついては説明しません。『NI Switches Getting Started Guide』を参照
してください。
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表記規則

この文書では、以下の表記規則を採用しています。

<> 山括弧はファンクションキーを示します。

→ →の記号は、ネストされたメニュー項目やダイアログボックスのオプショ

ンをだどっていくと目的の操作項目を選択できることを示します。たとえ

ば、ファイル→ページ設定→オプションという順番で示されている場合

は、まずファイルメニューをプルダウンして、次にページ設定項目を選択

し、オプションを選択します。

メモのアイコンは重要な情報を示します。

このアイコンは、人体の損傷、データの損失、システムの破壊を防止する

ための注意事項があることを示します。デバイスにこの記号が付いている

場合には、事前対策についてデバイスに同梱されている『はじめにお読み

ください : 安全性および電波周波数障害』ドキュメントを参照してくだ
さい。

製品にこの記号が付いている場合は、電気ショックを防止するための事前

対策についての警告を示します。

製品にこの記号が付いている場合は、熱を持っている可能性があるコン

ポーネントを表します。このコンポーネントに接触すると、人体が損傷す

るおそれがあります。

太字 太字のテキストは、メニュー項目およびダイアログボックスのオプション

など、ソフトウェアで選択またはクリックする必要のある項目を表します。 

下線 下線の付いたテキストは強調を示します。
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monospace このフォントのテキストは、キーボードから入力するテキストや文字、エ

ラーコード、ディスクドライブ名、パス、ディレクトリ、プログラム、関

数、ファイル名、および拡張子を示します。

2重括弧 2重括弧（『』）はクロスリファレンスを示します。

NI-DAQ 7.xソフトウェア
ナショナルインスツルメンツの計測デバイスには、LabVIEWまたは
LabWindows�/CVI�など、アプリケーションソフトウェアから呼び出す
ことができる VIや関数の豊富なライブラリである NI-DAQドライバソフ
トウェアが同梱されており、NIの計測デバイスをプログラムすることが
できます。計測デバイスには、Mシリーズマルチファンクション I/O
（MIO）デバイス、SCXI信号調節モジュール、およびスイッチモジュー
ルなどの DAQデバイスが含まれます。また、ドライバソフトウェアに
は、デバイスのアプリケーションを作成するための、VI、関数、クラス、
属性、およびプロパティのライブラリであるアプリケーションプログラミ

ングインタフェース（API）が含まれています。

NI-DAQ 7.xには、NI-DAQドライバが 2つ含まれており、それぞれのド
ライバには独自の API、ハードウェア構成、およびソフトウェア構成があ
ります。 

� NI-DAQmxは最新の NI-DAQドライバで、従来型 NI-DAQ（レガ
シー）に比べ、以下の優位点があります。

� DAQアシスタント―LabVIEW、LabWindows/CVI、および
Measurement Studioで使用できるように、デバイスの仮想
チャンネルおよび計測タスクを構成し、この仮想チャンネルとタ

スクに基づいて NI-DAQmxコードを生成するグラフィカルツ
ール。

� 高速化シングルポイントアナログ I/Oおよびマルチスレッドな
ど、パフォーマンスの向上。

� ハードウェアをプラグインせずにアプリケーションをテストおよ

び修正する NI-DAQmxシミュレーションデバイス。 

� NI-DAQの旧バージョンと比較して、わずかな関数と VIで DAQ
アプリケーションを作成できる、シンプルで直感的な API。

� プロパティノードおよび波形データタイプサポートを含む、

LabVIEWのために拡張された機能。

� ANSI C、LabWindows/CVI、ネイティブ .NETとC++インタ
フェースを含むMeasurement Studioと同様の APIおよび機
能性。

� LabVIEW Real-Timeモジュールのために向上したサポートおよ
びパフォーマンス。
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� 従来型 NI-DAQ（レガシー）は、NI-DAQの旧バージョンがアップグ
レードされたものです。従来型 NI-DAQ（レガシー）では、従来型
NI-DAQ（レガシー）および NI-DAQmxを同一のコンピュータで使
用できる点と、サポートされていないハードウェアがある点を除き、

NI-DAQ 6.9.3と同じ VIおよび関数があり、同様に機能します。 

NI-DAQmxの使用条件
以下の状況に該当する場合は、NI-DAQmxをインストールして使用して
ください。

� NI-DAQの新規ユーザ。

� NI-DAQmxでサポートされているデバイスを使用している場合は、
本書の最後にある「NI-DAQ 7.4のサポート」セクションを参照して
ください。

� Windows 2000/NT/XPを使用している場合。

NIアプリケーションソフトウェアを NI-DAQmxとともに使用している場
合は、LabVIEW、LabWindows/CVI、Measurement Studio バージョ
ン 7.x、VI Logger 2.x、または LabVIEW Real-Timeモジュール 7.1以降
を使用する必要があります。

Microsoft .NET言語、 Visual C# 、Visual Basic .NET、またはMシリー
ズデバイスなどの NI-DAQmxのみでサポートされているデバイスを使用
する場合には、NI-DAQmxを使用する必要があります。

また、ANSI Cコンパイラなど、サポートされているコンパイラとともに
NI-DAQmxを使用することもできます。 

従来型 NI-DAQ（レガシー）の使用が必要な場合
新規 NI-DAQユーザの場合、または使用しているアプリケーションが前
述の条件に合う場合は、NI-DAQmxを使用してください。以下の状況が
該当する場合には、従来型 NI-DAQ（レガシー）をインストールして使用
してください。

� AT E シリーズマルチファンクション DAQデバイスなど、
NI-DAQmxでサポートされていないデバイスを使用している。

� 7.0より前のバージョンの LabVIEW、LabWindows/CVI、または
Measurement Studioを使用している。

� Macintosh用 LabVIEW Real-Timeモジュールを使用している。

� NI-DAQ 6.9.xからアップグレードして、NI-DAQmxに移植する予定
のない既存アプリケーションがある。 

メモ 従来型 NI-DAQ（レガシー）でサポートされている NIアプリケーションソフト
ウェアで最も古いバージョンは 6.0です。LabVIEW、LabWindows/CVI、ま
たはMeasurement Studio 6.xでは、NI-DAQ 7.xから従来型 NI-DAQ（レガ
シー）を使用できます。
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NI-DAQのシステムの適合性
図 1はこの計測システムの概要で、実際の物理現象がどのような流れで
計測アプリケーションに取り入れられるかを示しています。

センサとトランスデューサは物理現象を検出します。信号調節コンポーネ

ントは、物理現象を計測デバイスがデータを扱えるような電気信号に調節

します。コンピュータは計測デバイスからデータを受け取ります。ソフト

ウェアは計測システムを制御し、いつ、どの物理チャンネルからデータを

集録または出力するかを計測デバイスに伝えます。また、ソフトウェアは

未処理データを取得し、グラフ、チャートまたはレポート用ファイルのよ

うな人間が理解できる形式で解析および表示します。 

図 1 計測システムの概要
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NIの計測デバイスおよびアプリケーションソフトウェアには、データの
構成、集録、生成、NIの計測デバイスへのデータの送信といった NIの計
測デバイスの機能をすべてプログラムするための NI-DAQドライバソフ
トウェアが梱包されています。NI-DAQを使用すると、そのようなプログ
ラムを作成する時間や手間が省けます。LabVIEW、LabWindows/CVI、
Measurement Studio、および VI Loggerのようなアプリケーションソ
フトウェアは、熱電対で読み取った値を収録して返すなど、コマンドをド

ライバへ送信して集録されたデータの表示や解析を行います。

NI-DAQドライバは、NI アプリケーションソフトウェアまたは ANSI C
インタフェースを介したダイナミックリンクライブラリ（DLL）の呼び出
しをサポートするプログラミング環境から使用できます。図 1のように、
プログラミング環境に関係なく、DAQアプリケーションは NI-DAQを使
用します。

手順 1. アプリケーションソフトウェアをインストール
する

NIアプリケーションソフトウェアをインストールします。NI-DAQmx
を使用してシステムで DAQデバイスのプログラムを作成する場合は、
LabVIEW 7.x、LabWindows/CVI 7.x、Measurement Studio 7.x、 
VI Logger 2.x、または LabVIEW Real-Timeモジュール 7.1以降をイン
ストールしてください。

旧バージョンのアプリケーション開発環境または NI-DAQで作成された
アプリケーションが存在する場合は、そのアプリケーションのバックアッ

プコピーを作成します。その後、ソフトウェアをアップグレードして、

そのアプリケーションを修正することができます。

手順 2. NI-DAQ 7.xソフトウェアをインストールする

CDを挿入する

注意 既存のアプリケーションがサポートされていないコンポーネントを含む場合、

NI-DAQ 7.xをインストールしないでください。ソフトウェアをインストールす
る前に、この文書の最後にあるセクションの「NI-DAQ 7.4のサポート」を参照
してください。
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NI-DAQ 7.xのインストーラが自動的に起動します。インストーラが起動
しない場合は、スタート→ファイル名を指定して実行を選択します。

x:¥setup.exeと入力します。ここで、xは CDドライブの文字を示し
ます。トラブルシューティングの説明については、ni.com/support/

ja/troubleshooting.htmのトラブルシューティングリソースを参照し

てください。

新規ハードウェアデバイスをインストールする前にドライバソフトウェア

をインストールして、Windowsがデバイスを検出できるようにしてくだ
さい。

インストールする APIを選択する

注意 NI-DAQ 7.xは、NI-DAQの旧バージョンと同じシステムに共存させることがで
きません。NI-DAQ 7.xをインストールすると、最新バージョンの従来型
NI-DAQ（レガシー）が旧バージョンの NI-DAQを上書きします。また、旧バー
ジョンによりインストールされたサポートファイルも最新のものになります。

NI-DAQmxのみをインストールした場合は、NI-DAQ 6.9.x以前の NI-DAQが削
除されます。

NI-DAQ 7.xは、複数のドライバおよびその API（NI-DAQmx、
NI-SWITCH、および従来型 NI-DAQ（レガシー））を含みます。ドライバ
のいずれかまたはすべてのドライバをインストールするかどうかは、使用

するデバイスによって決まります。どのドライバがシステム中のデバイス

をサポートするかについては、この文書の最後にある「NI-DAQ 7.4のサ
ポート」セクションを参照してください。

NIスイッチモジュールのプログラムを作成するには、NI-SWITCHまたは
NI-DAQmxを使用できます。 

サポートファイルをインストールする
以下の例に示すとおり、NI-DAQ 7.xインストーラはシステムにインス
トールされている NIソフトウェアを検出し、最新のドライバ、アプリ
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ケーションソフトウェア、および言語サポートファイルを CDから自動
的にインストールします。

 

1. インストーラが正しいサポートファイル、およびアプリケーションソ

フトウェアや言語の正しいバージョンを検出して選択したかどうかを

確認します。

NIアプリケーションソフトウェア 7.xをインストールする前に
NI-DAQ 7.xをインストールする場合、NI-DAQ 7.xインストーラを再
度実行して正しいアプリケーションソフトウェアサポートをインス

トールする必要があります。

2. 次へをクリックします。

3. 終了をクリックします。

4. インストールが完了したら、再起動、シャットダウン、または終了す

るかどうかを尋ねるメッセージが表示されます。

� 再起動―LabVIEW Real-Timeモジュールを実行しているシステ
ムを使用している場合、システムを再起動します。

Measurement & Automation Explorer（MAX）を使用して、
ターゲットに NI-DAQ 7.xをダウンロードします。ヘルプ→ヘル
プトピック→リモートシステムを選択し、『Measurement & 
Automation Explorer リモートシステムヘルプ』を参照してく
ださい。

� 終了―複数の NIソフトウェアをインストールする場合は、一度
終了してからインストール作業を行います。PCから PXIシャー
シを制御するためにMXI-3を使用している場合は、DAQデバイ
スを使用する前に終了し、ni.com/jp/downloadsから入手で

きるMXI-3ソフトウェアをインストールしてください。

� シャットダウン―デバイスをインストールする準備ができたら、

シャットダウンします。
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手順 3. デバイス、アクセサリ、およびケーブルの梱包
を解く

デバイスは、静電気によるデバイスおよびコンポーネントへの損傷

（ESD、静電破壊）を防ぐため、静電防止の梱包で出荷されます。

注意 露出しているコネクタピンには絶対に触れないでください。

このような損傷を回避するには、以下の予防措置を講じてください。

� 接地ストラップを使用したり、接地された物体に触れたりして、身体

を接地する。

� 静電防止の梱包をシャーシの金属部分に接触させてから、デバイスを

梱包箱から取り出す。

デバイスを箱から取り出し、部品がゆるんでいないかどうか、また、損傷

箇所がないかどうか調べてください。デバイスが損傷している場合は、ナ

ショナルインスツルメンツまでご連絡ください。損傷したデバイスをイン

ストールしないでください。

デバイスを使用しないときは、静電防止の梱包に保管してください。

保安と準拠については、デバイスのマニュアルの「手順 9. デバイスの文
書を参照またはインストールする」を参照してください。

手順 4. デバイス、アクセサリ、およびケーブルの梱包
をインストールする

複数の DAQデバイスをインストールする場合には、それらのデバイスを
すべてここでインストールしてください。DAQデバイスに接続する
SCXIモジュールがシステムに含まれる場合、この文書を参照して DAQ
コンポーネントを先にインストールします。「手順 10. 信号調節またはス
イッチデバイスをインストールする」セクションに SCXIモジュールをイ
ンストールする方法が記載されています。

ハードウェアをインストールせずに NI-DAQmxアプリケーションをテス
トするには、NI-DAQmxシミュレーションデバイスを使用することがで
きます。NI-DAQmxシミュレーションデバイスを作成して NI-DAQmx
シミュレーションデバイス構成を物理デバイスにインポートする手順につ

いては、「手順 6. MAXを起動する」へ進み、ヘルプ→ヘルプトピック→
NI-DAQmxを選択して、『NI-DAQmx対応Measurement & 
Automation Explorerヘルプ』を参照してください。 

注意 適切な静電破壊防止対策により身体が接地されていることを必ず確認してから、

ハードウェアを取り付けてください。保安と準拠に関する情報については、デ

バイスの仕様書を参照してください。
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PCIデバイス
PCIデバイスをインストールするには、以下の手順に従ってください。

1. コンピュータの電源を切り、コードを抜いてください。

2. コンピュータおよび /または拡張スロットのカバーを外します。

3. 静電気を放電するため、コンピュータの金属部分に接触します。

4. PCIシステムスロットにデバイスを挿入します。そっと揺り動かしな
がら、デバイスをスロットに差し込みます。デバイスをスロットへ無

理に押し込まないでください。
 

図 2 PCIデバイスのインストール

5. デバイスの取り付け金具をコンピュータのバックパネルレールに取り

付けます。

6. 該当する場合、コンピュータのカバーを元の位置に戻します。

PXIデバイス
PXIモジュールをインストールするには、以下の手順に従ってください。

1. PXIシャーシの電源を切り、コードを抜いてください。

注意 機材のカバーの取り外し、または信号配線の接続または接続解除する前に、PXI
シャーシまたはデバイスと一緒に梱包されている『Read Me First: Safety and 
Radio-Frequency Interference』ドキュメントを参照してください。

2. 未使用の PXIスロットのカバーパネルを外します。スロットの要件に
ついては、「手順 9. デバイスの文書を参照またはインストールする」
に記述されているデバイスのドキュメントを参照してください。

3. 静電気を放電するため、シャーシの金属部分に触れます。

1 PCI DAQデバイス 2 PCIシステムスロット 3 PCIスロットがある PC

1 2

3
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4. PXIモジュールの脱着ハンドルが固定されないで自由に揺れ動く状態
にします。

5. PXIモジュールの縁をシャーシの上下にあるモジュールガイドに配置
します。

6. デバイスをシャーシ後部に接続するように、PXIスロットにデバイス
を差し込みます。

7. 抵抗を感じたら、完全にデバイスを挿入するように脱着ハンドルを引

き上げます。

8. シャーシのフロントパネル取り付けレールに、デバイスのフロントパ

ネルをネジで取り付けます。
 

図 3 PXIデバイスのインストール

PCMCIAデバイス
NI PCMCIAデバイスは、Type IIの PCカードの空きスロットにインス
トールすることができます。PCMCIAデバイスをインストールするには、
以下の手順に従ってください。

1. コンピュータの PCMCIAスロットカバーを外します（該当する
場合）。

2. コネクタがしっかりと接続されるまで、PCMCIAデバイスの
PCMCIAバスコネクタをスロットに挿入します。

3. I/Oケーブルを取り付けます。ケーブルコネクタの挿入や取り外しで
は、I/Oケーブルに負担をかけないように注意してください。常に、
挿入または取り外しを行うケーブルのコネクタ部分をしっかりとつか

1 PXIシャーシ
2 PXIシステムコントローラ
3 PXIモジュール
4 脱着ハンドル

5 フロントパネル取り付けネジ

6 モジュールガイド

7 電源スイッチ

3

1

2

4

PXI-1000B

7

5

6
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んでください。PCMCIAデバイスから I/Oケーブルを絶対に直接引
き抜かないでください。

図 4 PCMCIAデバイスのインストール

USB/IEEE 1394デバイス
USBまたは IEEE 1394用の NIデバイスをインストールするには、以下の
手順に従ってください。

1. 電源を接続します。

� BP-1バッテリーパックを使用している場合は、BP-1のインス
トールガイドにあるインストール手順に従ってください。

� USBまたは IEEE 1394用の NIデバイスの中には外部電源が必要
なデバイスもあります。

� デバイスに外部電源がある場合、外部電源の電圧（該当

する場合）がユーザがデバイスを使用する場所の電圧

（120/230 VAC）とデバイスに必要な電圧に一致するかどう
かを確認してください。電源の片方をコンセントに接続し、

もう片方をデバイスに取り付けます。

� デバイスに電源コードがある場合は、電源コードの片方をデ

バイスに接続し、もう片方をコンセントに接続します。

1 PCMCIAスロットがあるコンピュータ
2 PCMCIAソケット
3 PCMCIAデバイス

4 シールドされた I/Oケーブル
5 アクセサリ

6 信号線

®

®

1

2

4

5
6

DAQCard

3
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2. コンピュータの USBまたは IEEE 1394ポート、その他のハブ、
IEEE 1394デバイス上の使用可能な USBまたは IEEE 1394ポートに
ケーブルを接続します。 

3. USBまたは IEEE 1394デバイスに電源スイッチがある場合、デバイス
の電源を入れます。コンピュータがデバイスを即座に検出します。

アクセサリ
インストールガイドの手順に従って、アクセサリやターミナルブロックを

取り付けます。SCXIおよび SCC信号調節システムについては、「手順
10. 信号調節またはスイッチデバイスをインストールする」セクションま
で、この文書の手順に従ってください。

手順 5. コンピュータまたは PXIシャーシに電源を入
れる

Windowsは、ハードウェアのインストール後に初めてコンピュータが再
起動されたときに、新しくインストールされたデバイスを認識します。一

部のWindowsシステムでは、インストールされたすべての NIデバイス
に対して、新しいハードウェアの検索ウィザードが起動します。デフォル

トにより、デバイスに最適なドライバを検索する（推奨）が選択されま

す。Windowsがデバイスを認識するように、次へまたははいをクリック
して各デバイスのソフトウェアをインストールします。

コンピュータが USBや IEEE 1394デバイスを認識すると、デバイスにあ
る電源の LEDが点滅または点灯します。また、IEEE 1394用 NIデバイス
には、デバイスが検出されると点滅する COM LEDがあります。特定の
デバイスの LEDの点灯点滅パターンの説明については、デバイスの文書
の「手順 9. デバイスの文書を参照またはインストールする」を参照して
ください。 

手順 6. MAXを起動する
デスクトップにあるMeasurement & Automationアイコンをダブルク
リックして、MAXを開きます。

手順 7. デバイスが認識されたことを確認する
次の手順に従ってください。

1. デバイスとインタフェースを展開します。リモート RTターゲットを
使用する場合、リモートシステムを展開し、ターゲットを検索して展

開して、デバイスとインタフェースを展開します。

2. デバイスとインタフェースの下に表示されるデバイスを確認します。 
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デバイスが表示されない場合には、<F5>キーを押してMAXの表示
を更新します。デバイスがまだ認識されない場合は、ni.com/

support/ja/troubleのトラブルシューティングを参照してくだ

さい。

3. デバイスのプログラムに使用する NI-DAQ APIのフォルダの下で、
テストするデバイスを右クリックします。 

� デバイスが NI-DAQmxに表示される場合は、セルフテストを選
択します。

 

セルフテスト中にヘルプの参照が必要な場合、ヘルプ→ヘルプト
ピック→ NI-DAQmxを選択して『NI-DAQmx対応MAXヘル
プ』を開きます。 

� デバイスが従来型 NI-DAQ（レガシー）に表示される場合、プロ
パティを選択して、プロパティウィンドウに表示されるリソース

確認をクリックします。

1 NI-DAQmxと従来型 NI-DAQ（レガシー）の両方でデバイスがサポートされていて、そ
の両方ともがインストールされている場合、マイシステム→デバイスとインタフェース
の NI-DAQmxと従来型 NI-DAQ（レガシー）フォルダの下に同じデバイスが異なる名前
で表示されます。 

2 リモートシステム→デバイスとインタフェースの下には NI-DAQmxデバイスのみが表示
されます。 

1

2
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4. セルフテストが終了すると、テストが成功した確認またはエラーが発

生したかどうかを示すメッセージが表示されます。エラーが発生した

場合、トラブルシューティングに関する情報については、ni.com/

support/install（英語）を参照してください。

手順 8. デバイス設定を構成する
インストールする各デバイスを構成します。

1. デバイス名を右クリックしてプロパティを選択します。デバイスを制

御する NI-DAQ APIフォルダの下のデバイス名を必ずクリックしてく
ださい。リモート RTターゲットを使用している場合、NI-DAQmxデ
バイスはリモートシステム→デバイスとインタフェースの下に表示さ

れます。

2. デバイスプロパティを構成します。NI-DAQmxと従来型 NI-DAQ
（レガシー）の両方でデバイスを使用するには、それぞれの APIでデ
バイスのプロパティを構成する必要があります。

� アクセサリを使用している場合、アクセサリについての情報を追

加します。

� 従来型 NI-DAQ（レガシー）でデバイスを使用している場合、
MAXでヘルプを選択して『従来型 NI-DAQ対応
Measurement & Automation Explorerヘルプ』を参照してく
ださい。

� IEEE 1451.4 トランスデューサ電子データシート（TEDS）センサ
およびアクセサリについては、上記の方法でデバイスを構成して

アクセサリを追加します。TEDSをスキャンをクリックします。
MAXでデバイスに直接接続された TEDSセンサを構成するには、
デバイスとインタフェースの下にあるデバイスを右クリックし

て、TEDSを構成を選択します。

3. OKをクリックして変更を承諾します。

従来型 NI-DAQ（レガシー）仮想チャンネル、スケール構成、および
SCXIとアクセサリ構成を NI-DAQmx構成に変換するには、ツール→
NI-DAQmx構成→構成を従来型 NI-DAQ（レガシー）から NI-DAQmx
に変換を選択します。ウィザードが SCC構成を変換しない場合、使用す
る各 APIに SCC情報を構成する必要があります。構成を変換する詳細に
ついては、ウィザードのヘルプをクリックしてください。

手順 9. デバイスの文書を参照またはインストールする
NI-DAQ 7.xソフトウェアキットには、サポートされているデバイスおよ
びアクセサリのオンライン文書（デバイスの端子、仕様、機能、および操

作を説明した PDFおよびヘルプファイル等）が含まれます。各デバイス
の文書を検索、表示、そして印刷するには、Device Documentation 
CDを挿入します。ヘルプシステムおよび Device Document Browser
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を含む NI-DAQ 7.xの文書の機能には、Internet Explorer 5.0以降のバー
ジョンのインストールが必要なものもあります。インストール後、ブラウ

ザおよびデバイスの文書はスタート→プログラム→ National 
Instruments→ NI-DAQ→ Browse Device Documentationから表示
できます。 

この CDをお持ちでない場合、デバイスのオンライン文書は ni.com/

manuals（英語）から入手できます。Device Document Browserは、
ni.com/support（英語）から、Drivers and Updates→Most 
Popularを選択し、表示されたページでご使用の NI-DAQのバージョン
を選択して、インストール説明のウェブページを開きます。NI-DAQ CD 
2をダウンロードして NI-DAQ Device Documentation Browserをイ
ンストールする説明に従ってください。

手順 10. 信号調節またはスイッチデバイスをインストー
ルする

信号調節またはスイッチモジュールなど、システムに追加デバイスが含ま

れる場合は、以下の文書を参照して信号調節やスイッチのハードウェアを

インストールおよび構成してください。

� SCXI信号調節モジュール、および SCキャリアと SCCモジュール
などの信号調節コンポーネント（SCC）―製品のクイックスタート
ガイドを参照。

� スイッチモジュール―『NI Switches Getting Started Guide』
を参照。

このガイドの残りの部分は DAQまたは PXI信号調節実装デバイスのみに
適用されます。

手順 11. センサと信号線を取り付ける
センサと信号線をターミナルブロックまたはアクセサリ端子に配線しま

す。その際に役に立つ情報を記載します。 

� 信号および端子の接続 :

� DAQアシスタントを介して、システム中の NI-DAQmxタスク
および仮想チャンネルの接続ダイアグラムを表示して印刷できま

す。タスクまたは仮想チャンネルを選択して接続ダイアグラムタ

ブをクリックします。センサからコネクタブロックへの必要な接

続の端子の名前と数を表示するには、タスク中の各仮想チャンネ

ルを選択します。 

� 『M Series Help』、『E Series Help』、デバイスのユーザマニュア
ル、およびアクセサリガイドは、Device Document Browser
から参照することができます。
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� ピンの並び順については、MAXのヘルプメニューから表示でき
る『NI-DAQmx対応Measurement & Automation Explorer
ヘルプ』および『従来型 NI-DAQ対応Measurement & 
Automation Explorerヘルプ』のデバイス端子というトピック
に記載されています。

� センサ :

� ni.com/sensors（英語）を参照してください。

� LabVIEWを使用する場合は、LabVIEWに同梱されている
『LabVIEW Measurements Manual』または ni.com/

jp/manualsを参照してください。 

� NI-DAQmxを使用する場合には、スタート→プログラム→
National Instruments→ NI-DAQ→ NI-DAQmx Helpから表
示できる『NI-DAQmx Help』の「Sensors」のトピックを参照
してください。 

� IEEE 1451.4 TEDSスマートセンサの情報については、ni.com/

zone（英語）を参照してください。 

� スイッチ―スイッチの仕様にはデバイスのトポロジーが含まれてい

ます。

手順 12. テストパネルを実行する
多くのデバイスには、信号の集録や生成などの特定のデバイス機能をテス

トするためのテストパネルがあります。 

1. MAXでデバイスとインタフェース→ NI-DAQmxデバイス、または
デバイスとインタフェース→従来型 NI-DAQ（レガシー）デバイスを
展開します。リモート RTターゲットを使用している場合、リモート
システムを選択し、ターゲットを検索して展開し、デバイスとインタ

フェースを展開します。

2. テストするには、デバイスを右クリックします。デバイスを使用する

NI-DAQ APIフォルダの下にあるデバイス名をクリックしてくだ
さい。

3. 選択されたデバイスのテストパネルを開くには、テストパネルを選択

します。従来型 NI-DAQ（レガシー）には LabVIEW Real-Time
モジュールのテストパネルはありません。
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テストパネルの例を以下の図に示します。

4. デバイスのさまざまな機能をテストするには、タブをクリックしま

す。NI-DAQmxでのテストパネルの操作については、ヘルプを参照
してください。従来型 NI-DAQ（レガシー）のテストパネルの操作に
ついては、『従来型 NI-DAQ対応Measurement & Automation 
Explorerヘルプ』を参照してください。

5. テストパネルには、エラーが発生したかどうかを示すメッセージが表

示されます。その場合、トラブルシューティングについては、

『NI-DAQmxヘルプ』または ni.com/support/jaを参照してくだ

さい。 

6. テストパネルを終了するには、閉じるをクリックします。
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手順 13. 追加の新規デバイスを構成する
複数の DAQデバイスをインストールする場合、各デバイスごとに手順
「手順 8. デバイス設定を構成する」～「手順 12. テストパネルを実行す
る」を繰り返します。 

手順 14. チャンネルとタスクを構成する
この手順は、NI-DAQまたは NIアプリケーションソフトウェアを使用し
てデバイスをプログラムする場合のみに適用されます。 

物理チャンネルとは、アナログ /デジタル信号を計測または生成できる端
子またはピンのことです。これに対して、仮想チャンネルとは、名前、物

理チャンネル、入力端子接続、計測または生成のタイプ、およびスケール

情報を含む設定を集めたものです。NI-DAQmxでは、仮想チャンネルは
すべての計測に不可欠です。NI-DAQmxでは、MAXから起動できる
DAQアシスタントまたは NIアプリケーションソフトウェアを使用して、
仮想チャンネルと計測タスクを構成します。『DAQアシスタントヘルプ』
と『NI-DAQmx対応Measurement & Automation Explorerヘルプ』
を参照してください。また、アプリケーションプログラムで、

NI-DAQmx APIを使用して仮想チャンネルを構成することもできます。
従来型 NI-DAQ（レガシー）とそれ以前のバージョンでは、MAXで仮想
チャンネルを構成することができます。これは、どの物理チャンネルがど

の計測に使用されるかを登録するオプション機能です。 

タスクとは、NI-DAQmxの重要な概念で、タイミング、トリガ、その他
のプロパティを備えた単一または複数の仮想チャンネルを集めたもので

す。概念としては、タスクは実行する計測または生成を意味しています。

タスク内の構成情報はすべて設定または保存して、アプリケーションで使

用することができます。

NI-DAQmxでは、仮想チャンネルをタスクの一部として、またはタスク
から切り離して構成できます。タスク内に作成された仮想チャンネルは、

ローカル仮想チャンネルです。タスク外に定義された仮想チャンネルは、

グローバル仮想チャンネルです。グローバル仮想チャンネルはMAX内あ
るいはアプリケーションソフトウェア内で作成して、MAXに保存するこ
とができます。また、どのアプリケーションでもグローバル仮想チャンネ

ルを使用することができるだけでなく、さまざまなタスクにそれらを追加

することもできます。グローバル仮想チャンネルを変更した場合は、その

変更がそのグローバル仮想チャンネルに関連するすべてのタスクに影響を

及ぼします。 

NI-DAQmxでタスクを構成する
NI-DAQmxを使用する場合、DAQアシスタントでタスクを構成します。
DAQアシスタントでタスクおよび仮想チャンネルを作成するには、NIア
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プリケーションソフトウェアパッケージの 7.0以降のバージョンを使用す
る必要があります。

� MAXでデータ設定を右クリックして、新規作成を選択します。新規
作成ウィンドウで NI-DAQmxタスクを選択して、次へをクリックし
ます。

リモート RTターゲットを使用している場合、リモートシステムを展
開し、ターゲットを検索して展開して、データ設定を右クリックして

新規作成を選択します。

� また、NIアプリケーションソフトウェアの中から直接 DAQアシス
タントを開くこともできます。

� LabVIEWの場合 :

� 『LabVIEW入門』の説明に従って、Express入力パレット
から「DAQアシスタント（DAQ Assistant）」Express VI
をブロックダイアグラムに配置します。 

� フロントパネルで DAQmx名前制御器パレットから
DAQmxタスク名制御器を配置して、「DAQアシスタント」
を開くこともできます。制御器を右クリックして、新規タス

ク（DAQアシスタント）を選択します。『LabVIEWにおけ
る NI-DAQmx計測』には、DAQmxタスク名制御器からタ
スクを作成する方法およびタスクに基づいたコードを生成す

る方法が段階的に説明してあります。LabVIEWでヘルプ→
LabVIEWにおける NI-DAQmx計測を選択します。

� LabWindows/CVIの場合 :

1. Tools→ Create/Edit DAQmx Tasksを選択します。
Create/Edit DAQmx Tasksダイアログボックスが開き
ます。 

2. Create New Task in MAXまたは Create New Task in 
Projectを選択し、OKをクリックします。

� Measurement Studioの場合 :

1. Visual Studio .NETを開き、DAQmxタスクのクラスを作成
するプロジェクトを開きます。

2. Project→ Add New Itemを選択します。Add New Item
ダイアログボックスが開きます。 

3. Categoriesぺーンで、Measurement Studio→
Assistantsを選択します。

4. Templatesぺーンで DAQmx Task Classを選択します。
5. DAQmxタスクファイルの名前を指定して、Openをク

リックします。 
6. 新規タスクまたはMAXで作成したグローバルタスクのプロ
ジェクトコピーを作成するかどうかを指定します。

7. Finishをクリックします。
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DAQアシスタントで、新規タスクを作成するプロンプトが表示され
ます。

1. アナログ入力などの I/Oタイプを選択します。

2. 実行する計測または生成を選択します。

3. 使用するセンサを選択します（その計測に該当する場合）。

4. タスクのローカル仮想チャンネルを作成する物理チャンネルを選択し

ます。あるいは、既存グローバル仮想チャンネルをタスクに追加する

か、または既存グローバル仮想チャンネルからローカル仮想チャンネ

ルに情報をコピーすることもできます。 

TEDSセンサと一緒にシステムが構成されている場合、TEDSチャン
ネルタブをクリックします。物理チャンネルを選択します。DAQ
アシスタントがセンサから設定をインポートして、タスクを作成し

ます。 
次へをクリックします。

5. MAXから DAQアシスタントを起動した場合には、新規タスク名を
入力します。終了をクリックします。

6. 必要に応じて、その計測に適した設定、タイミング、トリガ、および

スケールを設定します。1つあるいは複数のチャンネルが TEDSセン
サ用に構成されている場合、TEDSからロードされる一部の設定は編
集可能ではありません。
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7. 追加の仮想チャンネルをタスクに追加することができます。タスクに

追加された仮想チャンネルは同じ計測タイプになるか、または温度仮

想チャンネルを電圧タスクに追加するように、異なる計測タイプにな

ります。追加ボタン（ ）をクリックして仮想チャンネルを追加し

ます。 

a. 追加する計測タイプをドロップダウンリストから選択します。

b. タスクのローカル仮想チャンネルを作成する物理チャンネルを選
択します。あるいは、既存グローバル仮想チャンネルをタスクに

追加するか、または既存グローバル仮想チャンネルからローカル

仮想チャンネルに情報をコピーすることもできます。 

c. OKをクリックします。

8. タスクを保存します。

� LabVIEWまたは LabWindows/CVIから DAQアシスタントを
開いた場合は、OKをクリックします。 

� Measurement Studioから DAQアシスタントを開いた場合は、
File→ Saveを選択します。 

� MAXから DAQアシスタントを開いた場合は、タスクを保存を
クリックします。 

これで、アプリケーションからタスクを使用することができます。DAQ
アシスタントでは、仮想チャンネルの編集や名前を変更することもでき

ます。

NI-DAQmxのグローバル仮想チャンネルを構成する
NI-DAQmxを使用する場合、DAQアシスタントでグローバル仮想チャ
ンネルを構成します。グローバル仮想チャンネルを作成するにはMAXを
使用する必要がありますが、グローバル仮想チャンネルの追加はアプリ

ケーションソフトウェアから行うことができます。 

� MAXで DAQアシスタントを開くには、データ設定を右クリックし
て、新規作成を選択します。 
リモート RTターゲットを使用している場合、リモートシステムを展
開し、ターゲットを検索して展開して、データ設定を右クリックして

新規作成を選択します。

新規作成ウィンドウで NI-DAQmxグローバルチャンネルを選択し
て、次へをクリックします。

� また、NIアプリケーションソフトウェアの中から直接 DAQアシス
タントを開くこともできます。 

� LabVIEWでは、DAQmxグローバルチャンネル制御器を使用し
て DAQアシスタントを開いてください。制御器を右クリックし
て、新規チャンネル（DAQアシスタント）を選択します。

� LabWindows/CVIまたはMeasurement Studioでは、前述の
ように最初にタスクを作成する必要があります。DAQアシスタ
ントでは、追加ボタン（ ）をクリックし、タスクにチャンネ



© National Instruments Corporation 129 DAQクイックスタートガイド

ルを追加ダイアログボックスでグローバルタブからグローバル仮

想チャンネルを選択します。 

DAQアシスタントでは、新規グローバル仮想チャンネルを作成するプロ
ンプトが表示されます。

1. アナログ入力などの I/Oタイプを選択します。 

2. 実行する計測または生成を選択します。 

3. 使用するセンサを選択します（その計測に該当する場合）。 

4. グローバル仮想チャンネルを作成する物理チャンネルを選択します。

あるいは、既存のグローバル仮想チャンネルから情報をコピーするこ

ともできます。

TEDSセンサと一緒にシステムが構成されている場合、TEDSチャン
ネルタブをクリックします。物理チャンネルを選択します。DAQア
シスタントでは、センサから設定がインポートされます。1つあるい
は複数の物理チャンネルが TEDSセンサ用に構成されている場合、
TEDSからロードされる一部の設定は編集可能ではありません。次へ
をクリックします。

5. 新規のグローバル仮想チャンネル名を入力します。終了をクリックし

ます。

6. 必要に応じて、その計測に適した設定およびスケールを設定します。 

7. 構成を保存します。

これで、アプリケーションでのグローバル仮想チャンネルの使用およびグ

ローバル仮想チャンネルのタスクへの追加ができるようになりました。

従来型 NI-DAQ（レガシー）で仮想チャンネルを構成する
従来型 NI-DAQ（レガシー）を使用する場合、MAXで仮想チャンネルを
構成するには、以下の手順に従ってください。

1. 新規チャンネルを作成ウィザードを開きます。 

� MAXでデータ設定を右クリックして、新規作成を選択します。
新規作成ウィンドウで従来型 NI-DAQ仮想チャンネルを選択し
て、終了をクリックします。 

� 従来型 NI-DAQ（レガシー）をリモート RTターゲットで使用し
ている場合は、ツール→従来型 NI-DAQ構成→リモート DAQ
構成を選択します。リモートシステム中の従来型 NI-DAQ（レガ
シー）デバイスがリモート DAQ構成ウィンドウに表示されま
す。チャンネルを選択して、追加をクリックします。
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2. 新規チャンネルを作成ウィザードの説明に従って、新しいチャンネル

を作成します。チャンネル構成の詳細については、『従来型 NI-DAQ
対応Measurement & Automation Explorerヘルプ』を参照してく
ださい。

手順 15. アプリケーションでタスクを使用する
使用しているアプリケーションで計測タスクを使用するには、以下の手順

に従ってください。タスクやコード生成についての詳細は、『DAQアシ
スタントヘルプ』を参照するか、アプリケーションソフトウェアのマニュ

アルを参照してください。

ハードウェアをインストールせずにサンプルを実行するには、

NI-DAQmxシミュレーションデバイスを使用できます。NI-DAQmxシ
ミュレーションデバイスを作成して NI-DAQmxシミュレーションデバイ
ス構成を物理デバイスにインポートする手順については、MAX
でヘルプ→ヘルプトピック→ NI-DAQmxを選択して、『NI-DAQmx対応
Measurement & Automation Explorerヘルプ』を参照してください。 

LabVIEW
1. LabVIEWでブランク VIを開きます。 

2. NI Measurement→ DAQmx-データ集録→ DAQmxタスク名定数
をブロックダイアグラムに配置します。

3. タスクをプルダウンメニューから選択します。 

4. VIを右クリックしてコードを生成→サンプルを選択します。 

5. フロントパネルからプログラムを実行します。
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LabWindows/CVI
LabWindows/CVIでタスクを使用する方法については、ni.com/info

（英語）で rddq73と入力して表示される情報を参照してください。

Measurement Studio
Measurement Studioでタスクを使用する手順については、ni.com/

infoで rddqmsと入力して表示される情報を参照してください。

アプリケーション開発を開始する

サンプルを使用する
各 APIにはプログラミングサンプルのコレクションが含まれており、ア
プリケーション開発を手がける際に役立ちます。サンプルのコードは、変

更したり、アプリケーションに保存したりすることができます。サンプル

を使用して、新しいアプリケーションを開発したり、サンプルのコードを

既存のアプリケーションに加えたりすることができます。

ハードウェアをインストールせずにサンプルを実行するには、

NI-DAQmxシミュレーションデバイスを使用できます。シミュレーショ
ンデバイスの詳細については、MAXでヘルプ→ヘルプトピック→
NI-DAQmxを選択して、『NI-DAQmx対応Measurement & 
Automation Explorerヘルプ』を参照してください。 

LabVIEWおよび LabWindows/CVIのサンプルを検出するには、
ヘルプ→サンプルを検索を選択して NIサンプルファインダを開きます。

Measurement Studioでサポートされる言語（Visual Basic .NET、C#、
およびMFC C++）の NI-DAQmxのサンプルは、以下のディレクトリに
あります。

� Measurement Studio MFC C++のサンプル―
MeasurementStudioVS2003¥VCNET¥Examples¥DAQmx 

� Visual C#および Visual Basic .NETのサンプル（Measurement 
Studioは不要）―MeasurementStudioVS2003¥DotNET¥
Examples¥DAQmx

ANSI C用 NI-DAQmxサンプルは、NI-DAQ¥Examples¥DAQmx ANSI C

ディレクトリにあります。

Visual Basic用の従来型 NI-DAQ（レガシー）サンプルは、以下のディ
レクトリにあります。

� NI-DAQ¥Examples¥Visual Basic with Measurement Studio

ディレクトリには、従来型 DAQ CWDAQ ActiveXコントロールの
サンプルへのリンクがあります。Measurement Studioがない場合



DAQクイックスタートガイド 132 ni.com/jp

は、これらのサンプルは評価版の ActiveXユーザインタフェースを
使用します。  

� NI-DAQ¥Examples¥VBasicディレクトリには、Measurement 
Studioに関連しないサンプルがあります。

ANSI C用従来型 NI-DAQ（レガシー）サンプルは、NI-DAQ¥Examples¥

VisualCディレクトリにあります。

その他数多くのサンプルについては、ni.com/zone（英語）を参照して

ください。

計測アプリケーションとデバイスの情報
計測アプリケーションおよびデバイスについての情報は以下の場所から選

択できます。

LabVIEW
はじめてご使用になる場合には、『LabVIEW入門』で LabVIEWの基本
操作を確認してください。スタート→プログラム→ National 
Instruments→ LabVIEW 7.x→ LabVIEWドキュメントライブラリを検
索を選択します。

『LabVIEW Measurements Manual』には、NI-DAQmxおよび従来型
NI-DAQ（レガシー）の APIの概要が記載されていて、計測の概念も説明
されています。スタート→プログラム→ National Instruments→
LabVIEW 7.x→ LabVIEWドキュメントライブラリを検索を選択します。

『LabVIEWにおける NI-DAQmx計測』では、LabVIEWでの計測をセッ
トアップする方法が段階ごとに説明されています。また、重要な新しい特

徴や概念も説明されています。LabVIEWでヘルプ→ LabVIEWにおける
NI-DAQmx計測を選択します。

『LabVIEWヘルプ』には、「VIおよび関数のリファレンス」セクションに
NI-DAQmxおよび従来型 NI-DAQ（レガシー）の LabVIEW VIおよびプ
ロパティについての説明があります。LabVIEWでヘルプ→オンラインヘ
ルプリファレンスを選択して、目次タブで「VIおよび関数のリファレン
ス」を開き、ご使用の NI-DAQ API用の VIリファレンスのヘルプセク
ションを検索します。

LabVIEW Real-Timeモジュール
LabVIEW Real-Timeモジュールのドキュメントのリンクについては、
スタート→プログラム→ National Instruments→ LabVIEW 7.x→
Module Documents→ LabVIEW Real-Time モジュールライブラリを
検索するを選択します。 
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LabWindows/CVI
はじめてご使用になる場合には、『Getting Started with 
LabWindows/CVI』で LabWindows/CVIの基本操作を確認してくださ
い。LabWindows/CVIで Help→ LabWindows/CVI Bookshelfを選
択します。 

『LabWindows/CVI Help』には、NI-DAQmx計測の概念および関数リ
ファレンスが説明されています。LabWindows/CVIで Help→
Contentsを選択します。

Measurement Studio
『NI Measurement Studio Help』には、NI-DAQmx計測の概念および
関数リファレンスが説明されています。このヘルプファイルは Visual 
Studio .NETのマニュアルに統合されています。Visual Studio .NETで
Measurement Studio→ NI Measurement Studio Helpを選択します。

ANSI C―NIアプリケーションソフトウェア不
使用
『Traditional NI-DAQ User Manual』および『NI-DAQmx Help』は API
の概念について説明しています。『NI-DAQmxヘルプ』にも、計測の概念
についての一般情報が含まれています。『Traditional NI-DAQ C 
Reference Help』および『NI-DAQmx C Reference Help』には、C
関数と属性についての説明が記載されています。スタート→プログラム→

National Instruments→ NI-DAQから、使用している NI-DAQ APIのマ
ニュアルのタイトルを選択します。

.NET言語―NIアプリケーションソフトウェア不
使用
『NI Measurement Studio Help』には、NI-DAQmx計測の概念および
関数リファレンスが説明されています。このヘルプファイルは Visual 
Studio .NETのマニュアルに統合されています。Visual Studio .NETで
Help→ Contentsを選択します。NI-DAQmx .NET Libraryのヘルプを表
示するには、NI Measurement Studio Help→ NI Measurement 
Studio .NET Class Library→ Reference→ National 
Instruments.DAQmxを選択します。タスクと概念については、
NI Measurement Studio Class .NET Library→ Using the 
Measurement Studio .NET Class Libraries→ Using the 
Measurement Studio NI-DAQmx .NET Libraryを選択します。 

メモ Visual Studio .NETを使用せずに .NET言語を使用すると、『NI Measurement 
Studio Help』を表示できない可能性があります。



DAQクイックスタートガイド 134 ni.com/jp

デバイスのドキュメント
NI-DAQ 7.xには、サポートされているデバイスおよびアクセサリのオン
ライン文書（デバイスの端子、仕様、機能、および操作を説明した PDF
およびヘルプファイル等）が含まれます。各デバイスの文書を検索、表

示、そして印刷するには、NI-DAQ Device Documentation CDを挿入
します。Device Document Browserをインストール後、デバイスの文
書はスタート→プログラム→ National Instruments→ NI-DAQ→
Browse Device Documentationから表示できます。

NI-DAQmxと従来型NI-DAQ（レガシー）を同じコンピュータで
使用する

NI-DAQの旧バージョンで開発された既存のアプリケーションは従来型
NI-DAQ（レガシー）で動作します。従来型 NI-DAQ（レガシー）APIお
よび NI-DAQmx APIの同じコンピュータでの使用については、以下の制
約があります。

� 一度に 1つの APIしかデバイスを制御できません。

� NI-DAQmxでデバイスを使用後、従来型 NI-DAQ（レガシー）
でデバイスを使用する前に、そのデバイスを使用しているすべて

の NI-DAQmxのタスクを解除する必要があります。デバイスを
NI-DAQmxで使用した後で、NI-DAQmxのタスクを予約解除せ
ずに従来型 NI-DAQ（レガシー）で使用すると、エラーコード
-10461が返されます。NI-DAQmxタスクを解除するには、
DAQmxタスクをクリア VIまたは関数を呼び出します。 

� 従来型 NI-DAQ（レガシー）でデバイスを使用した後は、
NI-DAQmxでそのデバイスを使用する前にデバイスをリセット
する必要があります。デバイスをリセットしないと、エラーコー

ド -200324が返されます。

SCXIデバイスでは、通信中の DAQデバイスは NI-DAQmxで使
用する前に従来型 NI-DAQ（レガシー）でリセットする必要があ
ります。たとえば、Eシリーズ DAQデバイスではポート 0のラ
イン 0、1、2、および 4を使用して SCXIモジュールと通信しま
す。以下のとおり、NI-DAQmxで使用する前に従来型 NI-DAQ
（レガシー）で通信中のデバイスをリセットしないと、エラー

コード -200158が返されます。

� 従来型 NI-DAQ（レガシー）のデバイスリセット VIまたは
Init_DA_Brds関数を呼び出します。

� MAXから従来型 NI-DAQ（レガシー）でデバイスをリセッ
トするには、すべてのデバイスを同時にリセットする必要が

あります。MAXの従来型 NI-DAQ デバイスフォルダを右ク
リックして、従来型 NI-DAQ用にドライバをリセットを選
択します。リモート RTターゲットについては、従来型
NI-DAQ（レガシー）のデバイスリセット VIを使用する必
要があります。
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� 1つの SCXIデータ集録システムのすべてのデバイス（接続された
DAQデバイスおよび挿入された SCXIモジュール）をプログラムす
るには、同じ APIを使用する必要があります。

以下のトピックの詳細と説明については、ni.com/support（英語）を参

照してください。

� 従来型 NI-DAQ（レガシー）アプリケーションに NI-DAQmxコード
を追加する方法

� 同じデバイスを使用する、従来型 NI-DAQ（レガシー）アプリケー
ションおよび NI-DAQmxアプリケーションの両方を実行する方法

トラブルシューティング

DAQハードウェアおよび /またはソフトウェアのインストールで問題が
ある場合、以下のリソースを参照してください。

� トラブルシューティングの説明については、ni.com/support/ja/

troubleshooting.htmのトラブルシューティングリソースを参照

してください。

� 一般的なインストールやプログラミングに関する問題点のトラブル

シューティングおよび NIの製品についてよくある質問（FAQ)の回
答に関するドキュメントについては、ni.com/jp/kbを参照してく

ださい。

� デバイスが損傷した可能性があり、ナショナルインスツルメンツの

ハードウェアを修理またはデバイスキャリブレーションのために返却

する必要がある場合は、日本ナショナルインスツルメンツ テクニカ
ルサポートへご連絡ください。電話番号：03-5472-2981　（平日　
9：00-12：00　13：00-17：00）

世界各国の技術サポート

技術サポートおよびその他の専門サービスについては、ナショナルインス

ツルメンツのウェブサイト（ni.com/jp）の下記のセクションを参照し

てください。

� サポート � オンライン技術サポート（ni.com/jp/support）には以

下のリソースがあります。

� セルフヘルプリソース �解答やソリューションが必要な場合は、
ナショナルインスツルメンツのウェブサイトから、ソフトウェア

ドライバとアップデート、検索ができる技術サポートデータベー

ス、製品マニュアル、トラブルシューティングウィザード、種類

豊富なサンプルプログラム、チュートリアル、アプリケーション

ノート、計測器ドライバなどをご利用いただけます。

� 技術サポート � ユーザ登録されますと、基本的なサービスを無
償でご利用いただくことができます。ni.com/exchange（英
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語）からアクセスできる NI Developer Exchangeで、世界各
地からアプリケーションエンジニアへご質問を承ります。お尋ね

いただきましたご質問には、ナショナルインスツルメンツのアプ

リケーションエンジニアが必ず解答いたします。

ご利用の地域のその他の技術サポートオプションについては、

ni.com/jp/servicesをご覧頂くか、または ni.com/jp/

contactから最寄の営業所までお問い合わせください。

� トレーニングと認定 � 自習形式のコースキットやインストラクタに
よる実践コースなどのトレーニングおよび認定プログラムについて

は、ni.com/jp/trainingにアクセスしてください。

� システムインテグレーション � 時間の制約がある場合や社内で技術
リソースが不足している場合、または、その他のプロジェクトで簡単

には解消しない問題がある場合などは、ナショナルインスツルメンツ

のアライアンスパートナーによるサービスをご利用いただけます。詳

しくは、最寄りの NI営業所にお電話いただくか、
ni.com/jp/allianceをご覧ください。

� 適合宣言（DoC）�適合宣言とは、その会社の自己適合宣言を用い
た、さまざまな欧州閣僚理事会指令への適合の宣言のことです。この

制度により、電磁適合性（EMC）に対するユーザ保護や製品の安全
性に関する情報が提供されます。ご使用の製品の適合宣言は、

ni.com/certification（英語）から入手できます。

� Calibration Certificate �ご使用の製品がキャリブレーションをサ
ポートする場合、ni.com/calibrationからその製品の

calibration certificate（英語）を入手してご利用になることもでき
ます。

ナショナルインスツルメンツ本社は 11500 North Mopac Expressway, 
Austin, Texas, 78759-3504にあります。最新のコンタクト情報、サポー
トの電話番号、電子メールアドレス、および現在のイベントの情報を提供

する海外オフィスのウェブサイトにアクセスするには、

ni.com/niglobal（英語）を参照してください。

NI-DAQ 7.4のサポート
NI-DAQmx 7.4では、すべての NI計測デバイス製品がサポートされてい
ます。将来の NI-DAQのリリースでは、NI-DAQmxのみに新規デバイス
のサポートが追加されます。従来型 NI-DAQ（レガシー）には新規デバイ
スは追加されません。
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オペレーティングシステムサポート
NI-DAQmxおよび従来型 NI-DAQ（レガシー）バージョン 7.4および
NI-SWITCH 2.3はWindows 2000/NT/XPをサポートします。
Windows NTで NI-DAQ 7.xを使用するには、Service Pack 6以降が必
要です。

NI-DAQmx 7.4は、LabVIEW Real-Timeモジュール 7.1でのみ
PharLapをサポートします。

Measurement StudioにはWindows 2000/NT 4.0/XPで動作する
Visual Studio .NET 2003が必要です。 

DAQmx .NET Libraryを使用している場合には、NET 1.1フレームワーク
が必要です。.NET 1.1はWindows 2000/XPを必要とします。

特定のオペレーティングシステムのインストールの説明を参照するには、

ni.com/support/install（英語）で Hardware Installation/
Configuration Troubleshooterをご利用ください。

他のオペレーティングシステムをサポートする NI-DAQの旧バージョン
をダウンロードするには、ni.com/jp/downloadsを参照してください。 

アプリケーションソフトウェアサポート
表 1は、NI-DAQmxおよび従来型 NI-DAQ（レガシー）でサポートされ
るアプリケーションソフトウェアのバージョンです。NIのアプリケー
ションソフトウェアを使用しない場合は、表 2を参照してください。

 
表 1 NI-DAQ 7.x アプリケーションソフトウェアサポート

NIアプリケーションソフトウェア

NI-DAQmxでサ
ポートされている
バージョン

従来型 NI-DAQ
（レガシー）でサ
ポートされている
バージョン

LabVIEW  7.x 6.1～ 7.x

LabVIEW Real-Timeモジュール 7.1* 6.1～ 7.x

LabWindows/CVI  7.x 6.0～ 7.x

Measurement Studio  7.x 6.0～ 7.x†

* NI-DAQmxとともに LabVIEW Real-Timeモジュール 7.1を使用するには、NI-DAQmx
バージョン 7.2以降を使用する必要があります。
† 従来型 NI-DAQ（レガシー）にはMeasurement Studio C++や .NETインタフェースは
含まれません。
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プログラミング言語とコンパイラサポート
 

NI-DAQの初期のバージョンでは、他のアプリケーションソフトウェアお
よび言語バージョンがサポートされています。初期のバージョンを検索し

てダウンロードするには、ni.com/downloadsを参照してください。

デバイスサポート
表 3は、NI-DAQmxおよび従来型 NI-DAQ（レガシー）によって
NI-DAQ7.4でサポートされるデバイスの種類です。特定のデバイスのモ
デル名については、CDにある『NI-DAQ 7.x Readme』を参照してくだ
さい。 

表 2 NI-DAQ 7.xプログラミング言語サポート

プログラミング言語

NI-DAQmxでサ
ポートされている
バージョン

従来型 NI-DAQ
（レガシー）でサ
ポートされている
バージョン

Microsoft Visual C++
Classライブラリ
ANSI C

7.x *
6.0～ 7.x

�
6.0～ 7.x

Visual Basic � 6.0†

Microsoft .NETフレームワーク
(C#および Visual Basic .NET)

.NET 1.1 �

Borland � ✓

* Measurement Studio 7.xが必要です。
† ActiveXを介してサポートします。

表 3 NI-DAQ 7.4デバイスサポート

デバイス NI-DAQmx

従来型
NI-DAQ

（レガシー）

マルチファンクション DAQ

NI PCI-622X/625X/628Xなどの PCI、PCI express、および PXI Mシリーズの
デバイス

✓ �

NI PCI-6052Eなどの PCI/PXI Eシリーズのデバイス ✓ ✓

PCMCIA Eシリーズ NI DAQCard-6024E、INI DAQCard-6036E、および
NI DAQCard-6062E

✓ ✓

AT Eシリーズ � ✓

NI PCI-6010 ✓ �

NI PCI-6013/6014ベーシックデバイス ✓ ✓

USB対応 NI DAQPad-6015 (BNC)/6015 (Mass Termination)/6016デバイス ✓ �

USBおよび FireWire®（IEEE1394）対応 NI DAQPad-6020E/6052E/6070Eデバ
イス

� ✓

LabVIEW RT対応 NI PCI-7041/6040Eデバイス ✓ ✓
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マルチファンクション DAQ（続き）

LabVIEW RT対応 NI PXIおよび PCI-7030デバイス � ✓

S シリーズ NI PXIおよび PCI-6122/6123/6132/6133/6143 ✓ �

NI PXI-6115/6120および NI PCI-6110/6111などの Sシリーズ ✓ ✓

アナログ出力 /波形

NI PXIおよび PCI-6711/6713波形 ✓ ✓

PCMCIA NI DAQCard-6715 ✓ ✓

NI PXIおよび PCI-6722/6723 ✓ �

NI PXIおよび PCI-6731/6733 ✓ ✓

NI PXI-6704および PCI-6703/6704 ✓ ✓

AT-AO-6/10 � ✓

アナログ入力―PCMCIA DAQCard-AI-16E-4/DAQCard-AI-16XE-50 � ✓

カウンタ /タイマ

NI PCI-6601/6602および NI PXI-6602/6608 ✓ ✓

NI PXIおよび PCI-6624光絶縁 ✓ �

デジタル I/O

NI 6503、NI PXI-6508、NI 6527、および NI PCI-DIO-96 ✓ ✓

NI 6509/6510/6511/6512/6513/6514/6515/6516/6517/6518/6519および
NI 6528

✓ �

DAQCard-6533および AT-DIO-32HS � ✓

NI 653X高速デジタル ✓ ✓

PCMCIA対応 NI DAQCard DIO-24 ✓ ✓

USB対応 NI DAQPad-6507/6508 � ✓

PC-DIO-24および PC-DIO-96 � ✓

AT-DIO-32F � ✓

ダイナミック信号集録

NI PXI-4472/4472Bおよび PCI-4472/4474 ✓ ✓

NI PXI-4461/4462 ✓ �

NI PCI-4451/4452/4454および 4551/4552 � ✓

表 3 NI-DAQ 7.4デバイスサポート（続き）

デバイス NI-DAQmx

従来型
NI-DAQ

（レガシー）
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NI-DAQ 7.xでサポートが廃止されたデバイス
以下のデバイスは NI-DAQ 7.x（NI-DAQmxまたは従来型 NI-DAQ（レガ
シー））でサポートされません。これらのデバイスは今後のバージョンで

もサポートされません。これらのデバイスをプログラムするには、

NI-DAQ 6.9.xまたはそれ以前のバージョンが必要です。

信号調節

SCXI-1521/Bおよび SCXI-1600モジュール ✓ �

その他すべての SCXI信号調節モジュール ✓ ✓

NI PXI-4200/4204/4220信号調節実装 ✓ �

SCCシリーズモジュール ✓ ✓

TEDSデバイス :BNC-2096、SC-2350キャリア、および SCXI-1314T
メモ :これらのデバイスは TEDSセンサの読み取りおよび書き込みをサポートし
ています。

✓ �

スイッチ

NI SCXI-1160/SCXI-1161/SCXI-1163Rモジュール ✓ ✓

その他すべての SCXIスイッチモジュール ✓ �

PXIスイッチモジュール ✓ �

NI AT-MIO-16F-5
NI DAQCard-500
NI DAQCard-516
NI DAQCard-700
NI DAQCard-1200
NI DAQCard-AO-2DC
NI DAQPad-1200
NI DAQPad-MIO-16XE-50
NI Lab-PCおよび Lab-PC+
NI Lab-PC-1200/AI
NI PC-516

NI PC-AO-2DC
NI PC-LPM-16/PNP
NI PC-OPDIO-16
NI PC-TIO-10
NI PCI-1200
NI SCXI-1200
NI SCXI-2000
NI SCXI-2400
NI VXI DAQモジュール
NI VXI-SCキャリアおよびモジュール
NI VXIバス対応 VXI-TB ターミナルブロック

表 3 NI-DAQ 7.4デバイスサポート（続き）

デバイス NI-DAQmx

従来型
NI-DAQ

（レガシー）
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